
JANOME 

DigitizerPro v2.0 
ir Digitizer MB daugiaadatinei mašinai* 

Vartotojo vadovas 
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Skyrius 1 
SISTEMOS ĮDIEGIMAS 
 
 
 
 
Šiame skyriuje aprašyti visi būtini žingsniai naujos DigitizerPro sistemos įdiegimui į PK (personalinį 
kompiuterį).Jums taip pat reikės prijungti periferinius įrenginius, būtinus darbui su DigitizerPro. Tai gali būti 
spausdintuvai, skeneriai ir, žinoma, jūsų siuvinėjimo mašina. Skirtingi įrenginiai gali būti diegiami skirtingais 
būdais – kai kurie Windows aplinkoje per Control Panel, kiti pačios DigitizerPro viduje. Prisijungiant 
įrenginius prie savo PK ir diegiant juos Windows aplinkoje, vadovaukitės pačių įrenginių technine 
dokumentacija, taip pat Microsoft  Windows dokumentacija. 
 
 
Įdiegimo žingsnių seka 
Įdiegiant ir konfigūruojant jūsų naują DigitizerPro programą, sekite visus tam reikalingus žingsnius. 
 
*Žingsnis 1: Įsitikinkite, kad jūsų PK atitinka minimaliems DigitizerPro sistemos poreikiams.  
*Žingsnis 2: Prieš diegdami naują DigitizerPro ar prieš atnaujindami egsistuojančią sistemą, būtinai atidžiai 
perskaitykite visus įdiegimo žingsnius. 
*Žingsnis 3: Kai sistemos įdiegimas pasibaigs, jums bus nurodyta pakartotinai išjungti ir įjungti jūsų PK. 
*Žingsnis 4: Kai sistema  nurodis, prijunkite jūsų saugumo raktą. Jeigu turite egsistuojančią programos versiją 
ir gavote naują raktą, prijunkite jūsų seną raktą taip pat. Detaliau žiūr. Sistemos saugumas  2 pusl. 
*Žingsnis5:  Prijunkite JANOME mašiną prie PK. Detaliau žiūr. Palaikomų mašinų modeliai ir atminties 
kortelės  4 pusl. 
*Žingsnis 6: Jeigu esate naujokas, atidžiai perskaitykite įvadinius skyrius iš vartotojo instrukcijos, pateiktos 
kartu su jūsų DigitizerPro įdiegimo pakuote. 
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2 
*Žingsnis7: Tiek naujiems tiek patyrusiems vartotojams reikia perskaityti visas leidinio pastabas Release 
Notes, kad suprasti naujas ir patobulintas šios naujos programos leidinio savybes. Šias pastabas jūs galite 
pasiekti per HELP meniu iš „online“ informacinės sistemos  jūsų įdiegtoje DigitizerPro.  
 
Minimalūs reikalavimai DigitizerPro 
 
Sudedamoji dalis  Minimum  Rekomenduotina 
 
CPU  Pentium III (800MHz) Pentium IV arba aukščiau 
Operacinė sistema Windows 2000/XP Windows 2000SP4, Win XP 
    Home/Pro SP1 arba vėlesnė 
Interneto naršyklė* MS Internet Exploer 6 MS I.E 6 arba vėlesnė 
Atmintinė (RAM) 128 MB  512 MB arba daugiau 
Kietas diskas  8GB  20GB arba daugiau 
Laisvos atminties diske 500MB  750MB 
Vaizduoklis  15“ ekrano darbui 15“ arba didesnis ekranas darbui 
Grafinė plokštė  High Color (16-bitų) 32Mb arba daugiau (neintegruota) 
  arba daugiau 
Ekrano skiriamoji galia 1024x768 pixelių 1280x1024 pixelių 
CD-ROM įrenginys 24x  Bet kuris veliausio modelio 
Mašinos prijungimas Esamas nuoseklus arba USB portas JANOME MemoryCraft siuvimo mašinai 

prijungti 
Skenerio, spausdintuvo, brai- Bet kuris su Windows suderinamas prijungimo būdas, pav. lygiagretus,  
žytuvo prijungimas USB 
Saugos rakto prijungimas Atskiras USB portas Atskiras USB portas 
Pelė Nuoseklus, PS/2 arba USB pelė PS/2 arba USB pelė 
Garso plokštė Nebūtina  Rekomenduotina mokymuisi 
*Interneto prijungimas rekalingas tam tikroms sistemos dalims taip pat, kad pasiekti informaciją apie produktą 
ir „online“ informacinės sistemos palaikymui 
 
Microsoft Internet Explorer‘io ir Adobe Acrobat Reader‘io atnaujinimas 
Kartu su DigitizerPro jums taip pat reikia įdiegti naujausias versijas Microsoft Internet Explorer ir Adobe 
Acrobat Reader programines įrangas į jūsų sistemą. Internet Explorer  yra būtinas dėl teisingo programinės 
įrangos  dalies Design Gallery (paveiksliukų galerėja)  veikimo, o Adobe Acrobat Reader yra reikalingas jūsų 
sistemos domentų skaitymui, paieškai ir spausdinimui. Sistema paprašys jūsų įdiegti Microsoft Internet 
Explorer V6 ir Adobe Acrobat Reader V6 kaip normalaus įdiegimo dalies. 
 
Perspėjimas: Windows 2000 arba XP vartotojams – jeigu jūs dirbate vienoje iš šių operacinių sistemų, tai 
norint įdiegti programinę įrangą, jums reikia užsiregistruoti Administratoriaus lygio teisėmis.  
 
Sistemos saugumas 
DigitizerPro kontroliuoja saugumo įtaisas arba „dongle“ (toliau „raktas“), prijungtas prie kompiuterio. 
Programa neveiks teisingai, jeigu saugos raktas ištrauktas iš kompiuterio, kai DigitizerPro atidarytas. Tokiu 
atveju programa gali pakibti arba sugesti ir bet kuris atidarytas failas gali būti sugadintas. 
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3 
DigitizerPro pilnas komplektas patiekiamas su USB saugos raktu. Kiekvienas raktas turi unikalų serijos numerį 
ir atpažinimo kodą, todėl jūsų sistema gali būti atpažinta. Saugos raktas įstatomas į USB jungtį jūsų 
kompiuteryje. Jeigu jūsų kompiuteryje nėra USB jungties, jums reikės įmontuoti USB plokštę. Saugos raktai su 
lygiagrečių portų jungtimis daugiau negaminami. 

Perspėjimas: Saugos raktas yra svarbiausia ir vertingiausia dalis jūsų sistemoje todėl su juo būtina elgtis 
atsargiai. Visuomet laikykite jį saugioje vietoje, kai nenaudojamas. JANOME garantuoja saugos rakto 
bedefektinį veikimą, kokybiškas panaudotas medžiagas ir kokybišką surinkimą – esant normaliai eksploatacijai 
ir priežiūrai ir jei teisingai sumontuotas - periode 90 dienų nuo pristatymo datos. Jeigu jis sugenda, jis gali būti 
pakeistas. Jeigu jis fiziškai pažeistas, jį galima siūsti į JANOME, bet pakeitimas bus apmokestintas. Tačiau 
jeigu raktas pamestas arba pavogtas, jums teks pirkti pilną DigitizerPro pakeitimo sistemą. Dėl šios priežasties 
jūs galite apdrausti savo saugos raktą. 

Egzistuojančios DigitizerPro modifikavimas 
Ar jūs norėsite atnaujinti savo esantį DigitizerPro ar norėsite jį ištrinti iš PK, jums reikia atlikti tokią pačią 
procedūrą. Kada jūs paleidžiate išnaujo įdiegimo programą, ji automatiškai nustato ar nėra jūsų sistemoje 
Janome DigitizerPro kopijos ir duoda jums pasirinkti modifikuoti, atkurti ar pašalinti ją. Tai yra apsauga, kad 
jūsų PK nebūtų įdiegta daugiau negu viena Janome DigitizerPro versija. 

Kaip modifikuoti egzistuojančią DigitizerPro 

1.Uždarykite visas Windows programas, tačiau palikite Windows veikiančią.
2.Įdėkite DigitizerPro įdiegimo diską. Jeigu DigitizerPro programa buvo įdiegta jūsų PK, pasirodis toks langas:

3.Pasirinkite jums reikalingą parinktį – Modify (modifikuoti), Repair (atkurti), Remove (pašalinti) – ir
spragtelėti  ant Next.
Jeigu pasirinksite modify arba repair jūsų esamai programai, pasirodis langas Select Components
(komponenčių pasirinkimas)

4.Pasirinkite sudedam1sias dalis įdiegimui arba pašalinimui.:
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4 
Sudedamoji dalis  Aprašymas 
Janome DigitizerPro  Pagrindinis DigitizerPro produktas 
Design Gallery   Design Galery yra piešinių naršyklės programa 
Online Help (operatyvi sistemos pagalba)  Kontekstui jautri pagalba – iškvietimui, naudokite funkcinį 

klavišą F1 arba su pele spragtelėkite ant  
 HELP mygtuko dialogo langeliuose 
User Manual (vartotojo vadovas) Elektroninė (sistemos) Janome vartotojo vadovo  
  kopija – pasiekiama per HELP meniu 
Samples (pavyzdžiai) Siuvinėjimo piešinių pavyzdžiai ir vaizdai – įdiegta 

Embroidery Album (siuvinėjima albumas) kataloge jūsų PK 
kietame diske. 

Release Notes (Pastabos apie leidinį) Elektroninė (sistemos) pastabų apie Janome leidinį  
  kopija – pasiekiama per HELP meniu 
Extra Languages (papildomos kalbos) Daugiakalbėje versijoje galimos papildomos kalbos 
 Jeigu tokiomis pačiomis kalbomis yra veikiantys sisteminiai 

dokumentai, čia jas galite pasirinkti – pav. 
 Japonų – dokumentai bus įdiegti automatiškai. Jeigu  
 sisteminių dokumentų jūsų pasirinktoje kalboje nėra, 
 bus įdiegti angliški dokumentai.  
 Po įdiegimo, kalbas jūs galėsite persijungti su Switch  
 Language (kalbų mygtukas) Program kataloge 
 
Pastaba: Automatiškai nustatoma ir parodoma bendra turima atminties apimtis. Tai atsinaujina priklausomai 
nuo pasirinkto punkto. 
 
5.Spragtelėti ant Next. 
6.Spragtelėti ant Install (įdiegti) 
Pasirodis įdiegimo pabaigos (Installation Complete) ekranas, kurio turinys priklausys nuo įdiegimo sėkmės ir 
bet kurio Windows papildomo failo, reikalaujančio atnaujinimo. 
7.Spragtelėti Finish (užbaigti) 
Kompiuteris automatiškai perkraus operacinę sistemą ir jūs būsit paprašytas prijungti jūsų saugos raktą. 
 
 
 
8.Spragtelėti OK. 
Kai tik sistema suras naują saugos raktą, pasirodis ekranas Setup Complete 
 
Janome MemoryCraft mašinos prijungimas prie jūsų PK 
Sėkmingai įdiegus ir patikrinus jūsų DigitizerPro programinę įrangą, galite prie savo PK prijungti JANOME 
MemoryCraft mašiną. Kad prijungti palaikomą mašiną prie PK  jums reikia panaudoti USB kabelį, kuris 
prijungtas prie jūsų PK USB jungties. Detaliau, žiūr.į JANOME MemoryCraft vadovą, kaip prijungti mašiną 
prie jūsų kompiuterio. 
 
Palaikomų mašinų modeliai ir atminties kortelės 
DigitizerPro palaiko tokius mašinų modelius ir atminties korteles: 
 
Palaikomų mašinų modeliai 
DigitizerPro palaiko tokius mašinų modelius: 
 1)Pasirinkti vieną turimų mašinų modelių grupių 
 
*MC11000, MC10001 ir MC10000 mašinos gali būti sujungtos tiesiai kabeliu prie jūsų PK. Detaliau, žiūr. 4 
pusl, JANOME MemoryCraft mašinos prijungimas prie jūsų PK. 
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5 
*MC10000 V2,2 arba ankstesni modeliai turi būti atnaujinami paverčiant juos į versiją V2,21. Įeikite įmūsų 
tinklalapį http://www.janome.com/, kad atsisiūsti reikiamas atnaujinimo programas. 
*Mašinos MC9700, MC9500, MC300E ir MC350E nepalaikomos tiesioginiu sujungimu su PK, tačiau jos gerai 
nuskaito ATA PK korteles. 
*MB-4 mašinos palaikomos tiesioginiu sujungimu. Jūs galite persiūsti piešinius į mašinos vidinę atmintį arba į 
ATA kortelę arba į USB diską prijungtą prie mašinos. Tačiau tiesioginis sujungimas MB-4 mašinos su PK 
įmanomas tiktai JANOME DigitizerPro MB sistemoje daugiaadatinių gaminių lygiui. 
 
Palaikomos atminties kortelės 
Be USB sujungimo, jūs galite piešinių programas įrašyti į ATA PC kortelę – „Flash Memory“ – panašiai, kaip 
jūs išsaugojate informaciją lanksčiame diskelyje. ATA PC kortelės yra PCMCIA standarto PK atminties 
kortelė, kuri naudojama kaip piešinių laikmena JEF formate skaitymui /įrašymui į JANOME MemoryCraft 
mašiną. ATA PC kortelės sukurtos taip, kad jos gali jūsų PK tarnauti kietu disku su pavadinimu E: arba F: arba 
kita kokia raide. Įrašius jūsų piešinį, jūs paprasčiausiai įdedate kortelę į ATA PC kortelės dėklą jūsų mašinoje ir 
nuskaitote piešinį. 
 
USB atminties lazdelės 
Naujausios JANOME MemoryCraft mašinos gali nuskaityti /rašyti iš/į USB atminties lazdeles. Tai yra labai 
patogus mažų gabaritų atminties įtaisas, kuriame galima laikyti didelius kiekius duomenų. 
 
Ryšys su jūsų PK USB kabeliu 
Visos Windows operacinės sistemos palaiko USB kabelinį sujungimą PK tiesiogiai su palaikoma mašina, su 
sąlyga, kad jūsų PK turi įmontuotą USB portą. 
 
Kad prisijungti prie jūsų PK su USB kabeliu 
1.Įjunkite savo PK ir JANOME MemoryCraft mašiną 
2.Tipo A jungtį sujungti su PK, o tipo B su siuvimo mašina. 
 
Pastaba: Neišjunkite PK arba siuvimo mašinos, kol nesibaigs sistemos nustatymas 
3.Instaliuokite USB valdiklį JANOME MemoryCraft mašinai. 
Pastaba:Šita nustatymo procedūra būtina tiktai pirmam kartui. Kabelį galima atjungti kai maitinimas įjungtas 
arba išjungtas 
 
USB valdiklių įdiegimas tiesioginiam jungimui 
USB valdikliai sistemoms 2000/XP yra ant jūsų DigitizerPro Installation kompaktinio disko. Jums reikia juos 
įdiegti, prijungiant jūsų mašiną prie PK. Hardware Wizard (įrenginių meistras) automatiškai ieško tinkamų 
valdiklių ir nukreipia jus per visą procesą. 
 
Kad įdiegti USB valdiklį tiesioginiam sujungimui 
1Sujunkite mašiną ir kompiuterį su USB kabeliu ir įjunkite abu. 
Kompiuteris pradės ieškoti naujo įrenginio ir nurodis jums įdiegti įrenginio valdiklį. 
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2.Pasirinkite Ne windows atnaujinimui ir spragtelėkite Next 
 
 
 
 
 
 
 
3.Pasirinkite automatinio įdiegimo parinktį, įdėkite Janome įdiegimo CD diską į CD ROM diskasukį ir 
spragtelėkite ant Next. 
Įdiegimo programa pradės ieškoti tinkamo įrenginio valdiklio ir, jeigu ji suras jūsų sistemoje daugiau negu 
vieną kopiją, nurodis jums kurią pasirinkti. 
 
 
Pastaba: MC11000 (Įrenginys Jsmc860) valdikliai nukopijuojami į standųjį diską, programinės įrangos 
diegimo metu, todėl nereikia naudoti CD disko. 
MC10001 mašina pareikalauja  CD diegimo, tuo metu, kai paleidžiamas įrangos meistras (Wizard), kad įdiegti 
valdiklius (įrenginys Jsmc850). 
 
4.Pasirinkite parinktį ir spragtelėkite ant Next, prasidėtų įdiegimas. 
 
Pasibaigus įdiegimui pasirodo toks langas 
 
 
 
 
 
 
 
5.Spragtelėkite ant Finish, kad išeiti ir perkrauti jūsų kompiuterį. 
 
 
Skenerių prijungimas 
Skeneriių prijungimui naudokite Scaner Setup (Image meniu). 
 
DigitizerPro palaiko TWAIN suderinamuosius skenerius. 
 
Pastaba: Periferinius įrenginius prie jūsų kompiuterio galima prijungti per nuoseklius portus, lygiagrečius 
portus, specializuotą tinklo plokštę arba interneto tinklą. 
 
Kad prijungti skenerius 
1.Sujungti skenerį su PK pagal palydinčias instrukcijas 
2.Nustatykite jį į Windows panaudojant palydinčias instrukcijas ir/arba Microsoft Windows dokumentaciją. 
3.Paleiskite DigitizerPro. 
4.Pasirinkite Image>Scanner Setup. 
Atsidaręs Select Source  dialogas parodis jūsų kompiuteryje esančių skenerių valdiklių sąrašą. 
 
 
 
 
 
 
 
5.Pasirinkite skanavimo valdiklį ir spragtelėkite ant Select. w
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7 
 
Pastaba: Jeigu po pakartotinio DigitizerPro paleidimo turėtumėte problemų su skenavimu, tai galėtų būti dėl 
konflikto su anksčiau veikusiu skenavimo valdikliu. Išnaujo įdiekite DigitizerPro ir patikrinkite skenerį. Jeigu 
pasirinkto skenerio valdiklis programoje DigitizerPro neveikia, tai iš sąrašo pasirinkite kitą valdiklį. Paprastai 
kiekvienam skeneriui diegiami du valdikliai. 
 
Vaizduoklio kalibravimas 
Jums reikia sukalibruoti savo vaizduoklį, kad jūsų piešiniai mąsteliu 1:1 atitiktų realų piešinio dydį. Atlikite tai 
pirmą kartą diegiant EasyDesign arba visuomet keičiant vaizduoklį. 
 
Kad sukalibruoti vaizduoklį 
1.Pasirinkti Setup>Screen Calibration 
Pasirodis dialogo langas Screen Calibration. 
 
 
 
 
 
2.Išmatuokite dialogo lango aukštį ir plotį. 
3.Įveskite matavimo rezultatus į atitinkamus laukus Width (plotis) ir Height (aukštis). 
4.Spragtelėkite OK, kad patvirtinti. 
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2 Skyrius 
 

ĮVADAS 
 
 
 
 
Sveiki atvykę į DigitizerPro, taikomųjų programų lyderę buitinio siuvinėjimo srityje. 
DigitizerPro programinė įranga veikia Windows aplinkoje ir apima daugelį įprastų dalykų, su kuriais daugelis 
PK vartotojų yra gerai susipažinę. 
 
 
 
Jeigu jūs esate naujokas DigitizerPro programoje, jūs patirsite malonumą dirbant su lankstaus elektroninio 
piešinių projektavimo galimybėmis, jūs lengvai su ja galėsite sukurti ir redaguoti piešinius, ir įsitikinsite, kaip 
lengva pridėti arba sukurti savo paties užrašus. Tačiau prieš pradėdami dirbti su produktu, perskaitykite skyrių 
Įvadas į elektroninių siuvinėjimo piešinių projektavimą puslapyje 15. Šiame skyriuje pateikta darbo su 
DigitizerPro pagrindų apžvalga ir svarbūs nurodymai, kaip naudotis programa, kad pasiekti geriausių rezultatų. 
 
Jums taip pat reikia gerai susipažinti su Pagrindinėmis Procedūromis 23 puslapyje . Čia jūs sužinosite, kaip 
pradėti dirbti su programa, išmoksite atidaryti piešinį, atspausdinti jį ir panaudoti kai kuriuos pagrindinius 
įrankius ir savybes, kurias suteikia DigitizerPro. 
 
Pastaba: Panaudokite procedūrą, apie kurią užsiminta skyriuje Sistemos įdiegimas, kad įdiegti DigitizerPro 
sistemą jūsų kompiuteryje kaip naują. Detaliau žiūr. Egzistuojančios DigitizerPro modifikavimas 3 puslapyje. 
 
 
Apie DigitizerPro 
Programinė įranga susideda iš dviejų dalių: EasyDesign ir EasyEdit. Jos aprašytos žemiau: 
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10 
Easy Design (projektavimo programa) 
EasyDesign naudoja orientuotų objektų priartinimą prie siuvinėjimo piešinių, išsaugojant figūras, kaip kontūrus, kurie 
automatiškai gali generuoti dygsnius, susijusius su iš anksto užduoto objekto detalėmis. Siuvinėjimo objektus galima 
padidinti ar sumažinti, pakeisti jų formą ir transformuoti juos į atskirus elementus atskirame piešinyje, automatiškai išnaujo 
generuojant dygsnius po kiekvieno pakeitimo. 
EasyDesign leidžia jums sukurti naujus piešinius iš eskizų, sujungti egzistuojančius piešinius ir greitai konvertuoti bitmap 
vaizdus į piešinio projektą. Jis taip pat aprūpina visa eile fontų ir leidžia kurti užrašus, kad pridėti monogramas ir išradingus 
užrašus į jūsų piešinių projektus. Su EasyDesign jūs galite: 
*Sukurti naują piešinį 
*Sukurti siuvinėjimo objektus, panaudojant elektroninius įrankius 
*Automatiškai sukurti siuvinėjimo objektus, panaudojant Click-to-Design ir Click-to-Stitch. 
*Panaudoti vaizdo paruošimo įrankius, kurie padeda paruošti bitmap vaizdus gatavais šablonais. 
*Pridėti užrašus ir sukurti monogramas, naudojant įvairius fontus ir išradingus efektus. 
*Įterpti arba nuskenuoti vaizdą, iš kurio sukurti naują siuvinėjimo piešinį. 
*Sumažinti arba padidinti, pakeisti formą, išgauti veidrodinį vaizdą ir pasukti atskirus objektus piešinyje. 
*Praeiti per visą piešinį, peržiūrėti siuvimo seką. 
*Peržiūrėti arba atspausdinti informacinius lapus apie jūsų piešinį, nurodant dygsnių skaičių ir spalvas, kurios panaudotos 
piešinyje. 
*Sukurti specialius efektus, kaip aplikacijų objektus su skylutėmis ir plunksnomis papuoštus kraštus. 
*Pasirinkti skirtingo tipo dygsnius piešinio užpildymui arba figūros formavimui. 
*Nustatyti ir pakeisti objekto reikšmes 
*Pakeisti siuvimo kampą 
*Pakeisti siuvimo seką 
*Užkrauti ir stebėti piešinius iš jūsų standaus disko, CD ROM arba lankstaus disko. Jie gali būti sukurti kitoje siuvinėjimo 
programinės įrangos aplinkoje. 
*Išsaugoti failus daugelyje failų formatų, įskaitant ir standartinį JAN formatą. 
 
EasyEdit (redagavimo programa) 
EasyEdit yra pagrįstas tradiciniu siuvinėjimo formatu, kuriame visas piešinys yra vienetinis objektas, sudarytas iš atskirų 
dygsnių. EasyEdit leidžia jums paimti iš dygsnių sudarytą elektroninį piešinį ir pakeisti jo dydį arba transformuoti jį visą 
arba modifikuoti atskirus dygsnius, kasd  įvesti subtilius pakeitimus arba švelniai paderinti. 
Su EasyEdit galima atlikti: 
*Atidaryti egzistuojantį piešinį 
*Pasirinkti ir redaguoti individualius dygsnius 
*Išskirstyti dygsnius į blokus, kad atskirti piešinio dalis 
*Ištrinti, kopijuoti, dubliuoti ir įterpti dygsnių blokus 
*Pakeisti dygsnių blokų matmenis, gauti jų veidrodinį vaizdą ir pasukioti. 
*Prakeliauti per piešinį, kad peržiūrėti dygsnių seką. 
*Įkrauti ir peržiūrėti piešinius iš jūsų standaus disko, CD-ROM arba lankstaus disko. Jie gali būti sukurti kitoje siuvinėjimo 
programinės įrangos aplinkoje. 
*Išsaugoti failus daugelyje failų formatų, įskaitant ir standartinus JEF ir SEW formatus. 
 
Spausdinta dokumentacija 
DigitizerPro užtikrina jums visą eilę būdų, kaip pasiekti informaciją apie programinę įrangą ir kaip ją panaudoti. Kartu su 
DigitizerPro įdiegimo CD disku jūs gausite tokią spausdintą dokumentaciją: 
 
Pastabos apie leidinį (Release Notes) 
Atspausdintas Release Notes komplemlektas (tiktai Upgrade Kit) suteikia jums informaciją apie sistemos reikalavimus 
įdiegiant DigitizerPro, naujų savybių detales ir apie svarbesnius bei smulkesnius programinės įrangos leidinio 
patobulinimus, taip pat apie žinomus apribojimus ir darbą. 
 
Vartotojo vadovas 
Atspausdintas DigitizerPro vartotojo vadovas (tiktai pilnas komplektas) sussideda iš šimtų žingsnis- po – žingsnio 
instrukcijų, papildytų pavyzdžiais ir ekrano vaizdais. Tai yra skirta susipažinimui, bet ne mokymui. Vadovo dokumentai 
susideda iš tokių produktų: 
EasyDesign, EasyEdit ir Design Gallery 
 
 
Perspėjimas: Ekranų iliustracijos, esančios vartotojo dokumentacijoje, yra skirtos tiktai pavaizdavimui, jos nėra tikslios 
ekranų, kurias generuoja programa, kopija. 
Procedūrų aprašymai gali nežymiai skirtis priklausomai nuo ypatingų programos diegimo atvejų, kada buvo pritaikyti 
kitokie sistemos nustatymo parametrai pagal nutylėjimą. 
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Sisteminė informacija tinkle 
 
Sisteminė  dokumentacija pateikta dvejuose formatuose – HTML Online Help (sisteminė pagalba tinkle) ir Adobe Acrobat 
 
Release Notes 
Pastabos apie leidinį yra kaip programinės įrangos diegimo dalis ir yra pasiekiama per Help meniu. Yra užtikrinti 
tiesioginiai ryšiai į atitinkamas sisteminio vadovo (Online Manual) dalis. 
 
Online Manual (tinklinis sisteminis vadovas) 
Vartotojo vadovas (sisteminis vadovas) taip pat yra programos diegimo dalimi ir pasiekiamas per Help meniu. 
 
Online Help (sisteminė tinklinė pagalba) 
Sisteminė tinklo pagalba leidžia greitai pasiekti bendrą informaciją apie EasyDesign ir EasyEdit savybes ir žingsnis –
po-žingsnio instrukcijas. Dialogų metu galima kontekstui jautri pagalba, paspaudus klavišą F1. 
 
Sisteminės informacijos apžvalga 
Siteminę informaciją galima pasiekti iš DigitizerPro programų aplanko arba iš Help meniu, esant DigitizerPro 
programoje. Ją galite skaityti su Adobe Acrobat Reader programa, kuri įeina į DigitizerPro programinės įrangos 
diegimo komplektą. Greitai informacijos paieškai jums reikia pasinaudoti standartinės programos Adobe 
Acrobat Reader galimybėmis. 
 
Kad peržiūrėti sisteminę informaciją 
1.Iš Windows Start eiti į Programs>Janome EasyDesign aplanką. 
Čia rasite tokius dokumentus: 
*DigitizerPro vartotojo vadovą 
* DigitizerPro pastabas apie leidinį 
2.Du kartus spragtelėjus, dokumentas atsidaro Adobe Reader formate. 
 
 
 
Pabandykite tai!Jūs galite atidaryti savo sistemos dokumentą tiesiogiai iš DigitizerPro. Įeikite į Help meniu ir 
pasirinkite norimą dokumentą iš išskleisto žemyn sąrašo. 
3.Pasirinkite norimą punktą, spragtelėję ant „Žymeklio“ 
4.Pasikeiskite vaizdo padidinimą bet kuriuo iš būdų: 
 *Spragtelėkite ant Actual Size arba Fit in Windows arba Fit Width mygtukų. 

*Pasirinkite Zoom in įrankį, tada spragtelėkite bet kurioje puslapio vietoje- su kiekvienu spragtelėjimu 
vaizdas didėja. 
*Spragtelėkite ant Reader Zoom skleistinės ir pasirinkite didinimą – pabandykite 200%, jeigu 
pageidajate iš arti apžiūrėti ekranų diagramas. 

5.Naudokite puslapių vartymo mygtukus apačioje, eiti per knygą pirmyn ir atgal arba sugrįžti prie ankstesnių 
vaizdų. 
 
Pabandykite tai! Reader ekrano viršuje pasirinkite Help>Reader Guide (Reader vadovas, kad gauti lačią 
informaciją apie Reader panaudojimą. 
 
Sisteminės pagalbos panaudojimas 
Sisteminę pagalbą galima pasiekti iš Help meniu, esant DigitizerPro programoje. 
 
Kad panaudoti sisteminę pagalbą 
1.Pasirinkite Help>Help Topics (Help‘o tematika) 
Atsidarys EasyDesign Help langas 
2.Spragtelėkite ant Contents, kad pamatyti pagrindinį temų sąrašą. 
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Temos sugrupuotos po aukštesnio lygio antraštėmis su knygos piktogramomis. 
3.Du kartus spragtelėkite ant knygos, kad pamatyti temų sąrašą, tada du kartus spragtelėkite ant temos. 
Arba kitu būdu, spragtelėkite ant Find (surasti) ir įvesti raktinius žodžius, kad atlikti nurodyto dalyko paiešką. 
 
Pastaba: Dialoguose galima kontekstui jautri pagalba. Atidarę dialogo langą, paspauskite klavišą F1, kad 
iškviesti pagalbą pagal dialogo temą. 
 
Ryšys su JANOME tinklalapiu 
Būdami programoje jūs lengvai galite pasiekti pardavimų ir palaikymo informaciją apie gaminius. 
 
Kad susisiekti su JANOME tinklalapiu 
*Pasirinkite Help>JANOME Web Page. 
Jūs tiesiogiai susijungsite su JANOME svetaine pagal adresą http://www.janome.com/ 
 
Pastaba: Jūs turite teisingai konfigūruoti interneto naršyklę savo sistemoje kartu su išėjimu į internetą. 
 
Sutartiniai konventai naudojami vadove 
Šiame vadove taikomi tokie konventai: 
 
Komandos 
Komandos į submeniu susideda iš submeniu pavadinimo ir komandos pavadinimo. Pavyzdžiui, pasirinkti 
komandą Select All iš Edit meniu, reikš kaip: Edit>Select Al. 
 
Dialogų langai 
Dialogų langai reiškia „dialogus“, kurie parodomi vadove tiktai jeigu jie teikia svarbią informaciją apie 
DigitizerPro panaudojimą. Vaizdai ekranuose skirti tiktai susipažinimui ir nėra tikslios kopijos tų ekranų, 
kuriuos generuoja programa. 
 
Pelės konventai 
Instrukcija   Simbolis Veiksmas 
Spragtelėjimas    Spragtelėti kairį pelės mygtuką 
Dešinys spragtelėjimas   Spragtelėti dešinį pelės mygtuką 
Dvigubas spragtelėjimas   Spustelėti pelės mygtuką du kartus, nejudinant pelės 
Shift-spragtelėjimas    Laikyti paspaustą Shift klavišą ir spragtelėti pelės mygtuku 
Spragtelėti OK  Spragtelėti OK su pele arba paspausti klavišą Enter ant klaviatūros, 

užbaigiant veiksmą. 
 
 
Klaviatūros konventai 
 
Nuoroda                            Aprašymas 
Ctrl+S Laikant paspaustą Ctrl klavišą, paspausti mažosios S klavišą 
 
Ctrl+Shift+H Laikant paspaustą Ctrl klavišą, paspausti Shift ir H klavišus 
 
Pilną klaviatūros klavišų nuorodų sąrašą galima surasti greitame nuorodų žinyne - Quick Reference Guide. 
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I Dalis 
 
PAGRINDAI 
 
 
Piešiniai sukurti su EasyDisign susideda iš „siuvinėjimo objektų“. Jie vadinami „objektais”, kadangi tai yra 
pavieniai elementai, kuriais galima manipuliuoti nepriklausomai vienas nuo kito. Kiekvienas elementas turi tam 
tikras apibrėžtas charakteristikas arba „savybes“, tokias kaip, spalva, dydis, padėtis ir t.t. Svarbiausia 
siuvinėjimo objekto savybė yra dygsnio tipas. 
 
Bazinės procedūros 
Šiame skyriuje aprašyta, kaip paleisti DigitizerPro EasyDesign ir DigitizerPro EasyEdit programas, kaip 
atidaryti piešinius, pradėti naujus ir panaudoti bazines komandas. Jame taip pat aiškinama, kaip įjungti ir 
išjungti tinklelį ir siuvinėjimo lankelį ir matuoti atstumus ekrane. Jūs taip pat išmoksite kaip išsaugoti piešinius. 
Detaliau žiūr. 23 puslapį. 
 
Piešinių peržiūra 
Šiame skyriuje aiškinami piešinių peržiūrėjimo metodai, galimi programoje DigitizerPro, taip pat įvairūs 
piešinių peržiūrėjimo nustatymai. Jame aprašyta, kaip abejose programose EasyDesign ir EasyEdit peržiūrėti 
dygsnių siuvimo seką ir kaip pamatyti dysnių seką, lėtai judant per piešinį. Aprašyta, kaip pasiekti informaciją 
apie piešinius, taip pat kaip peržiūrėti ir kaip paslėpti vaizdus. Plačiau žiūr. 31 puslapį Piešinių peržiūrėjimas. 
 
Objektų pasirinkimas 
Šiame skyriuje aprašyta, kaip pasirinkti objektus su tam tikslui skirtais įrankiais ir klaviatūra. Jame 
pavaizduota, kaip pasirinkti, keliaujant per piešinį ir kaip pasirinkti nurodytų spalvų objektus. Jūs taip pat galite 
pasirinkti atskirus dygsnius programoje EasyEdit. Plačiau, žiūr. Objektų pasirinkimas 41 puslapyje. 
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Tinkleliai ir siuvinėjimo lankeliai 
Šiame skyriuje aprašyta, kaip programoje DigitizerPro užsiduoti tinklelio langelių dydžius. Čia taip pat surasite 
apie siuvinėjimo lankelių pakeitimą ir jūsų pačių pasidaryto vartotojo lankelio apibrėžimą. Čia paaiškinta, kaip 
suskaldyti piešinius ant MA Hoop (MA lankelis), persiunčiant juos į mašiną taip pat pakeičiant siuvinėjimo 
lankelių foną. Plačiau, žiūr. Tinkleliai ir siuvinėjimo lankeliai 47 puslapyje. 
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3 Skyrius 
 
ĮVADAS Į ELEKTRONINĮ SIUVINĖJIMO PROJEKTAVIMĄ 
 
 
 
DigitizerPro užtikrina siuvinėtojams greitą ir lankstų būdą sukurti ir redaguoti siuvinėjimo piešinius. Šiame 
skyriuje bendrais bruožais pateiktas elektroninio siuvinėjimo procesas, kaip jį galima atlikti su DigitizerPro. 
 
Piešinių planavimas 
 
Gera siuvinėjimo kokybė prasideda nuo gerai atlikto piešinio. Toliau, jums reikalinga geros kokybės mašina, 
kuri tą paveiksliuką išsiuvinėtų dygsniais. Tačiau dar jums reikia panaudoti tinkamą medžiagą, siūlus, paklotus, 
temptuvus ir t.t.  Turėkite šiuos punktus omenyje: 
 
1)Piešinys atrodo gerai – forma, spalvos, pusiausvyra; 
2)Dygsniai yra pakreipti pagal formą 
3)Figūros užpildytos su tinkamais užpildymo ir kontūriniais dygsniais 
4)Detalės yra aiškiai išreikštos 
5)Dygsniai yra gražūs, glotnūs ir vienodi 
6)Kontūrai išdygsniuoti teisingai – nėra nepageidaijamų tarpų 
7)Užrašas yra aiškus ir lengvai įskaitomas 
 
Išsiuvinėtas piešinys turi pasižymėti tokiomis charakteristikomis: 
*Piešinio siuvinėjimas turi būti mašinai produktyvus 
*Medžiaga aplink išsiuvinėtą vietą neturi raukšlėtis 
*Piešinyje neturi būti laisvų galų 
 
Iliustracijos 
Į EasyDesign galima įterpti, pridurti, nuskenuoti iliustracijas „bitmap“ ir „vector“ formatuose, kad panaudoti 
juos elektroninių šablonų arba dekoracjų sukūrimui. Nors jūs ir esate patyręs programuotojas, nenaudokite 
sudėtingų iliustracijų. Galimi šaltiniai tinkamoms iliustracijoms yra : 
*Siuvinėjimo paveiksliukų knygos ir vaikiškų istorijų knygos 
*Margintos staltiesės arba arbatos rankšluostėliai 
*Vizitinės kortelės, atvirukai, vyniojimo popierius 
*Simbolių bei grafikos apdorojimo programų meninių iškarpų bibliotekos 
*Interneto arba CD meninių iškarpų rinkiniai 
*Pavyzdžiai iš EasyDesign C:\Embroidery Album aplanko 
*Originalūs meno darbai – pav., vaikų piešiniai. 
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Patarimas  Būtinai patikrinkite paveiksliukų, kurie yra ne jūsų sukurti, autorystės teises. Priešingu atveju 
kreipkitės į atitinkamą firmą, kad gauti leidimą panaudoti. 
 
Piešinio kontūrai ir dygsnių seka 
Prieš sudarant siuvinėjimo programą jums reikia atidžiai išanalizuoti ir suplanuoti piešinio kontūrus ir dygsnių 
seką. Piešinio kontūrai turi būti aiškiai apibrėžti, kad lengvai galima būtų juos išsiuvinėti. Geriausi kontūrai turi 
santykinai vienodą plotį, su lygiais pakraščiais, be staigių posūkių ir be mažų kyšančių detalių. Paveiksliuko 
seka apibrėžia dygsnių seką arbą eiliškumą, pagal kurį vyks siuvinėjimas. Žinoma jūs visuomet galite pakeisti 
seką, kad patobulinti siuvinėjimą – pavyzdžiui, kad iki minimumo sumažinti spalvų keitimosi skaičių. Detalės 
turi būti siuvinėjamos paskiausiai. 
 
Siuvinėjo programavimas 
Piešinių programos sukurtos   aplinkoje susideda iš ‚siuvinėjimo objektų‘. Jie vadinami ‚objektais‘, kadangi tai 
yra atskiri vienetai, kuriais galima manimuliuoti nepriklausomai vienas nuo kito. Kiekvienas objektas turi tam 
tikras apibrėžtas charakteristikas arba ‚savybes‘, kaip spalva, dydis, padėtis ir t.t.. Svarbiausia siuvinėjimo 
objektų savybė yra dygsnio tipas. 
 
Į siuvinėjimo programą įeina piešinio bazinių figūrų pavertimas į siuvinėjimo objektą. Skirtingoms figūroms 
yra pritaikyti skirtingi įrankiai. Jūs galite nupiešti juos rankiniu būdu, pažymint svarbiausius taškus pagal 
išorinę liniją arba naudojant ‚protingus‘ įrankius, kurie figūras automatiškai paverčia į siuvinėjimo objektus. 
 
Dygsniai automatiškai skaičiuojami iš piešinio kontūrų ir ploto. Jie regeneruojami visur, kur paspausite Enter. 
Tai reiškia, kad DigitizerPro piešinius jūs galite sumažinti ar padidinti, transformuoti ir keisti jų formą, 
nepakeitus dygsnių tankio ir kokybės. 
 
Objektų pasirinkimas 
Kad sudaryti siuvinėjimo piešinį, DigitizerPro EasyDesign leidžia pasirinkti objektus skirtingais būdais. Galite 
pasirinkti visus objektus, kad modifikuoti pilnai visą piešinį arba individualius objektus, atliekant kruopštesnį ir 
tikslesnį pakeitimą. Detaliau, žiūr.41 pusl. Objektų pasirinkimas. 
 
Piešinių peržiūrėjimas 
EasyDesign užtikrina daugelį būdų, kaip peržiūrėti siuvinėjimo piešinius. Jūs galite parodyti arba paslėpti adatų 
dūrių taškus ir jungtis. Yra galimybė padidinti mastelį, kad pamatyti daugiau piešinio detalių arba net atskirus 
dygsnius. Stebėjimo juosta skersai piešinio padeda stebėti dalis, kurios tuo metu nematomos, taip pat 
naudojamas peržiūros langas, kad pamatyti smulkiausias atsikišusias piešinio dalis. Detaliau, žiūr.31 pusl. 
Piešinių peržiūros būdai. 
 
Naudojamos tinklelio linijos, kurios padeda išlyginti arba kontroliuoti siuvinėjimo objektų matmenis. Tinklelį 
galima rodyti arba paslėpti. Detaliaus, žiūr.28 pusl. Tinklelio rodymas. 
 
Vizualizatorius parodo užbaigto piešinio vaizdą. ‚Keliaujant‘ per piešinį galima pamatyti siuvinėjimo seką, 
spalvas arba objektus. Detaliau, žiūr. EasyDesign 35 pusl. Keliavimas dygsnių seka. 
 
Įvedimo būdai 
Priklausomai nuo figūros formos ir reikalingų dygsnių, jūs galite panaudoti skirtingus ‚įvedimo būdus‘ arba 
‚įrankius‘, kad įvesti ‚bazinius taškus‘. 
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 Įvedimo metodas priklauso nuo to kaip vyks siuvinėjimas, ar pagal išorinę liniją, stulpeliu pakreipiant dygsnius 
ar užpildant plotą lygiagrečiais dygsniais. 
 1-Kintamo pločio stulpelis 
 (Turning Angle fill -Užpildymas pasukant kampu) 
 2-Didelė netaisyklinga figūra 
 (Parallel Fill-Lygiagretus užpildymas) 
 3-Siauras stulpelis (Border-riba) 
 4-Detalė (Single Run Line-siuvinėjimas vienguba  linija) 
Viengubo arba trigubo dygsniavimo linijoms piešti galima panaudoti Single Run Line įrankį. Single Run Line 
išilgai nupieštos linijos pakloja vieną eilutę dygsnių. Storesnei linijai, Triple Single Run Line pakartoja 
kiekvieną dygsnį tris (arba daugiau) kartų. Detaliau, žiūr.58 pusl. Linijų piešimas. 
 
Norint atvaizduoti kintamo pločio stulpelius ir išsiūti posūkius, reikia naudoti Turninig Angle Fill įrankį. 
Atžymėtos poros bazinių taškų apibrėžia kontūrą, o linijos jungiančios poras apibrėžia dygsnių kampus. 
Detaliau, žiūr.61 pusl. Kintamo pločio stulpelių programavimas 
 
Įrankis Border naudojamas pastovaus pločio stulpeliams programuoti. Dažniausiai jis naudojamas riboms ir 
kontūrams tarp didesnių figūrų. Jūs galite naudoti stulpelius, kad sukurti storas linijas ir ribas. Boders tipiškai 
naudojamas su dygsniais Satin.  
Parallel Fill įrankis naudojamas didelėms ir netaisyklingoms figūroms kurti. Su šiuo įrankiu galima sukurti 
daugumą figūrų. Projektuodami ribas Parallel Fill objektų viduje, galite sukurti užpildytus objektus su 
kiaurymėmis. Detaliau, žiūr.61 pusl. Sudėtingų figūrų su fiksuotu dygsnių kampu projektavimas. 
 
Dygsnių tipai 
Yra trys baziniai dygsnių tipai, galimi su siuvinėjimo mašinomis. – Single Run line, Satin ir Weave Fill. Visi 
kiti yra pastarųjų variantai. Naudotinų dygsnių tipai priklauso nuo objekto formos, dydžio ir efekto, kurį 
norėtumete pasiekti. Plačiau, žiūr.65 pusl. Užpildymo dygsniai. 
 
Satin dygsniai sukuria žvilgantį, aukštos kokybės efektą. Jie labai tinka siaurų figūrų arba ‚stulpelių‘ 
siuvinėjimui, kur kiekvienas dygsnys apima visą stulpelio plotį. Plačiau, žiūr.66 pusl.  Figūrų Satin dygsniais 
sukūrimas.  
 
Weave Fill dygsnius sudaro dygsnių grupių eilės, jie tinkami didelių netaisyklingų figūrų užpildymui. Jūs galite 
pasirinkti iš daugelio patrauklių Weave Fill pavyzdžių. Bendrai, siūlomas dydis ir intervalas duos geriausius 
rezultatus, tačiau galimas atvejas, kad jūs norėsite pakeisti dygsnių kampą. Plačiau, žiūr.67 pusl. Figūrų su 
Weave Fill dygsniais sukūrimas.  
 
Embosed Fill yra dekoratyviniai užpildantys dygsniai, kur adatos dūriai suformuoja plytelių motyvą. Galimas 
pasirinkimas iš plačios gausybės paruoštų pavyzdžių. Plačiau, žiūr.68 pusl. Figūrų su Embosed Fills dygsniais 
sukūrimas. 
 
Pastaba  Projektuojant linijas iš viengubos dygsnių grupės, programoje EasyDesign naudokite Single Run Line 
metodą. Single Run Line vienu metu yra dygsnių tipas ir ‚įvedimo būdas‘.Plačiau, žiūr.58 pusl. Linijų 
projektavimas. 
 
 
Siūlų spalvos ir siūlų diagramos 
Programuojant,  iš Color Chart jūs rinksitės siūlų spalvas kiekvienam kuriamam objektui. Nauji objektai 
sudaromi, pasinaudojant pasirinkta spalva. DigitizerPro leidžia jums sutvarkyti siūlų spalvas jūsų spalvų 
diagramoje Color Chart. Yra pasirinkimo galimybė iš plataus diapazono komercinių siūlų diagramų. 
DigitizerPro programoje jūs galite nustatyti spalvą siuvinėjimo lankelio viduje, kad suderinti ją su audinio, ant 
kurio ruošiatės siuvinėti, spalva. 
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Fono spalvos yra laikomos piešinio projekto detalėmis ir yra išsagomos kartu su piešiniu. Plačiau, žiūr.79 pusl. 
Siūlų spalvos. 
 
 
 
 
 
 
Jums reikia nuspręsti kiek skirtingų siūlų spalvų panaudoti ir kokia tvarka jos bus įjungiamos. Projektuodami,  
spalvą pasirinksite iš spalvų paletės. Kur tik įmanoma, suprastinkite piešinį, sumažindami spalvų pasikeitimų 
skaičių. Visuomet pradėkite nuo užnugarinių figūrų ir sluoksnis po sluoksnio judėkite į priekį 
 
 
Dygsnių kokybės pagerinimas 
 
Siuvinėjimo išvaizda ir kokybė daug priklauso nuo apatinio sluoksnio, kuris tarnauja pamatu, ant kurio 
dengiami dygsniai. Be apatinio sluoksnio siuvinys gulasi tiesiogiai ant siuvinėjamos medžiagos, kuri dažnai 
persišviečia. Nauji projektuotojai ko gero bandytų padidinti dygsnių tankį, tačiau žymiai efektyviau yra po 
siuvinėjimo medžiaga pakloti kitos medžiagos sluoksnį. Nors tai padidina dygsnių kiekį, apatinis sluoksnis 
padeda stabilizuoti medžiagas, sumažinti jų raukšlėjimąsi ir užtraukas, ypatingai ant didesnių piešinių. Jis taip 
pat užtikrina ‚paaukštinimą‘, pakeliant aukščiau dygsnių dangą, taip išvengiama dygsnių paskendimo į 
minkštus audinius. Toks sluoksnis taip pat gali atitinkamai paruošti šiauštas ar pūkuotas medžiagas, 
priplodamas jas. Plačiau, žiūr.139 pusl. Sustiprinimas ir stabilizavimas su apatiniais sluoksniais. 
 
Siuvinėjimo dygsniai, ten kur duria adata, įtraukia audinį. Tai sukelia audinio raukšlėjimąsi, tarp siuvinėjimo 
dygsnių pasirodo plyšeliai. Norint gerai išsiuvinėti objektą, reikia teisingai parinkti intervalą tarp dygsnių, siekti 
pakankamo audinio traukimo kompensavimo, derinant panaudojamą apatinį sluoksnį su dengiančių dygsnių 
tipu, objekto tipu, objekto forma ir audiniu.  DigitizerPro pateikia rinkinį optimizuotų audinių nustatymų, todėl 
programinė įranga įvertina audinio tipą ant kurio jūs siuvinėjate. Plačiau, žiūr.142 pusl. Darbas su audiniais. 
 
Proektavimas su iliustracijomis 
Yra dvi plačios iliustracijų failų kategorijos, kurias galima importuoti į EasyDesign ir panaudoti kaip bazę 
projektavimui. 
 

• Bitmap images: Jie susideda iš spalvotų taškų arba pikselių. Padidinę mažą plotelį pamatysite dantytus 
kontūrus ir pikselių serijas. 

• Vector images: Jie susideda iš kontūrų, kurie gali būti nuspalvinti ir užpildyti spalvomis. Vector 
vaizdai, importuojant juos į EasyDesign, automatiškai paverčiami į Bitmap vaizdus . 

Norint sukurti geros kokybės siuvinėjimo produktą, jums reikia pasirinkti tinkamą iliustraciją tinkamo 
formato. Programa suteikia geriausias galimybes tiek rankiniam tiek automatiniam projektavimui, išvalyti 
iliustraciją iki riboto skaičiaus spalvų ir gerai apibrėžtų kontūrų. 
 
 
 
 
1)Bitmap vaizdas sutvarkytas pagal mastelį ir pašalintu fonu – paruoštas rankiniam projektavimui 
2)Perspalvinti plotai ir pagerinti kontūrai – paruoštas automatiniam projektavimui. 
 

Kad paruošti gerus kokybiškus vaizdus, iliustraciją, kuri yra ne skaitmeniniame formate, reikia teisingai 
nuskenuoti. Bitmap  vaizdus, prieš naudojant juos automatiniam projektavimui, būtina atitinkamai paruošti su 
EasyDesign iliustracijų paruošimo įrankiais. Plačiau, žiūr.96 pusl. Vaizdų paruošimo įrankių panaudojimas. 
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Automatinis projektavimas 
Click-to-Stitch įrankiai yra naudingi greitam siuvinėjimo objektų sukūrimui iš vaizdų, kurie nereikalauja 
ypatingų meninių efektų arba specifinių siuvinėjimo žinių. Tai atleidžia jus nuo laiko eikvojimo meniškumui ir 
darbui sudėtingoms jūsų piešinių dalims. Plačiau, žiūr.102 pusl. Vaizdų projektavimas su Click-to-Stitch. 
 
Click-to-Design  automatiškai iliustraciją paverčia į pilnai suprojektuotą siuvinėjimo programą, 
nereikalaujančią arba reikalaujančią mažos korekcijos. 
Galima naudoti įvairias iliustracijų formas – Bitmap ir Vector – ir įvairius vartotojo ‚pagalbos‘ lygius taikomus 
šiam procesui. Plačiau, žiūr.104 pusl. Automatinis vaizdų projektavimas su Click-to-Design . 
 
 
 
 
 
Kad sukurti siuvinėjimo piešinį iš fotografijos ar kitokių spalvotų arba juodai baltų vaizdų, naudokite Photo 
Click įrankį. Photo Clik piešiniai susideda iš dygsnių eilučių su kintančiu intervalu. Efektas yra panašus į 
gaunamą iš linijinio spausdintuvo. Plačiau, žiūr.106 pusl. Siuvinėjimo vaizdų sukūrimas iš fotografijų. 
 
Piešinių modifikavimas 
Suprojektavę savo piešinį, jūs galite jį modifikuoti visą arba redaguoti atskirus objektus arba net individualius 
dygsnius. 
EasyDesign leidžia jums greitai papildyti piešinius dubliuotais objektais arba esamų objektų kopijomis. Jis taip 
pat leidžia sujungti piešinius, įterpiant vieno failo turinį į kitą failą. Plačiau, žiūr. 111 pusl. Objektų ir piešinių 
sujungimas. 
 
Pastaba Prieš modifikuojant bet kokį piešinį, gera praktika yra išsaugoti kopiją nauju vardu ir laikyti originalą 
tam atvejui, jeigu jūs panorėsite atmesti savo pakeitimus ir pradėti modifikuoti išnaujo. 
 
Siuvinėjimo seka paprastai vyksta ta pačia tvarka, kaip buvo suprojektuotas piešinys. Tačiau jūs galite pakeisti 
tai, panaudojant daugybę metodų. Dialogas Resequence (pakeisti seką) pateikia objektų, sugrupuotų pagal 
objektus arba spalvas, nuoseklų sąrašą. Tai lengvai leidžia išnaujo perrykiuoti pasirinktus objektus ir spalvų 
blokus. Plačiau, žiūr. 114 pusl. Siuvinėjimo objektų sekos pakeitimas. 
 
 
 
 
 
 
Objektų tvarkymas ir transformavimas 
Jūs galite pakeisti objektų padėtį, dydį orientaciją piešinyje, perkeldami juos į kitą vietą, pakeisdami jų mastelį 
ir transformuodami juos. Galite sugrupuoti objektus, kad pritaikyti pakeitimą visiems iškarto arba užrakinti 
juos, kad išvengti nepageidaujamos modifikacijos. Jūs galite modifikuoti objektus tiesiogiai ekrane arba 
keisdami jų nustatomus parametrus. Kai kurias iš tokių funkcijų galite pasiekti per iškylančią meniu. Plačiau, 
žiūr. 119 pusl. Objektų tvarkymas ir transformavimas. 
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Pastaba  Mastelio keitimo galimumas ir dygsniavimo kokybė žymiai priklauso nuo pačio piešinio originalo 
šaltinio. Tiktai tikrieji JAN piešiniai turi pilną informaciją, reikalingą 100% kokybiškam mastelio keitimui ir 
transformacijai. 
 
Objektų formos keitimas ir redagavimas 
DigitizerPro leidžia jums keisti objektų formas pagal kontrolinius taškus. Tai labai nežymiai pakeičia objekto 
tipą.Kai kuriems objektams galite taip pat pakeisti kontrolinius taškus nuo kampinių taškų iki kreivių. Aplink 
pasirinktus objektus pasirodis dygsnių kampų linijos ir įėjimo ir išėjimo žymekliai. Dygsnių kampų 
reguliavimas priklauso nuo objekto, su kuriuo jūs dirbate, tipo.Kai kuriems objektams jūs galite nustatyti 
dygsnių kampą ištisam objektui. Kitiems jūs galite pareguliuoti posūkių dygsnių kampus. Taip pat, 
individualiems objektams jūs galite pakeisti dygsnių įėjimo ir išėjimo taškus.Tai yra naudinga, mažinant kelių, 
jungiančių besiribojančius objektus, skaičių. Plačiau, žiūr. 125 pusl. Objektų formos keitimas ir redagavimas. 
 
Dygsnių redagavimas 
DigitizerPro programoje su EasyDesign dygsniai automatiškai generuojami iš piešinio kontūrų užimamo ploto. 
Tai reiškia, kad DigitizerPro piešiniams jūs galite keisti mastelį, transformuoti ir keisti formą, nepakeisdami 
dygsnių tankio ir kokybės.  
DigitizerPro EasyEdit leidžia jums dirbti su tradiciniais dygsniniais piešiniais  SEW arba JEF formatuose. 
EasyEdit pagalba jūs galite tiksliai sureguliuoti savo piešinius, nekonvertuojant jų į JAN formatą. EasyEdit 
leidžia jums redaguoti individualius dygsnius. Jūs paprasčiausiai pasirenkate juos panašiai kaip bet kokį objektą 
perkeliate adatos smaigalio padėtį į norimą vietą. Jums ypač gali to prireikti, dirbant su ‚dygsnių‘ failais, 
kuriuose nėra piešinio kontūrų duomenų. Plačiau, žiūr. 157 pusl. Dygsnių redagavimas. 
 
Tobulesnis projektavimas  
 
Patyrusiam projektuotojui DigitizerPro užtikrina visą eilę sudėtingesnių projektavimo galimybių, kurios 
pagerina siuvinėjimo piešinio išvaizdą skirtingiems siuvinėjimo gaminių tipams. 
 
Objektų detalės ir šablonai 
Siuvinėjimo objektų detalių bendros charakteristikos yra dydis ir padėtis, o taip pat siuvinėjimo specifinės 
charakteristikos, kaip dygsnių tipas ir tankis. Ypatingi dygsnių nustatymai apibrėžia, kaip dygsniai bus 
regeneruojami, keičiant objekto formą, transformuojant jį arba keičiant mastelį. 
 
Jums pradedant projektuoti naują piešinį, DigitizerPro panaudoja pradinius nustatymus arba ‚reikšmes‘, 
saugomas šablone. Daugumai piešinių galima panaudoti ‚Normal‘ šablonus, tačiau jūs galite sukurti ir naudoti 
savo nuosavą šabloną. Realiai jūs galite išsaugoti bet kokius nustatymų derinius, kaip mėgstamiausi dygsniai 
arba raidiniai nustatymai. Plačiau žiūr. 133 pusl. Objektų detalės ir šablonai.  
 
Pranašesnė projektavimo technika 
DigitizerPro užtikrina specializuotas projektavimo galimybes, kad pagerinti jūsų siuvinėjimą. Naudokite Cut 
Hole įrankį, kad panaikinti skylutes objekte ir išvengti papildomų dengiančių dygsnių sluoksnių. Fill Holes 
funkcija užpildo skylutes pasirinktuose Parallel Fill objektuose, pašalinant jas visiškai arba sukuriant naujus 
objektus, pagrįstus ant skylučių iš originalaus objekto. Plačiau žiūr. 147 pusl. Pranašesnė projektavimo 
technika.  
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Naudokite Feather Edge, kad savo piešinyje sukurti grubius pakraščius, šešėlių efektus arba imituoti kailį arba 
pūkuotą tekstūrą. Gradient Fill  sukuria meniškų dygsnių efektą, kuris pasireiškia laipsnišku dygsnių intervalų 
kitimu nuo tankaus iki atviro užpildymo per siuvinėjimo objektą.Tai jums leidžia lengvai sukurti skirtingų 
atspalvių ir spalvų efektus. Plačiau, žiūr. 151 pusl. Palaipsninių užpildymų efektų sukūrimas.  
 
 
 
 
 
DigitizerPro programoje, yra tipiškai naudojamas Travel on Edge  efektas kartu su atviru Weave Fill  
siuvinėjimu, kad užpildyti fonus arba šešėlių efektams. Naudodami siuvinėjimo įrankį Applique,  galite 
automatiškai sukurti viską, ko reikia aplikacijai. Priklausomai nuo esamo nustatymo, yra generuojami iki trijų 
siuvinėjimo sluoksnių:  gairių, tvirtinimo ir padengimo. Plačiau, žiūr. 153 pusl. Aplikacijų projektavimas.  
 
 
 
 
 
Siuvinėjimo antspaudai ir motyvai 
Siuvinėjimo atnspaudai tai yra išanksto apibrėžti piešinio elementai, kaip širdelės, lapai arba apsiuvų raštai. 
Paprastai jie susideda iš vieno arba daugiau paprastų objektų, sudarytų iš Run ir/arba Satin  dygsnių. 
Siuvinėjimo antspaudus naudokite kaip dekoratyvius elementus. 
DigitizerPro taip pat užtikrina siuvinėjimo motyvų biblioteką. Šiuos motyvus galima sujungti kartu ir sukurti 
pasikartojančius ornamentus arba ornamentinius užpildus. Antspaudai paprastai yra žymiai didesni už motyvus, 
kurie naudojami įrankiuose Motif Runs ir Motif Fills, ir juose yra Satin dygsnių, ne vien tik Run dygsniai. 
Plačiau, žiūr. 71 pusl. Siuvinėjimo antspaudai ir motyvai. 
 
 
 
 
 
Raidžių siuvinėjimas 
 
DigitizerPro siūlo įvairius būdus, kaip greitai ir lengvai papildyti piešinius raidėmis, panaudojant atmintyje 
patalpintus siuvinėjimo fontus arba konvertuojant bet kokius TrueTipe fontus, įdiegtus jūsų sistemoje. Raidinių 
objektų formatavimui naudokite tuos pačius būdus kaip Word procesoriuje, įskaitant ir italic. 
Orientavimas apsprendžia raidinių objektų formą piešinyje. Jūs galite raides patalpinti tiesioje horizontalioje 
arba vertikalioje bazinėje linijoje, kreivėje aplink apskritimą arba lanku arba sukurti savo bazę. DigtizerPro 
suteikia galimybę dialoginiame režime kontroliuoti daugelį basinių linijų nustatymų.Raidžių ir linijų intervalus 
galima nustatyti prieš arba po raidinių objektų sukūrimo ir patalpinus juos į piešinį. Plačiau, žiūr. 163 pusl. 
Raidžių siuvinėjimo pagrindai.  
 
DigitizerPro suteikia dialogą ir tikslią skaitmeninę daugelio nustatymų, veikiančių raidinius objektus, kontrolę. 
Jūs galite reguliuoti objektus kaip grupę arba individualias raides, sudarančias raidinį objektą. Pats pirmas 
sukurtas raidinis objektas gali būti per didelis arba per mažas.  
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Dydį galima sureguliuoti dialoginiu būdu arba nustatymais. Išskyrus mastelį, dialogo būdu raidinius objektus 
jūs galite pakreipti ar pasukti. Raidžių išdėstymą taip pat galite pareguliuoti ekrane, kai tik raidės bus perkeltos 
į piešinį. Plačiau, žiūr. 173 pusl. Raidžių readagavimas. 
 
Kaip kiekvienas siuvinėjimo objektas, kiekvienas raidinis objektas turi savas savybes. Prieš projeektuojant 
raidinį objektą, jūs galbūt panorėsite pareguliuoti dygsnių tipo, kurį jūs ruošiatės panaudoti, nustatymus. 
Arba galbūt jūs norite pakeisti dygsnių nustatymus ir esamiems objektams taikomus efektus. Plačiau, žiūr. 184 
pusl. Skirtingų dygsnių tipų taikymas raidiniams objektams. 
 
Papildomai, DigitizerPro prie savo vidinės siuvinėjimo alfabetų bibliotekos leidžia bet kokį TrueTipe fontą, 
įdiegtą jūsų sistemoje, pervesti į siuvinėjimo alfabetą.Rezultatas yra panašus į siuvinėjimo alfabetus, nors 
kokybė gali būti ne tokia aukšta. Plačiau, žiūr. 185 pusl. TrueTipe fontų pavertimas į siuvinėjamus. 
 
Pridėkite prie piešinio dekoratyvinius rėmelius, pavyzdžiui stačiakampį, ovalą ar skydelį. Pridedamo rėmelio 
dydis automatiškai  sureguliuojamas, kad tiktų esamam piešiniui. Norėdami raidinius objektus padaryti 
išpūstus, išlenktus, ištemptus arba suspaustus, taikykite Lettering Art efektus. Plačiau, žiūr. 187 pusl. Specialių 
efektų sukūrimas su Lettering Art. 
 
Piešinių išvedimas, saugojimas ir tvarkymas 
 
Išvesti siuvinėjimo piešinius jūs galite daugeliu būdų – išsaugodami diske arba išsiųsdami jį tiesiai į 
siuvinėjimo mašiną. Dizaineriai dažnai nori paskirstyti savo piešinius taip, kad jie matomi realiomis spalvomis 
pavyzdžiui į Vizualizer‘į arba kitaip. EasyDesign atveju jūs galite išsaugoti diske tiek piešinio vaizdus tiek 
gamybines darbo užduotis arba viską išsiųsti elektroniniu paštu. Plačiau, žiūr. 201 pusl. Piešinių failų skaitymas 
ir rašymas. 
 
Pagal standartą EasyDesign piešinius išsaugoja į savo gimtąjį failų formatą JAN. Šiame formate yra visa 
informacija būtina siuvinėjimo piešiniui ir vėlesnei modifikacijai. Išsaugojant piešinį, įrašomas jo failo vardas, 
išsaugojimo vieta ir formatas ir visuomet atnaujinamas po bet kokių pakeitimų. JAN formato failai automatiškai 
suspaudžiami, kad sumažinti užimamos atminties dydį, tokiu būdu galima išsaugoti didelius failus. 
 
Piešinių galerėja 
DeignGallery įrankis leidžia efektyviai tvarkyti siuvinėjimo piešinius. Šis piešinių tvarkymo įrankis gali 
pasiekti piešinių failus, esančius jūsu kompiuterio standžiajame diske, CD-ROM arba lanksčiajame diske. Jis 
atpažįsta visus piešinių failų formatus, kuriuos naudoja EasyDesign. Plačiau, žiūr. 227 pusl. Piešinių tvarkymas. 
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4 skyrius 
 
PAGRINDINĖS PROCEDŪROS 
 
Norint pradėti naudoti DigitizerPro, jums reikia žinoti pagrindines procedūras, kaip programos paleidimas, 
piešinių atidarymas ir sukūrimas naujų ir jų išsaugojimas. 
Prie kitų pagrindinių procedūrų galima priskirti tinklelio įvedimą ir slėpimą, įrankių juostų išvedimą į ekraną ir 
jų panaudojimą. 
 
Šiame skyriuje aprašyta, kaip paleisti DigitizerPro EasyDesign ir DigitizerPro EasyEdit, kaip atidaryti 
piešinius, pradėti naujus ir kaip naudotis pagrindinėmis komandomis. Jame aiškinama kaip įjungti ir išjungti 
tinklelį ir lankelį ir kaip matuoti atstumus ekrane. Jūs taip pat išmoksite išsaugoti piešinius. 
 
 
DigitizerPro paleidimas 
 
DigitizerPro yra sudarytas iš dviejų atskirų programų – EasyDesign ir EasyEdit – abi paleidžiamos iš Windows 
darbo lauko. EasyDesign naudojamas piešinių kūrimui, o EasyEdit esamų piešinių modifikavimui. 
 
Pastaba  Jūs vienu tuo pačiu metu galite atidaryti tiktai vieną programą EasyDesign arba EasyEdit. 
 
Perspėjimas  Jeigu jums dirbant su DigitizerPro apsauginis įtaisas (raktas) buvo nuimtas arba dingo kontaktai 
jo jungtyje, tai ekrane pasirodis pranešimas apie klaidą. Atšaukite pranešimą ir išeikite iš DigiržtizerPro. Šiuo 
metu jūs prarasite neišsaugotus pakeitimus, atliktus piešinyje. Išnaujo įdėkite apsauginį įtaisą į kompiuterį ir, 
įsitikinę, kad jis patikimai pritvirtintas, vėl paleiskite DigitizerPro. 
 
DigitizerPro EasyDesign paleidimas 
Du kartus spragtelėti, kad paleisti EasyDesign 
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Atidarydami DigitizerPro EasyDesign naudokitės piktograma ant ekrano arba Windows Start meniu. 
 
Kad paleisti DigitizerPro EasyDesign 
1.Du kartus spragtelėkite ant DigitizerPro EasyDesign piktogramos, esančios ant Windows darbinio lauko 
(ekrano) 
Arba kitu būdu, iš Start meniu pasirinkite Programs>Janome DigitizerPro > EasyDesign 
EasyDesign programai pasileidžiant, pasirodo dialoginis langas 
 
 
 
 
2.Pasirinkite labiausiai jums tinkančią parinktį: 
*Atidaryti egzistuojantį piešinį: Naudoti šią parinktį, jeigu jūs jau turite egzistuojantį piešinį arba norite 
panaudoti vieną iš esančių pakuotėje. Skaitykite taip pat pusl.25 Piešinių atidarymas programoje EasyDesign. 
*Projektuoti iš egzistuojančio vaizdo: Naudokite šią parinktį, jeigu jūs turite elektroninę iliustraciją, kurią norite 
panaudoti už pagrindą naujam piešiniui.  Skaitykite pusl.85 Projektavimas su fonais. 
*Laisvas projektavimas:Naudokite šią parinktį, jeigu norite sukurti naują piešinį su esamais piešimo įrankiais 
DigitizerPro viduje. 
 
Jeigu pasirinksite vieną iš dviejų antrų parinkčių, atisidarys dialogo langas Choose Fabric 
 
 
 
 
3.Pasirinkite vieną nustatytų medžiagų. 
DigitizerPro užtikrina rinkinį optimizuotų medžiagų nustatymų, kurių dėka programa įvertins medžiagos, ant 
kurios jūs siuvinėsite, tipą. Skaitykite taip pat pusl.142 Darbas su medžiagomis. 
Jeigu jūs pasirinkote laisvą projektavimą, EasyDesign atsidarys su tuščiu piešiniu (Design1) 
 
 
 
 
 
 
4.Nusistatykite piešinio langą su įjungtu arba išjungtu tinkleliu, pakeiskite tinklelio dydį, išveskite arba 
paslėpkite įrankių juostas. Plačiau skaitykite pusl.28 Tinklelio įjungimas lange ir pusl.26 Įrankių juostų 
įvedimas ir slėpimas. 
 
DigitizerPro EasyEdit paleidimas 
Du kartus spragtelėti, kad paleisti EasyEdit 
 
 
Kad paleisti DigitizerPro EasyEdit 
*Du kartus spragtelėkite ant DigitizerPro EasyEdit piktogramos, esančios ant Windows darbinio lauko (ekrano) 
Arba kitu būdu, iš Start meniu pasirinkite Programs>Janome DigitizerPro > EasyEdit 
EasyEdit programa atsidaro su nauju tuščiu piešiniu (Design1) 
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*.Nusistatykite piešinio langą su įjungtu arba išjungtu tinkleliu, pakeiskite tinklelio dydį, išveskite arba 
paslėpkite įrankių juostas. Plačiau skaitykite pusl.28 Tinklelio įjungimas lange ir pusl.26 Įrankių juostų 
įvedimas ir slėpimas. 
 
Piešinių atidarymas programoje EasyDesign 
 
Naudokite įrankį Open (standartinėje įrankių juostoje), kad atidaryti egzistuojantį piešinį 
 
DigitizerPro EasyDesign atidaro JAN failus. Žiūr. pusl.202, Siuvinėjimo piešinių formatai. 
 
Perspėjimas  Jūs negalite atidaryti failų sukurtų ankstesnėje programinės įrangos versijoje. 
 
Kad atidaryti piešinį EasyDesign programoje. 
1.Spragtelėti ant piktogramos Open. 
Atsidaro dialogas Open 
 
 
 
 
 
2.Iš sąrašo Look in pasirinkite bylą 
3.Jeigu piešinys yra ne JAN formato, pasirinkite failo tipą iš Files>Types sąrašo 
4Pasirinkite piešinį arba piešinius. 

*Norint pasirinkti paeiliui kelis ir daugiau  pavadinimų, pasirenkant laikykite nuspaustą klavišą Shift. 
 *Norint pasirinkti daugybę piešinių, pasirenkant laikykite paspaustą ctrl. 
5.Pasirinkite Preview  kontrolinį langelį, kad peržiūrėti piešinius (palaikomų formatų failams) kartu su piešinių 
duomenimis. Tai yra dygsnių ir spalvų skaičius, piešinio aukštis ir plotis 
 
Pabandykite tai!  Kad gauti daugiau informacijos apie pasirinktą failą, spragtelėkite dešiniu pelės klavišu 
Windows Explorer programoje ir pasirinkiteProperties  iš nusileidusio meniu. 
 
6.Spragtelėti Open. 
 
Piešinių atidarymas programoje EasyEdit 
 
Naudokite įrankį Open (standartinėje įrankių juostoje), kad atidaryti egzistuojantį piešinį 
 
DigitizerPro EasyEdit atidaro JEF ir SEW failus. Žiūr. plačiau pusl.202, Siuvinėjimo piešinių formatai. 
 
Perspėjimas  Jūs negalite atidaryti failų sukurtų ankstesnėje programinės įrangos versijoje. 
 
Kad atidaryti piešinį EasyEdit programoje. 
1.Spragtelėti ant piktogramos Open. 
Atsidaro dialogas Open 
 
 
 
 
 
2.Iš sąrašo Look in pasirinkite bylą 
3.Jeigu piešinys yra ne JEF formato, pasirinkite failo tipą iš Files>Types sąrašo 
4Pasirinkite piešinį arba piešinius. 

*Norint pasirinkti paeiliui kelis ir daugiau  pavadinimų, pasirenkant laikykite nuspaustą klavišą Shift. w
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 *Norint pasirinkti daugybę piešinių, pasirenkant laikykite paspaustą ctrl. 
 
5.Spragtelėti Open. 
 
Persijungimas tarp EasyDesign ir EasyEdit 
DigitizerPro vienu spragtelėjimu leidžia jums greitai persijunginėti tarp EasyDesign ir EasyEdit langų.  
Norint persijungti iš EasyDesign į EasyEdit reikia spragtelėti ant piktogramos Switch to EasyEdit, kuri yra 
EasyDesign programoje Standart įrankių juostoje. Galimas atvirkštinis persijungimas vyksta analogiškai per 
Standart įrankių juostą programoje EasyEdit. Persijungimo metu jums bus priminta išsaugoti jūsų atliktus 
pakeitimus 
 
 
 
Komandų panaudojimas 
Paleidę programą DigitizerPro, jūs būtinai pasinaudosite komandomis arba įrankiais ir dialogais, kad užbaigti 
savo užduotis. DigitizerPro komandos pasirenkamos tokiu pačiu būdu kaip ir Windows aplinkos programose – 
iš meniu, įrankių juostos arba iš išsiskleidusių meniu. Dažniausiai naudojamoms komandoms taip pat taikomi 
klavišų rinkiniai klaviatūroje. Plačiau, skaitykite pusl.251 Greitas žinynas. 
 
Komandų pasirinkimas iš įrankių juostų 
Įrankių juostos leidžia greitai pasiekti DigitizerPro komandas. Kai kurios iš šių komandos galimos iš 
išsiskleidusių meniu. Kad aktyvuoti komandą, reikia spragtelėti ant piktogramos įrankių juostoje. DigitizerPro, 
kad taupyti vietą ekrane, užtikrina ‚iškylančias įrankių juostas‘ iš Digitize įrankių juostos. Iš iškylančios juostos 
pasirinktas įrankis tampa aktyviu įrankiu Digitize juostoje. 
 
Kad pasirinkti komandas iš įrankių juostos 
*Patalpinkite pelės rodyklę ant įrankio piktogramos, kad pamatyti įrankio vardą atsidarusiame langelyje. Jūsų 
paslaugoms DigitizerPro siūlo tokias įrankių juostas. Detaliau, skaitykite žemiau Įrankių juostų parodymas ir 
slėpimas. 
 
 
 
 
*Spragtelėkite ant pictogramos, kad aktyvuoti komandą. 
*Kad pasiekti iškylančias juostas, reikia Digitizer juostoje spragtelėti ant iškylančios juostos rodyklės, kuri 
pavaizduota ties įrankio apatiniu kairiuoju kampu. Iškilusi juosta pasilieka atidaryta, kol jūs nepasirinkote kokio 
nors įrankio. 
 
 
 
 
 
 
 
*Norint uždaryti iškilusią įrankių juostą nieko napasirinkus, tiesiog spragtelėkite kur nors už juostos ribų. 
 
Įrankių juostų parodymas ir slėpimas 
Įrankių juostos užtikrina greitą ir lengvą priėjimą prie DigitizerPro komandų. Dėl patogumo, jūs galite 
pasirinkti, kad jos būtų matomos arba paslėptos. 
 
Patarimas  Kad padidinti savo darbinį lauką ekrane, paslėpkite nereikalingas įrankių juostas ir vietoj jų 
naudokite meniu ir komandas iš klaviatūros. Plačiau, skaitykite 251 pusl. Greitas žinynas. 
 
Kaip rodyti ir slėpti įrankių juostas 
*Pasirinkti View>Toolbars 
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*Pasirinkite įrankių juostas, kurias jūs norite matyti. 
*Išjunkite įrankių juostas, kurių jūs nenorite matyti. 
 
Pastaba  DigitizerPro įrankių juostos yra mobilios. Norint perkelti įrankių juostą į patogesnę vietą, reikia 
spragtelėti ir tempti ją. Kad nustatyti juostą į normalią padėtį, reikia du kartus spragtelėti ant juostos titulinio 
pavadinimo. 
 
  -Spragtelėti ant juostos krašto ir tempti ją 
 
Popup (iškylančių) meniu panaudojimas 
Spragtelėjus dešiniu pelės klavišu ant pasirinkto objekto, atsidaro popup meniu, kuriame yra dažniausiai 
naudojamos komandos._________________________________________ 
 
Kad panaudoti popup meniu 
1.Spragtelėti dešiniu pelės klavišu ant pasirinkto objekto. 
Atsidaro popup meniu. 
2.Pasirinkti komandą iš meniu. 
 
Komandų atšaukimas ir atgaminimas 
 Naudoti Undo (atšaukti) (standartinė įrankių juosta), kad atšaukti komandą 

Naudoti Redo (atgaminti) (standartinė įrankių juosta), kad iš naujo pritaikyti komandą, kuri buvo 
atšaukta 

 
Jūs galite atšaukti daugelio komandų veiksmus. Jeigu jūs persigalvojote, galite juos vėl atgaminti. 
DigitizerPro atsimena paskutines keletą panaudotų komandų. 
_____________________________________________ 
 
Kad atšaukti ir atgaminti komandas 
*Norėdami atšaukti, spragtelėkite ant Undo piktogramos. 
Kai DigitizerPro daugiau komandų neprisimena, Undo nublanksta. 
*Spragtelėkite ant Redo, norėdami atgaminti atšauktos komandos veiksmą. 
 
Naujų piešinių kūrimas 
Paleidus DigitizerPro, automatškai susikuria naujas failas – Design1 - , paruoštas naujo piešinio projektavimui. 
Pagal pradinį nustatymą, Design1 yra pagrįstas šablonu NORMAL. Kad palengvinti ir pagreitinti projektavimą 
šablonų sudėtyje yra išanksto patalpintų piešinių programų, išankstinių nustatymų ir objektų. 
 
Patarimas  Bet kada, sukūrus naują piešinį, išsaugokite jį nauju vardu. Plačiau apie tai pusl.29 Piešinių 
išsaugojimas. 
 
Naujų piešinių kūrimas pagal NORMAL šabloną 

Spragtelėkite ant New (standartinė įrankių juosta), kad pradėti naują piešinį pagal NORMAL šabloną. 
Galite kurti naują piešinį pagal NORMAL šabloną 
_______________________________________________ 
 
Kad sukurti piešinį pagal NORMAL šabloną 
*Spragtelėti ant piktogramos New. 
Atsidarys tuščias piešinio langas. 
Naujų piešinių kūrimas pagal vartotojo šablonus 
Jūs galite pasirinkti užsakovo šabloną kaip bazę naujam piešiniui. Jeigu nėra kitokio šablono, negu kad 
sistemos siūlomas, tai New  dialogas gali ir nepasirodyti. Plačiau apie tai skaitykite pusl. 135 Piešinių šablonų 
tvarkymas. 
Kad sukurti naują piešinį pagal vartotojo šabloną 
1.Pasirinkti File>New 
Atsidaro dialogas New 
2.Pasirinkti šabloną iš sąrašo 
3.Spragtelėti OK. w
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Lankelių ir tinklelių rodymas 
________________________________ 
 
Pasirinkti lankeliai parodomi Design Windows. Tai užtikrina gaires piešinių dydžių reguliavimui ir jų vietos 
parinkimui. Tinklelio linijas panaudokite tiksliam piešinio išdėstymui arba siuvinėjimo objektų dydžiams 
sureguliuoti. 
 
Lankelių rodymas 
 Spragtelėkite Display Hoop (View įrankių juostoje) , kad pqaslėpti arba parodyti lankelį 
 
Lankeliai reikalingi palaikyti įtemptą siuvinėjamą medžiagą, kai mašina siuvinėja. Jų būna skirtingų dydžių. 
Design Windows‘e pasirinkimui pateikti lankeliai ir taisyklės kaip keisti dydį ir piešinių išdėstymą lankelyje. 
Skaitykite taip pat 47 puslapyje Tinkleliai ir lankeliai. 
 
Pastaba  Darbinio lauko riba lankelio viduje pavaizduota plona raudona linija. Jeigu bet kuri piešinio dalis 
pasirinktam lankeliui atsiduria už siuvinėjimo lauko ribų, tai piešinio išsaugojimo metu pasirodo perspėjimas. 
Tai apsaugo jus nuo atsitiktinio siuvinėjimo už siuvinėjimo ribų ir mašinos pagadinimo, adatai atsitrenkus į 
lankelį. Lankelį galite bet kuriuo metu parodyti arba paslėpti. 
 
Kad parodyti lankelį 
*Spragtelėkite Display Hoop piktogramą, kad įjungti arba išjungti lankelį 
 
*Arba pasirinkite View>Hoop 
*Arba spragtelėkite dešiniu pelės klavišu ant tuščios vietos piešinio lange. Išsiskleis popup meniu: 
 
  -Lankelio parodymo jungiklis 
 
Pabandykite tai  Jūs galite pakeisti tinklelio langelio dydį, patempkite slinkties juostą. Plačiau skaitykite 
pusl.48 Tinklelio langelio nustatymas. 
 
Tinklelio parodymas 
 Spragtelėkite Display Grid (View įrankių juostoje), paslėpti ar parodyti tinklelį. 
 
Tinklelį paslėpti arba parodyti jūsgalite bet kuriuo metu. 
______________________________________________ 
 
Kad parodyti tinklelį 
*Spragtelėkite Display Grid piktogramą, kad įjungti arba išjungti tinklelį.  
*Arba pasirinkite View>Hoop 
*Arba spragtelėkite dešiniu pelės klavišu ant tuščios piešinio lange. Išsiskleis popup meniu: 
 
  -Lankelio parodymo jungiklis 
 
Pabandykite tai  Jūs galite pakeisti tinklelio langelio dydį, patempkite slinkties juostą. Plačiau skaitykite 
pusl.48 Tinklelio langelio nustatymas. 
 
Atstumų matavimas ekrane 
Kad išmatuoti atstumus ekrane, naudokite Measuring Tape (View meniu). 
 
Norėdami išmatuoti atstumą tarp dviejų taškų ekrane, naudokite komandą Measuring Tape. Matavimo 
rezultatai rodomi milimetrais arba coliais, priklausomai nuo parinkties Windows Control panelėje. Skaitykite 
savo Windows dokumentaciją. 
 
Patarimas  Didesniam tikslumui pasiekti, prieš matavimą padidinkite (zoom in) vaizdą. Matavimo rezultatas 
nesikeis nuo didinimo koeficiento. 
_____________________________________________ 
 
Kad išmatuoti atstumą ekrane 
1.Pasirinkite View>Measuring Tape 
2.Spragtelėkite ant pradinio taško. 
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3.Pelės rodyklę perkelkite ant galinio taško ir laikykite pelę. 
Įrankio gale pasirodis išmatotos linijos ilgis kartu su dygsniųkampu. 
 
 
4.Paspauskite Esc, kad išeiti. 
 
Pastaba  Būsenos juostoje jūs galite matyti piešinio plotį ir aukštį. 
 
Piešinių išsaugojimas 
 
DigitizerPro leidžia jums išsaugoti piešinius gimtajame JAN, o taip pat ir kituose ‚kontūrų‘ ir ‚dygsnių‘ failų 
formatuose. Plačiau, skaitykite 202 pusl. Siuvinėjimo piešinių formatai. 
 
Veikiančių piešinių išsaugojimas 
 Naudokite komandą Save (standartinių įrankių juosta), kad išsaugoti veikiantį piešinį. 
 
Išsaugojant piešinį, įrašomas jo failo vardas, saugojimo vieta ir formatas, atnaujinamas, jeigu buvo atlikti bet 
kokie pakeitimai. Kada išsaugojate egzistuojantį piešinį nauju vardu į kitą vietą arba kitame formate, jūs 
sukuriate originalaus piešinio kopiją. Plačiau, skaitykite 204 pusl. Piešinių mašinai išsaugojimas. 
 
Patarimas  Išsaugokite savo piešinį anksčiau ir dažniau. Nelaukite, kol pabaigsite visą darbą. Galite nustatyti 
DigitizerPro taip, kad jūsų darbo metu sistema automatiškai periodiškai perrašinėtų jūsų piešinį į atmintį 
(išsaugotų). Skaitykite žemiau, Automatinio išsaugojimo parinkties nustatymas. 
 
Kad išsaugoti piešinį 
1.Spragtelėti ant Save piktogramos. 
Jeigu išsaugojate piešinį pirmą kartą, atsidaro dialogas Save As. 
 
 
 
 
 
 
 
 
2.Iš sąrašo Save In pasirinkite bylą, į kurią norėsite išsaugoti piešinį. 
3.File Name lauke įveskite piešinio vardą. 
4.Iš sąrašo Save As Type pasirinkite failo formatą. Skaitykite pusl.257 Palaikomi siuvinėjimo failų formatai. 
5.Spragtelėti Save. 
 
Pabandykite tai  Failai, išsaugoti JAN formate automatiškai, automatiškai suspaudžiami išsaugojimo metu ir 
„išpakuojami‘ atidarymo metu.  Tai sumažina užimamos atminties apimtį ir suteikia galimybę lanksčiame 
diskelyje išsaugoti didesnius failus arba išsiųsti juos elektroniniu paštu kaip priedus. 
 
Automatinio išsaugojimo parinkčių nustatymas 
Pasirinkite Work Environment (Setup meniu), kad pasirinkti automatinio išsaugojimo parinktis. 
 
Išsaugoja jūsų darbą automatiškai reguliariais intervalais, panaudojant Auto Save, kad apsaugoti jus nuo darbo 
praradimo kompiuterinės bei programinės įrangos gedimo atvejais. Plačiau, skaitykite 297 pusl. Piešinių failų 
atgaminimo iš archyvinės bylos problema. 
 
Kad nustatyti automatinio išsaugojimo parinktis 
1.Pasirinkti Setup>Work Environment. 
Atsidaro Work Environment>Display tab 
2Pasirinkti Autosave tab 
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30 
3.Pasirinkti Auto Save Design Every langelį (atžymėti paukščiuku) 
4.Minutes lauke įvesti automatinio išsaugojimo intervalą. 
Piešinys bus išsaugojamas BACKUP (archyvinėje) byloje, esančioje jūsų DigitizerPro sistemoje. Jis turės tokį 
patį vardą, kaip originalus failas, tačiau su pratęsimu BAK. 
 
Perspėjimas  Archyviniai failai pasilieka Backup byloje, kol jūs jų neištrinsite.Kad byla standžiajame diske 
neužimtų per daug vietos, reguliariai ištrinkite nereikalingus failus. 
5.Spragtelėkite OK. 
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5 skyrius 
PIEŠINIŲ PERŽIŪRA 
 
 
DigitizerPro užtikrina daug peržiūros galimybių, kad palengvinti darbą su jūsų piešiniais. Galimybė padidinti 
vaizdą, kad detaliau jį matyti arba stebėti realiame dydyje. 
 
Galima parodyti arba paslėpti įvairius piešinio elementus, naudojantis atitinkamais vaizduoklio nustatymais. Jūs 
galite parodyti arba paslėpti adatos dūrių taškus, jungtis ir pačius dygsnius. 
 
DigitizerPro taip pat suteikia informaciją apie piešinius skirtingais būdais ir formatais. Netgi prieš paleidžiant 
DigitizerPro ar atidarant piešinį, tiesiogiai iš Windows Explorer jūs galite informaciją apie piešinius su JAN 
arba JEF failais. Piešinių spausdinimo galimybė irgi užtikrina svarbią gamybinę informaciją, įskaitant piešinio 
peržiūrą, piešinio dydį, spalvų seką ir kitas specialias instrukcijas. 
 
Šiame skyriuje aiškinama apie piešinių peržiūros režimus, veikiančius programoje DigitizerPro taip pat apie 
įvairius piešinių peržiūros nustatymus. Čia aprašoma kaip stebėti siuvinėjimo seką abiejose paprogramose 
EasyDesign ir EasyEdit ir kaip stebėti siuvinėjimo seką sulėtintai. Taip pat aprašoma, kaip pasiekti informaciją 
apie piešinį, kaip parodyti ir paslėpti vaizdus. 
 
Piešinių peržiūros režimai   . 
 
DigitizerPro užtikrina daug peržiūros būdų, palengvinančių jūsų darbą su piešiniais. Vaizdo padidinimas 
(Zoom) plote leidžia  pamatyti daugiau detalių arba stebėti piešinį realiame dydyje. 
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32 
Viso piešinio peržiūra 
Pasirinkti Zoom>Whole Design (View meniu), kad peržiūrėti visą piešinį piešinio lange. 
 
Kad peržiūrėti visą piešinį 
*Kad peržiūrėti visą piešinį: 
 *Pasirinkti View>Zoom>Whole Design 
 *Pasirinkti View>Show>All Objects 
 *Paspausti 0. 
*Kad peržiūrėti visą lankelį: 
 *Pasirinkti View>Zoom>Whole Hoop 
 *Paspausti 1. 
*Kad parodyti pasirinktus objektus lange: 
 *Pasirinkti View>Show>Selected Objects only. 
*Kad parodyti pasirinktas spalvas lange, pasirinkti View>Show>Selected Colors only. Skaitykirte taip pat 33 
pusl. Piešinio peržiūros nustatymai. 
 
Piešinio mastelio ir panoramos keitimas 
 Spragtelėkite Zoom In (View įrankių juostoje), kad parodyti piešinį dvigubai padidintą. 
 Spragtelėkite Zoom Out (View įrankių juostoje), kad parodyti piešinį dvigubai sumažintą 
  Spragtelėkite Zoom Boz (View įrankių juostoje), kad padidinti mastelį ant piešnio dalies 
 Pasirinkite Zoom>Whole Hoop (View meniu), kad peržiūrėti visą plotą lankelio viduje. 
 Pasirinkite Zoom>Whole Design (View meniu), kad peržiūrėti visą meniu. 
 
Padidinkite savo vaizdą didindami individualių dygsnių  arba detalių mastelį arba sumažinkite mastelį, kad 
parodyti lange daugiau piešinio. Be to, slenkamųjų juostų pagalba galima greitai perslinkti vaizdo panoramą, 
kad pamatyti kitas vaizdo dalis, kurių nesimatė piešinio lange. Panoramą paprastai prireikia perslinkti, 
padidinus ploto mastelį. 
 
Kad pakeisti piešinio mastelį ir panoramą 
*Norėdami dvigubai padidinti piešinį, pasirinkite View>Zoom In. 
* Norėdami dvigubai sumažinti piešinį, pasirinkite View>Zoom Out 
*Norėdami padidnti mastelį piešinio dalyje, spragtelėkite Zoom Box ir pasirinkite mastelio procentus 
* Norėdami padidnti mastelį piešinio dalyje, paspauskite klavišą B jūsų klaviatūroje ir ant didinamo ploto 
užtraukite ribojantį rėmelį. 
  -Spragtelėkite ir ant didinamo ploto užtraukite ribojantį rėmelį   
 
*Kad pakeisti panoramą skersai piešinio piešinio lange, pasirinkite View>Pan arba paspauskite P. Nuslinkite 
‚panoramos rėmėlį‘ virš piešinio dalies, kurią norite peržiūrėti ir spragtelėkite kairiu klavišu. EasyDesign 
centruoja piešinio langą aplink tašką, ant kurio spragtelėjote. 
 
 

- Nuslinkite ‚panoramos rėmėlį‘ virš piešinio dalies, kurią norite peržiūrėti ir 
spragtelėkite. 

 
Darbas su peržiūros langu 

Naudokite Overview Window (View įrankių juosta), kad įjungti/išjungti Overview lango rodymą. 
 
Overview Window naudokite peržiūrint labai sumažintus piešinius. Visuomet, atlikus pakeitimą, langas  
atsinaujina, be to galite padidinti mastelį arba pakeisti panoramą skersai piešinio lango. Skaitykite taip pat pusl. 
32 Piešinio mastelio ir panoramos keitimas 
 
Pastaba  Kad pakeisti Overview lango peržiūros nustatymus, spragtelėkite ant jo, kad suaktyvinti jį. Plačiau, 
skaitykite 33 pusl. Piešinio peržiūros nustatymas. 
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33 
Kad dirbti su Overview Window 
1.Spragtelėti ant Overview Window piktogramos 
Atsidaro Overview langas 
 
  -Spragtelėkite į mastelio rėmelį 
 
 
 
2.Kad sumažinti ar padidinti mastelį, spragtelėkite lango apačioje ir tempkite apribojančius rėmelius per plotą, 
kad pakeisti mastelį. 
 
   - tempkite apribojančius rėmelius per plotą, kad pakeisti mastelį. 
 
3.Kad pakeisti panoramą skersai piešinio, įveskite žymeklį į mastelio rėmelio vidų – žymeklis pasikeis į keturių 
krypčių rodyklę – patempkite jį. 
 
 
   -Patempkite mastelio rėmelį į plotą, kad keisti panoramą. 
 
Piešinio peržiūros nustatymai 
 
Su daugeliu įvairių nustatymų pagalba jūs galite parodyti arba paslėpti piešinio elementus. Parodyti arba 
paslėpti adatos dūrių taškus ir jungtis. Parodyti arba paslėpti pasirinktas spalvas. 
 
Piešinių peržiūra Vizualizer‘yje 

Spragtelėkite ant Vizualizer (View įrankių juostoje), kad pakeisti normalų vaizdą į Vizualizer‘io vaizdą 
ir atvirkščiai. 

 
Vizualizer‘is siūlo gatavai išsiuvinėto piešinio grafinį atvaizdą. 
_________________________________________________ 
 
Kad peržiūrėti piešinius Vizualizer‘yje 
*Spragtelėkite ant Vizualizer piktogramos, kad persijungti iš Vizualizer vaizdo į normalų vaizdą arba 
atvirkškčiai. 
 
 
 
Pabandykite tai  Panaudokite Vizualizer‘į  kartu su medžiagos fonu, kad pamatyti, kaip atrodis išsiuvinėtas 
piešinys. Pačiau, skaitykite 52 pusl. Fonų keitimas. 
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Adatos taškų peržiūrėjimas 

Naudokite Display Needle Points (View įrankių juosta), kad parodyti arba paslėpti adatos taškus 
piešinyje. 

 
EasyEdit leidžia jums parodyti arba paslėpti adatos taškus jūsų piešinyje. Tai yra naudinga, kai jūs norite 
pasirinkti dygsnius redagavimui. Plačiau, skaitykite 157 pusl. Dygsnių redagavimas. 
 
Kad peržiūrėti adatos taškus 
*Kad parodyti arba paslėpti adatos taškus, spragtelėkite ant piktogramos Display Needle Points. 
*Kad paslėpti jungiančiuosius siūlus, peržiūrėkite piešinį Vizualizer‘o režime. 
 
 
 
 
Pasirinktų piešinio dalių peržiūrėjimas 
Pasirinkti Show>Selected Objects (View meniu), kad parodyti tiktai pasirinktus objektus piešinyje. 
 
Jūs galite nustatyti savo sistemą, kad rodytų visus siuvinėjimo objektus piešinyje arba paslėpti visus bet 
pasirinktus objektus. 
 
Kad peržiūrėti pasirinktas piešinio dalis 
1.Sukurti arba atidaryti piešinį 
2.Pasirinkti reikalingus objektus 
 
 
 
3.Pasirinkti View>Show>Selected Objects Only 
 
 
 
Matomi tiktai tie objektai, kuriuos pasirinkote. Ši parinktis įmanoma tiktai, jei yra parinkti (pažymėti) objektai. 
 
Piešinio objektų peržiūra pagal spalvą 
Pasirinkti Show>Selected Color Only (View meniu), kad parodyti tiktai pasirinktas spalvas piešinyje. 
 
Išskirti individualius piešinio elementus, kad lengviau būtų juos patikrinti arba pakeisti, jums pagelbės Selected 
Color Only funkcija, kuri leidžia peržiūrėti objektus pagal spalvą. Ši funkcija ypač yra naudinga pertvarkant 
objektų seką pagal spalvas. Skaitykite taip pat 116 pusl. Objektų sekos pertvarkymas pagal spalvas. 
 
Kad peržiūrėti objektus pagal spalvą 
1Sukurti arba atidaryti piešinį. 
 
 
 
2. Pasirinkti View>Show>Selected Color Only. 
Atsidaro Select By Color dialogo langas. 
 
 
 
 
 
3.Pasirinkite spalvas, kurias pageidaujate peržiūrėti. 
*Norėdami peržiūrėti paeiliui keletą objektų, palaikykite nuspaustą Shift klavišą, kai renkatės. 
*Norėdami pasirinkti pasikartojančius objektus, palaikykite nuspaustą Ctrl klavišą, kai renkatės. 
4.Spragtelėkite OK. 
Piešinys pasirodis tiktai su spalvomis, kurias pasirinkote peržiūrėti. 
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Pabandykite tai  Kad vėl pamatyti pilną piešinį, pasirinkite View>Show>All Objects. 
 
Keliavimas per siuvinėjimo seką programoje EasyDesign 
 
Dirbant su siuvinėjimo piešiniais, jums reikia išsiaiškinti siuvinėjimo seką. Jūs galite pamatyti piešinio 
siuvinėjimo seką programoje EasyDesign ‚keliaujant‘ per jį pagal spalvas arba objektus. DigtizerPro imituoja 
siuvinėjimą, keičiant dygsnius nuo juodos iki jiems priskirto siūlo spalvos, lyg jie būtų ‚išsiuvinėti‘. 
 
Keliavimas iki piešinio pradžios arba pabaigos 

Naudokite Jump to Start/End of Design (View įrankių juostoje) bendrai su Forward ir Back 
piktogramomis, kad keliauti iki piešinio pradžios/pabaigos. 
 
Spragtelėkite Forward (View įrankių juostoje), kad keliauti pirmyn pagal siuvinėjimo seką. 
 
Spragtelėkite Back (View įrankių juostoje), kad keliauti atbuline siuvinėjimo sekai kryptimi 

 
Naudokite įrankį Jump to Start/End of Design arba klaviatūros klavišų rinkinį, kad greitai praeiti iki 
siuvinėjimo sekos pradžios arba pabaigos. Skaitykite taip pat pusl.83 Greitas žinynas ir rodyklė. 
 
Kad keliauti iki piešinio starto arba pabaigos 
*Kad keliauti iki piešinio starto, spragtelėkite  ant piktogramos Jump to Start/End of Design, tada spragtelėkite 
ant kelionės krypties piktogramos Back. 
* Kad keliauti iki piešinio pabaigos, spragtelėkite  ant piktogramos Jump to Start/End of Design, tada 
spragtelėkite ant kelionės krypties piktogramos Forward. 
 
Kad keliauti pagal objektus 

Naudokite Jump by Objects (View įrankių juostoje) kartu su piktogramomis Forward ir Back, kad 
keliauti į ankstesnį arba sekantį objektą. 
 
Spragtelėkite Forward (View įrankių juostoje), kad keliauti pirmyn pagal siuvinėjimo seką. 
 
Spragtelėkite Back (View įrankių juostoje), kad keliauti atgal prieš siuvinėjimo seką. 

 
EasyDesign programoje, naudokite kelionės pagal objektus įrankį  arba klavišų rinkinius, kad keliauti per 
piešinį pagal objektus. Šis būdas yra naudingas, jeigu jums reikia eilėje patalpinti kokį nors objektą, kad įterpti 
kitą objektą arba ištrinti jį iš siuvinėjimo sekos. Naudokite jį kartu su kelionės pagal dygsnius įrankiu, kai norite 
‚patalpinti‘ objektą. Plačiau skaitykite 114 pusl. Objektų talpinimas;  ir taip pat 83 pusl. Greitas žinynas ir 
rodyklė. 
 
Kad keliauti pagal objektus  
*Kad keliauti į ankstesnį arba sekantį objektą, spragtelėti ant Jump by Objects piktogramos, tada spragtelėti ant 
Back arba Forward krypties piktogramos. 
 
Pastaba  EasyEdit programoje keliauti pagal objektus jūs negalite. 
 
Kelionė pagal spalvas 

Naudokite Jump by Color (View įrankių juostoje) kartu su piktogramomis Forward ir Back, kad keliauti 
į ankstesnę arba sekančią spalvą. 

 
Naudokite Jump by Color įrankį arba klavišų rinkinį , kad keliauti per piešinį pagal spalvas. Šis būdas yra 
naudingas, kai reikia eilėje patalpinti kokį nors spalvos pakeitimą, kad įterpti kitą objektą, arba ištrinti jį iš 
siuvinėjimo sekos. Žiūr.taip pat 83 pusl. Greitas žinynas ir rodyklė. 
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Kad keliauti pagal spalvą 
*Kad nukeliauti į ankstesnę aba į sekančią spalvą, spragtelėkite Jump by Color  piktogramą, tada spragtelėkite 
Back arba Forward krypties piktogramą. 
 
Kelionė pagal dygsnius 
EasyDesign programoje jūs galite keliauti per savo piešinį pagal dygsnius su klavišų rinkinių pagalba. 
Spauskite Esc, tada spauskite kairę ir dešinę rodykles, kad pereiti vienu dygsniu, aukštyn žemyn rodyklėmis 10 
dygsnių ir pagalbiniais klavišais ‚+‘ ir ‚-‚ 100 dygsnių. Žiūr. taip pat 36 pusl. Kelionė dygsniais. 
 
 
 
 
 
 
Kelionė dygsnių seka programoje EasyEdit 
 
Dirbant su siuvinėjimo piešiniais, jums reikia suprasti dygsnių seką. Jūs galite peržiūrėti piešinio siuvinėjimo 
seką EasyEdit programoje keliaujant per jį pagal dygsnius arba spalvas. DigitizerPro imituoja siuvinėjimą 
keičiant dygsnius nuo juodos iki jiems priskirto siūlo spalvos, lyg jie būtų ‚išsiuvinėti‘.Žiūr. taip pat 157 pusl. 
Dygsnių redagavimas.   
 
Keliavimas iki piešinio pradžios arba pabaigos 

Naudokite Jump to Start/End of Design (View įrankių juostoje) bendrai su Forward ir Back 
piktogramomis, kad keliauti iki piešinio pradžios/pabaigos. 
 
Spragtelėkite Forward (View įrankių juostoje), kad keliauti pirmyn pagal dygsnių seką. 
 
Spragtelėkite Back (View įrankių juostoje), kad keliauti atbuline dygsnių sekai kryptimi 

 
Naudokite įrankį Jump to Start/End of Design arba klaviatūros klavišų rinkinį, kad greitai praeiti iki 
siuvinėjimo sekos pradžios arba pabaigos. Skaitykite taip pat pusl.83 Greitas žinynas ir rodyklė 
 
Kad keliauti iki piešinio starto arba pabaigos 
*Kad keliauti iki piešinio starto, spragtelėkite  ant piktogramos Jump to Start/End of Design, tada spragtelėkite 
ant kelionės krypties piktogramos Back. 
* Kad keliauti iki piešinio pabaigos, spragtelėkite  ant piktogramos Jump to Start/End of Design, tada 
spragtelėkite ant kelionės krypties piktogramos Forward. 
 
Kelionė pagal spalvas 

Naudokite Jump by Color (View įrankių juostoje) kartu su piktogramomis Forward ir Back, kad keliauti 
į ankstesnę arba sekančią spalvą. 
 
Spragtelėkite Forward (View įrankių juostoje), kad keliauti pirmyn pagal dygsnių seką. 
 
Spragtelėkite Back (View įrankių juostoje), kad keliauti atbuline dygsnių sekai kryptimi 

 
Naudokite Jump by Color įrankį arba klavišų rinkinį , kad keliauti per piešinį pagal spalvas. Šis būdas yra 
naudingas, kai reikia eilėje patalpinti kokį nors spalvos pakeitimą, kad įterpti kitą objektą, arba ištrinti jį iš 
siuvinėjimo sekos. Žiūr.taip pat 83 pusl. Greitas žinynas ir rodyklė. 
 
Kad keliauti pagal spalvas  
*Kad keliauti į ankstesnę arba sekančią spalvą, spragtelėti ant Jump by Colors piktogramos, tada spragtelėti ant 
Back arba Forward krypties piktogramos. 
 
Pastaba  Žiūr.pusl.251 Greitas žinynas,kur rasite kelionės funkcijų suvestinę. 
 
Kelionė pagal dygsnius 

Naudokite Jump by 1 Stiitch (View įrankių juostoje) kartu su piktogramomis Forward ir Back, kad 
praeiti 1 dygsniu. 
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Naudokite Jump by 10 Stiitch (View įrankių juostoje) kartu su piktogramomis Forward ir Back, kad 
praeiti 10 dygsnių. 
 
Naudokite Jump by 100 Stiitch (View įrankių juostoje) kartu su piktogramomis Forward ir Back, kad 
praeiti 100 dygsnių. 
 
Spragtelėkite Forward (View įrankių juostoje), kad keliauti pirmyn pagal dygsnių seką. 
 
Spragtelėkite Back (View įrankių juostoje), kad keliauti atbuline dygsnių sekai kryptimi 

 
Naudokite dygsniais kelionės įrankius arba klavišų rinkinius, kad keliauti per piešinį kas vieną ar daugiau 
dygsnių iškarto. Programoje EasyEdit jūs galite keliauti tiktai pagal dygsnius iki piešinio pradžios arba 
pabaigos arba keliauti pagal spalvas taip pat redaguoti dygsnius. Programoje EasyDesign jūs galite nušokti į 
piešinio pradžią arba į pabaigą arba keliauti pagal objektus arba spalvas. Žiūr.taip pat 83 pusl. Greitas žinynas 
ir rodyklė. 
Esamoji adatos padėtis nurodoma su ‚esamojo dygsnio padėties žymekliu‘. Pradžioje, jis yra piešinio pabaigoje. 
Kada jūs keliaujate pagal dygsnius, adatos padėties žymeklis juda atitinkamai. Žiūr.taip pat 157 pusl.Dygsnių 
redagavimas. 
 
 
 
 
Kad keliauti pagal dygsnius 
1.EasyEdit programoje, pasirinkti kelionės dygsniais įrankį. Jūs galite pasirinkti taip: 
 *Jump By 1 stitch 

*Jump By 10 stitch 
*Jump By 100stitch 

2.Keliauti per piešinį 
*Kad pereiti į sekantį dygsnį siuvinėjimo sekoje, spragtelėkite ant Forward rodyklės įrankių juostoje. 
*Kad keliauti į ankstesnį dygsnį, spragtelėkite ant rodyklės Back. 
Jūsų kelionės procese, esamoji žymeklio padėtis irgi judės, kad pavaizduoti siuvinėjimo seką. 

 
 
Pabandykite tai  Kad keliauti per savo piešinį pagal dygsnius, jūs taip pat galite panaudoti klavišų rinkinius. 
Spauskite Esc, tada spauskite kairę ir dešinę rodykles, kad pereiti vienu dygsniu, aukštyn žemyn rodyklėmis 10 
dygsnių ir pagalbiniais klavišais ‚+‘ ir ‚-‚ 100 dygsnių.  
 
 
 
 
Siuvinėjimo sekos lėtas perėjimas 
 

Naudokite Slow Redraw (View įrankių juostoje), kad lėtai peržiūrėti piešinio dygsnių ir spalvų seką . 
 
Slow Redraw leidžia jums lėtai peržiūrėti piešinio dygsnių ir spalvų seką. 
Pastaba  Slow Redraw negalima panaudoti operatoriuje Vizualizer. 
____________________________________________________ 
 
Kad lėtai pereiti dygsnių seką 
1.Spragtelėkite piktogramą Slow Redraw, arba Shift+R  
Atsidaro Slow Redraw dialogas 
 
 
Pabandykite tai  Kad pereiti tiktai piešinio dalį, keliaukite iki taško, nuo kurio norėtumete pradėti Slow 
Redraw. Plačiau, skaitykite pusl.35 kelionė dygsniu seka EasyDesign programoje. 
2.Kad sureguliuoti judėjimo greitį, naudokite slinkties juostą. 
3.Pasirinkite reikalingas parinktis 
*Hide Before: Paslėpti visas piešinio dalis, esančias iki esamos žymeklio padėties. 
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38 
*Auto Scroll: Kai didelis piešinys, ekranas automatiškai slenka, kad ‚siuvinėjamas‘ plotas visuomet būtų 
ekrane. 
4.Spragtelėti Go. 
Piešinys pereinamas ekrane siuvinėjimo seka su pasirinktu greičiu. 
5. Spragtelėti Pause, Stop arba Back to Start,  kai reikia. 
*Pause daro perėjimo pauzę, leidžiančią jums pradėti iš naujo iš kur pradėjote. 
*Stop sustabdo perėjimą ir sugrąžina į piešinio pradžią. 
*Back to Start išnaujo pradeda perėjimą nuo piešinio pradžios. 
 
Piešinio informacijos peržiūra 
 
DigitizerPro užtikrina informaciją apie piešinius skirtingais būdais. Netgi prieš atidarydami DigitizerPro, jūs 
galite patikrinti informaciją apie piešinį tiesiogiai iš Windows Explorer. Dialogas Open irgi duoda jums svarbią 
informaciją apie failą. Būklės juosta piešinio lange yra kitas informacijos apie piešinius šaltinis. Spausdinimo 
peržiūros langas užtikrina pilną informaciją apie piešinį. 
 
Informacijos apie piešinį peržiūra programoje DigitizerPro 
DigitizerPro viduje, Svarbią informaciją apie piešinį  duoda Open dialogas ir taip pat būklės juosta piešinio 
lange. 
___________________________________________________________________________ 
 
Kad peržiūrėti piešinio informaciją DigitizerPro viduje 
*Spragtelėkite ant piktogramos Open. 
Open  dialogas parodo ribotą informaciją apie pasirinktus piešinius peržiūros langelyje. 
*Kai jūs atidarote piešinį, būklės juostoje pasirodo tokia informacija, kaip bendras dygsnių skaičius. 
 1)Bendras dygsnių skaičius; 2)Piešinio matmenys; 3)Pasirinkto objekto siūlo spalva; 
 
Piešinių spausdinių peržiūra 

Spragtelėkite Print Preview (Standartinėje įrankių juostoje), kad peržiūrėti piešinio spaudinį ant ekrano. 
 

Spaudinio peržiūros lange yra būtiniausia informacija, įskaitant piešinio matmenis, spalvų seką ir bet kokią 
specialią siuvinėjimo informaciją. Žiūr. taip pat pusl.195 Piešinių Spausdinimas. 
___________________________________________________________________ 
 
Kad peržiūrėti piešinio spaudinį 
1.Spragtelėkite ant Print Preview piktogramos. 
Piešinio spaudinys pasirodis peržiūros lange 
 
 
 
 
 
 
 
2.Pareguliuokite viazdą, kaip pageidaujate 
*Kad pkeisti orientaciją ant popieriaus, spragtelėkite Landscape arba Portrait. 
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*Kad pakeisti rodomą informaciją, spragtelėkite Options. Žiūr. taip pat pusl.196 Spausdinimo parinkčių 
nustatymas. 
*Kad atspausdinti piešinį, spragtelėkite Print. 
*Kad uždaryti spausdinimo peržiūros langą, spragtelėkite Close. 
 
 
Pabandykite tai  Padidinkite mastelį, kad priartinti piešinį. Dideli piešiniai gali būti rodomi per kelis puslapius. 
 
Vaizdų rodymas ir slėpimas 
 Naudokite Display Images (View įrankių juostoje), kad parodyti arba paslėpti foną. 
 
Jūs galite parodyti arba laikinai paslėpti bitmaps fonus projektavimo metu. Fonų slėpimas neištrina jų iš 
piešinio. 
_______________________________ 
 
Kad parodyti arba paslėpti vaizdus 
*Spragtelėkite piktogramą Display Images arba paspauskite D. 
Pasirinkus, fonų vaizdai yra matomi. 
 
 
*Kad paslėpti vaizdą, spragtelėkite Display Images arba paspauskite D. 
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6 skyrius 
OBJEKTŲ PASIRINKIMAS 
 
 
DigitizerPro EasyDesign leidžia įvairiais būdais pasirinkti objektus, kurie sudaro siuvinėjimo piešinius. Jūs 
galite pasirinkti visus objektus, kad modifikuoti visą piešinį, arba atskirus objektus, kad atlikti tikslesnę 
modifikaciją. 
 
Šiame skyriuje aprašoma kaip pasirinkti objektus su pasirinkimo įrankiais ir klaviatūra.  Čia parodyta, kaip 
pasirinkti keliaujant per piešinį, ir kaip pasirinkti objektus su tam tikra spalva. EasyEdit programoje jūs taip pat 
galite pasirinkti atskirus dygsnius. Žr.taip pat 157 pusl. Dygsnių redagavimas. 
 
Visų objektų pasirinkimas piešinyje 
 
Įrankis Select turi daug reikšmių pasirenkant objektus, įskaitant parodymą ir spragtelėjimą, apribojančio 
rėmelio pasirinkimą ir – kartu su klavišais Shift+Tab – pirmo/paskutinio ir sekančio/ankstesnio objekto 
pasirinkimą. Jūs galite taip pat pasirinkti visus objektus, kad pakeitimus pritaikyti visam piešiniui. 
_________________________________________________________________ 
 
Kad pasirinkti visus objektus piešinyje 
*Pasirinkti Edit>Select All arba paspausti Ctrl+A 
Aplink visą piešinį pasirodis matmenų valdymo ‚rankenėlės‘ 
*Atšaukti pasirinkimą, paspausti X arba Esc. 
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Pasirinkimas, nurodant ir spragtelėjus 
 
 Spragtelėti Select (Edit įrankių juostoje) ir spragtelėti ant pasirenkamo objekto. 
 
Perspėjimas  Paprasčiausias objekto pasirinkimo būdas yra nurodyti ir spragtelėti su pele, kai aktyvuotas Select 
įrankis. Su Shift  ir Ctrl klavišais galite pasirinkti kartotinius objektus. 
___________________________________________________ 
 
Kad pasirinkti objektus nurodant ir spragtelėjus 
1.Spragtelėti ant Select piktogramos 
2.Spragtelėti ant objekto, kurį norite pasirinkti. 
Kada jūs spragtelėjote ant objekto, aplink jį pasirodis matmenų valdymo rankenėlės. Jūs galite spragtelėti bet 
kur ant šių pratęsimų ir vilkti objektą. 
 1)Spragtelėti ant objekto;  2)Laikyti paspaustą Ctrl ir spragtelėti ant antro objekto;  
 
*Kad pasirinkti eilę objektų, pasirenkant, laikyti paspaustą Shift. 
*Kad pasirinkti kartotinius objektus, pasirenkant, spausti ir laikyti paspaustą Ctrl. 
 
 
Pabandykite tai  Kad pasirinkti objektą, kuris yra kito objekto užnugary, padidinkite mastelį ir spragtelėkite 
ant kontūro. Arba kitaip, patalpinkite žymeklį virš objekto, laikykite paspaudę klavišą 2 ir spragtelėkite kol 
objektas nebus pasirinktas. Kiekvienas spragtelėjimas parenka sekantį uždengiamą objektą. 
 
Objektų pasirinkimas su ribojančiu rėmeliu 
 

Spragtelėkite Select (Edit įrankių juostoje) ir tempkite ribojantį rėmelį aplink objektą, kad jį pasirinkti. 
 
Kai Select įrankis yra aktyvuotas, jūs galite pasirinkti objektus velkant ribojantį rėmelį aplink juos. 
 
__________________________________________________________________________ 
 
Kad pasirinkti objektus su ribijančiu rėmeliu 
1.Spragtelėti Select piktogramą. 
2.Vilkite ribojantį rėmelį aplink objektus, kuriuos norite pasirinkti. 
Objektai bus pasirinkti, kai jūs atleisite pelės mygtuką 
 1)Vilkite ribojantį rėmelį aplink objektus 
 2)Objektai pasirinkti 
 
Pastaba  Nebent jie buvo sugrupuoti, tačiau tik tie objektai, kurie pilnai patekę į ribojantį rėmelį, bus pasirinkti, 
atleidus pelės mygtuką. Žr.taip pat pusl.121 Objektų grupavimas. 
 
Objektų eilės pasirinkimas nurodant ir spragtelėjus 
 
 Spragtelėti Select (Edit įrankių juostoje) kartu su Shift klavišu, kad pasirinkti eilę objektų. 
 
Jūs galite pasirinkti eilę objektų, laikant paspaustą klavišą Shift , kol jūs spragtelėjate ant pirmo ir paskutinio 
pasirenkamų objektų. 
____________________________________________ 
 
Kad pasirinkti eilę objektų nurodant ir spragtelėjus 
1.Spragtelėkite ant Select piktogramos 
2.Spragtelėkite ant pirmo objekto iš eilės ir laikykite paspaustą klavišą Shift. 
3.Spragtelėkite ant paskutinio objekto eilėje. 
Visi objektai, išdėstyti pagal siuvinėjimo seką paeiliui nuo pirmo iki paskutinio, yra pasirinkti. 
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Pastaba  Šiam metodui gali padėti piešinio siuvinėjimo sekos žinojimas. Plačiau, skaitykite pusl.35 Kelionė 
pagal objektus. 
 
Objektų pasirinkimas su įrankiu Polygon Select 
 

Spragtelėkite ant Polygon Select (Edit įrankių juostoje), kad pasirinkti objektus su ribojančiu rėmeliu. 
 
Kartais įrankis Select neužtikrina tikslaus valdymo. Polygon Select įrankis leidžia pasirinkti atskirus objektus 
brėžiant kontūrą aplink juos. Naudokite Polygon Select, kad pasirinkti objektus su ribojančiu rėmeliu. 
_____________________________________ 
 
Kad pasirinkti objektus su Polygon Select 
1.Spragtelėti ant piktogramos Polygon Select. 
2.Pažymėkite bazinius taškus aplink objektus, kuriuos norėtumėte pasirinkti. 
 1)Pažymėkite bazinius taškus aplink objektus, kad pasirinkti  
 
Objektai, kuriuos norite pasirinkti turi būti pilnai kontūro viduje. 
3.Paspausti Enter, kad pasirinkti. 
 
Objektų pasirinkimas keliaujant per piešinį 
 
 Spragtelėti Select (Edit įrankių juostoje), kad pasirinkti objektus. 
 Spragtelėti Jump By Object (View įrankių juostoje), kad keliauti pagal objektus. 

Spragtelėti Stitch Select While Traveling (View įrankių juostoje), kad pasirinkti objektus keliaujant. 
 
EasyDesign programoje jūs galite pasirinkti objektus keliaudami per piešinį. Kelionė paprastai yra susijusi su 
siuvinėjimo sekos patikrinimo. Žr.taip pat pusl.158 Dygsnių pasirinkimas keliaujant. 
_________________________________ 
 
Kad pasirinkti objektus keliaujant per piešinį 
1.Spragtelėkite Jump By Object piktogramą ir keliaukite per piešinį, sustodami prieš pat objektą, kad pasirinkti. 
Plačiau, pusl.35 Kelionė pagal objektus. 
 1)Sustokite prieš pat pirmą objektą, kurį reikia pasirinkti.  
 
2.Spragtelėkite piktogramą Select. 
3.Spragtelėkite piktogramą Stitch Select While Traveling. 
4.Tęskite kelionę per piešinį. 
Kelionės metu parenkami objektai 
 Objektai pasirinkimo metu keičia spalvą 
5.Pabaigę pasirinkimą, vėl spragtelėkite piktogramą Stitch Select While Traveling, kad išjungti šį įrankį. 
 
Pastaba  Jeigu objektas jau buvo pasirinktas (pažymėtas), tai jums keliaujant pro jį, jo parinktis automatiškai 
atšaukiama. 
*Kad pasirinkti daugiau objektų, toliau kelionę tęskite nuspaudę klavišą Ctrl. 
*Jei norite praleisti (nepasirinkti) kurį nors objektą, prieš pat praeinant tokį objektą, atleiskite Ctrl klavišą. 
 
Spalvų pasirinkimas keliaujant per piešinį 
 
 Spragtelėti Select (Edit įrankių juostoje), kad pasirinkti objektus. 
 Spragtelėti Jump By Color (View įrankių juostoje), kad keliauti pagal spalvas. 

Spragtelėti Stitch Select While Traveling (View įrankių juostoje), kad pasirinkti spalvas keliaujant. 
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EasyDesign programoje jūs galite pasirinkti spalvas keliaudami per piešinį. Kelionė paprastai susijusi su 
siuvinėjimo sekos patikrinimu. Žr.taip pat pusl.158 Dygsnių pasirinkimas keliaujant. 

  
Patarimas  Vienos spalvos objektus galite pasirinkti panaudojant View>Show>Selected  Color only. Plačiau, 
skaitykite pusl.34 Piešinių objektų peržiūrėjimas. 
______________________________ 
 
Kad pasirinkti spalvas, keliaujant per piešinį 
1.Keliaukite per piešinį, sustodami prieš pat spalvą, kad pasirinkti. Plačiau, skaitykite pusl.35 Kelionė pagal 
objektus. 
2. Spragtelėti Jump By Color piktogramą. 
 Sustokite prieš pirmą objektą, kurį reikia pasirinkti 
 
 
3.Spragtelėkite piktogramą Select. 
4.Spragtelėkite piktogramą Stitch Select While Traveling. 
5.Tęskite kelionę per piešinį. 
Kelionės metu parenkamos spalvos 
 Objektai pasirinkimo metu keičia spalvą 
6.Pabaigę pasirinkimą, vėl spragtelėkite piktogramą Stitch Select While Traveling, kad išjungti šį įrankį. 
 
Pastaba  Jeigu spalva jau buvo pasirinkta (pažymėta), tai jums keliaujant pro ją, jos parinktis automatiškai 
atšaukiama. 
*Kad pasirinkti daugiau spalvų, toliau kelionę tęskite nuspaudę klavišą Ctrl. 
*Jei norite praleisti (nepasirinkti) kurią nors spalvą, prieš pat praeinant tokią spalvą, atleiskite Ctrl klavišą. 
 
 
Objektų pasirinkimas ir peržiūra su dialogu Resequence (sekos perrykiavimas) 
 

Naudokite Resequence (Edit įrankių juostoje), kad įjungti arba išjungti Resequence dialogą. Naudokite 
jį, kad pasirinkti ir peržiūrėti objektus piešinyje. 

 
Resequence dialogas pateikia paeiliui pagal seką išdėliotų suprojektuotų objektų sąrašą, sugrupuotų pagal 
‚spalvų blokus‘. Tai nuo režimo nepriklausantis dialogas, kuris pasilieka ant piešinio lango tiek kiek jums reikia 
ir palengvina objektų pasirinkimą ir jų peržiūrą. Jis sinchronizuotas su piešinio langu, greitai atsinaujina, kai tik 
atliekate kokius nors pakeitimus su objektais. Paprastai jis patalpintas dešinėje piešinio lango pusėje, bet jūs 
galite jį nuvilkti į bet kurią vietą ir jeigu reikia, pakeisti jo matmenis. 
 
Pastaba  Resequence dialogą galite panaudoti objektų užrakinimui ir atrakinimui. Naudokite jį taip pat, kad 
iškirpti, kopijuoti ir įterpti, taip pat perrykiuoti atšakos objektus. Žr.taip pat pusl.114 Siuvinėjimo objektų 
perrykiavimas. 
_______________________________ 
 
Kad pasirinkti ir peržiūrėti objektus su Resequence dialogu 
1.Spragtelėti Resequence piktogramą 
Atsidaro Resequence dialogas. Jis gali būti patalpintas piešinio lango kairėje arba dešinėje arba nuvilktas į bet 
kurią vietą. 
 
 
 
Spalvos režime, Resequence dialogas parodo kiekvienos spalvos bloko piešinyje atskirą piktogramą suvinėjimo 
sekos tvarka. Jis taip pat parodo siūlų spalvos kodą kartu su objektų skaičiumi, naudojančių tą spalvą. 
2.Spragtelėti Objects mygtuką, kad peržiūrėti piešinio objektus. 
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Dabar Resequence dialogas rodo atskirą piktogramą kiekvienam objektui piešinyje. Taip pat rodomas kiekvieno 
objekto dygsnių skaičius, objekto tipas ir dygsnio tipas piešinio kūrimo metu. 
 
 
 
 
 
 
 
 
Pabandykite tai  Jūs galite pasiekti tam tikras komandas per popup meniu dialogą, įskaitant užrakinti/atrakinti 
ir objektų detales. 
 
3.Spragtelėti ant piktogramos, kad pasirinkti spalvos bloką ir/arba individualius objektus. 
Kada pasirinktas spalvos blokas, visi jį sudarantys objektai irgi pasirinkti.  
*Kad pasirinkti eilę punktų, spragtelėjimo metu laikykite paspaustą Shift. 
*Kad pasirinkti kartotinius punktus, spragtelėjimo metu laikykite paspaustą Ctrl. 
*Kad atšaukti visų objektų pasirinkimą, spargtelėkite nuošalėje nuo objektų arba spalvų blokų. 
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7 Skyrius 
 
TINKLELIAI IR LANKELIAI 
 
 
Lankeliai reikalingi medžiagos palaikymui įtemptame būvyje siuvinėjimo su jūsų mašina metu. Jie išleidžiami 
skirtingų dydžių. JANOME DigitizerPro užtikrina platų standartinių gamyklinių lankelių pasirinkimo 
diapazoną. Jeigu jūs turite lankelį, kuris nepasirodo sąraše, jūs galite nusistatyti savo vartotojišką lankelį iš 
eskizo arba pagrįstą standartiniu lankeliu. Parenkami lankeliai su nurodymais, kaip keisti jų dydį ir patalpinti 
jūsų piešinį, yra parodyti piešinio lange Design Window. 
 
 
 
 
 
 
Šiame skyriuje aprašyta kaip DigitizerPro viduje nustatyti tinklelio langelio dydį. Jis taip pat apima lankelių 
keitimą ir jūsų pačių sukurtų lankelių apibūdinimą. Čia aiškinama, kaip išdalinti piešinius ant MA Hoop, 
siunčiant į mašiną ir keičiant lankelių fonus. 
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Tinklelio langelio dydžio nustatymas 
 
Kad nustatyti langelio dydį, naudokite Work Environment (Setup meniu) 
 
Tinklelio linijos yra orientyrai tiksliam siuvinėjimo objektų išdėstymui ir dydžio sureguliavimui. Reikalui 
esant, tinklelį galima įjungti arba išjungti arba pakeisti langelio dydį. 
____________________________________ 
 
Kad nustatyti tinklelio langelio dydį 
1.Pasirinkti Select>Work Environment. 
Work Environment>atsidaro Display lentelė 
2.Pažymėti Display Grid  nustatymo langelį, kad parodyti tinklelį. 
 
3.Paslenkant slinkties rodyklę, nustatykite tinklelio langelio dydį. 
Langelio dydis nurodytas virš slinkties rodyklės. 
 
Pabandykite tai  Kad panaudoti šiuos nustatymus, kaip standartą, esamam šablonui, spragtelėkite Save. 
4.Spragtelėkite OK. 
 
 
 
 
Lankelių pasirinkimas 
 
Kai tik sukūrėte naują piešinį, kaip standartas, piešinio lango viduryje pasirodo siuvinėjimo lankelis, 
atitinkantis mašinoje įstatytą lankelį. Lankelių dydžių diapazonas tenkina plačią piešinių tipų įvairovę. 
Jūs galite pakeisti lankelio orjentaciją ekrane, kad palengvinti dirbą. Žr.taip pat pusl.28 Atstumų ekrane 
matavimas. 
 
Lankelių keitimas 
  Kad pakeisti lankelius, naudokite Hoop Type žemyn išsiskleidžiantį sąrašą. 
 
Labai svarbu pasirinkti tinkamą lankelį iki siuvinėjimo. Tačiau kartais prieš siuvinėjimą jūs galite panorėti 
pakeisti lankelius. Hoop Type išsiskleidžiančio sąrašo valdiklis leidžia jums bet kuriuo metu patvirtinti 
naudojamą lankelį ir pakeisti jį. Pasirinkite patį mažiausią lankelį iš galimų, kuris tiktų piešiniui. Plačiau, 
skaitykite pusl. 258 Palaikomų lankelių tipai. 
 
Pastaba  Kai jūs atidarote tam tikro piešinio pavyzdžius, programinė įranga priima, kad anksčiau sukurti 
piešiniai pritaikyti lankeliui 126x110 mm  dar reikalauja šio dydžio. Jeigu norite peržiūrėti senesnius piešinius 
ant naujo tipo lankelio, paprasčiausiai pakeiskite jį į kitą ir tada persijunkite atgal į Hoop ST (126x110). 
_______________________________________ 
 
Kad pakeisti lankelius 
*Pasirinkite lankelio tipą vienu iš būdų: 
 *Pasirinkite iš Hoop Type išsiskleidusio meniu 
 *Pasirinkite Setup>Work Environment ir lankelį pasirinkite iš Hoop sąrašo 
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Pabandykite tai  Galima pakeisti lankelio fono spalvą. Plačiau, skaitykite pusl.52 Fonų keitimas. 
 
Lankelių centravimas 
Automatic Centering  funkcija užtikrina, kad lankelio centras (arba paslinktame centre senesnio tipo lankeliams 
– pavyzdžiui, Hoop No.1&30 būtų automatiškai nustatytas esamo piešinio centre arba esamo piešinio lango 
taške (0,0), kai piešinyje dar nėra dygsnių. Kitu atveju, lankelio centras  - arba paslinktas centras senesniems 
lankeliams – fiksuotas piešinio lango taške (0,0). 
________________________________________ 
 
Kad centruoti lankelį 
1.Atidaryti Work Environment dialogą 
*Pasirinkti Setup>Work Environment. 
*Dešiniu pelės klavišu spragtelėti į piešinio langą, nieko nepasirenkant, ir tada pasirinkti Work Environment. 
2.Spragtelėti į Automatic Centering kontrolinį langelį, esantį Display tab. 
 
Lankelių sukiojimas 

Naudoti įrankį Rotate Hoop 90o CCW (Edit įrankių juostoje), kad pasukti lankelį 90o kampu bet 
kuria kryptimi. 

 
 Įrankis Rotate Hoop  palengvina piešinio projektavimą. Prijungtas mechanizmas parodytas ekrane ir 
spausdiniuose. Tokiu būdu, jūs galite įvertinti piešinio orientaciją lankelio atžvilgiu ir nuspręsti, kaip jį 
patalpinti. Pasukite naudojamą lankelį vienu iš žemiau aprašytų būdų. 
______________________________ 
 
Kad pasukti lankelį 
*Spragtelėti Rotate Hoop 90o CCW/CW piktogramą. 
 
 
 
 
 
 
 
* Dešiniu pelės klavišu spragtelėti į piešinio langą, nieko nepasirenkant, ir tada pasirinkti Rotate Hoop>90o  
Conterclockwise)- prieš laikrodžio rodyklę- arba 90o Clockwise - pagal laikrodžio rodyklę. 
*Pasirinkti Setup>Environment ir pasirinkti lankelio orientaciją ant Display tab. 
 
Vartotojo lankelio apibrėžimas 
 
Jeigu naudojate tokį lankelį, kurio nėra lankelių sąraše, jūs galite apibrėžti savo pačių lankelius ir išsaugoti juos 
vėlesniam naudojimui. Vartotojo lankeliai yra reikalingi kadangi naujesnių lankelių poreikis siuvimo mašinoms 
atsiranda greičiau negu atsinaujina programinė įranga. 
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Ši galimybė pagrindinai skiriama ne JANOME mašinų savininikams, kadangi JANOME mašinos aprūpintos 
pilnu diapazonu fiksuotų lankelių dydžių.  DigitizerPro gali apibrėžti arba redaguoti dviejų tipų lankelius – 
stačiakampius ir ovalinius. 
 
 
Pastaba  Jeigu jūs atidarote JAN failą, kuriame yra vartotojo lankelis neįtrauktas į lankelių sąrašą arba turi tokį 
patį vardą kaip sąraše, tačiau skirtingo tipo ir/arba nustatymų, DigitizerPro sukuria naują vartotojo lankelį su 
tokiomis pat charakteristikomis ir palaiko jį  su sistemos generuotu vardu. Jeigu vartotojo lankelis yra 
einamasis tuo metu kai išsaugojamas piešinys į JEF failą, jūs gausite pranešimą apie klaidą. Toks pat 
pranešimas gali būti gautas, jeigu pasirinktas JANOME lankelis nebūtų palaikomas tikslinės mašinos. 
___________________________________ 
 
Kad apibrėžti arba redaguoti vartotojo lankelį 
1.Pasirinkti Setup>Work Environment arba spragtelėti dešiniu pelės mygtuku Design Window lango viduje ir 
pasirinkti Work Environment iš popup meniu. 
Atsidaro Work Environment >Display dialogas 
 
 
 
 
 
2.Pasirinkite pageidaujamą variantą: 
*Sukurti lankelį: Šiuo mygtuku pasiekiamas Create/Edit Hoop dialogas, kuris yra naudojamas naujų lankelių 
sukūrimui ir egzistuojančių redagavimui. 
*Redaguoti lankelį: Pasirinkti lankelį iš Hoop sąrašo, ir pradeda veikti mygtukas Edit Hoop. Šiuo mygtuku 
galima pasiekti tą patį dialogą Create/Edit Hoop. 
*Delete Hoop: Pasirinkti lankelį iš Hoop sąrašo, ir spragtelėti ant klavišo Delete Hoop, kad pašalinti jį iš 
sąrašo. Bus prašoma jūsų patvirtinimo. 
 
Nepriklausomai nuo to ar pasirinksite sukurti ar redaguoti lankelį, atsidarys Create/Edit Hoop dialogas. 
 1)Pasirinkite reikalingą lankelio tipą;  2)Nustatykite lankelio matmenis 
 
 
 
3.Format panelėje nustatykite reikalingą tipą stačiakampį (rectangle) arba ovalinį (Oval). 
4.Dimensions panelėje nustatykite reikiamus matmenis. 
 *Ovaliniam lankeliui nustatykite matmenį Rectangle Height, Total Height ir Width. 
 *Stačiakampiam lankeliui įveskite Height ir Width. 
 
Pabandykite tai  Jūs galite sukurti ir apvalų lankelį, įvedus „0“ į Rectangle Height lauką ir nustačius vienodo 
dydžio Width ir Total Height. 
 
 
Perspėjimas  Kad išvengti adatos susidūrimo su lankelio rėmeliu, lankelio matmuo turi atitikti vidinio 
siuvinėjimo ploto matmenis, ne išorinį lankelio matmenį. 
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5.Išsaugokite naujo arba redaguoto lankelio duomenis: 
*Jeigu išsaugojate modifikuotą lankelį, spragtelėkite ant mygtuko Save Hoop. 
*Jeigu išsaugojate naujai apibrėžtą lankelį, spragtelėkite ant mygtuko Save Hoop As  ir dialogo lange įveskite 
lankelio vardą. 
 
 
 
6.Spragtelėkite Save. 
7.Spragtelėkite OK, kad uždaryti Work Environment  dialogą. 
 
Piešinių siuntimas su MA Hoop lankeliu 
 

Naudokite Send To Machine (standartinių įrankių juostoje), kad nusiųsti piešinį į mašiną siuvinėjimui. 
 
DigitizerPro palaiko JANOME MA Hoop. Tai yra dviejų padėčių lankelis, komplekte su mašina, jis praplėčia 
galimą Janome mašinų siuvinėjimo plotą. Galimų lankelių sąraše MA Hoop atpažinamas, kaip ‚Hoop MA 
(200x280)‘. Raudonai ir mėlynai p.avaizduoti du siuvinėjimo laukai. Projektuojant piešinį, visi siuvinėjimo 
objektai turi sutilpti vienoje iš dviejų lankelio padėčių. Žr.taip pat pusl.259  MA Lankelio palaikymas. 
 
MA Hoop lankelio funkcionavimas užkraunant ir redaguojant siuvinėjimo piešinius  yra tiksliai toks pat kaip ir 
normalaus stačiakampio lankelio, kurio dydis yra 200x280. Faktas, kad yra du siuvinėjimo laukai, neturi įtakos 
iki piešinio išsaugojimo ar siuntimo į mašiną. Siunčiant į mašiną, dažniausiai DigitizerPro sukuria tiktai vieną 
failą, viename JEF faile išsaugotos dvi lankelio padėtys. Tačiau, jeigu prireiktų sugįžti prie 1-os  lankelio 
padėties, DigitizerPro sukurs du failus (arba labai retais atvejais daugiau). 
____________________________________ 
 
Kad nusųsti piešinį su MA Hoop lankeliu 
1.Atidarykite piešinį, kurį reikia nusiųsti į mašiną. 
Pasirodis du siuvinėjimo laukai, raudonas ir mėlynas. Projektuojant kiekvienas siuvinėjimo objektas turi pilnai 
tilpti į vieną iš dviejų lankelio padėčių.  
 
 
 
 
Pastaba  Mastelyje 1:1 matmenys pavaizduoti milimetrais. Kitų mastelių languose reikšmės yra proporcingos 
masteliui. 
2.Spragtelėkite Send to Machine piktogramą, esančią standartinių įrankių juostoje, arba pasirinkite 
Machine>Send Design. 
Jeigu mašina teisingai sujungta, atsidaro dialogas Send a Design. Plačiau, žr.pusl. 205 Piešinių siuntimas ir 
rašymas. 
3.Spragtelėti Send mygtuką. 
DigitizerPro nustato ar nėra nei vieno objekto, kuris netilptų pilnai į vieną iš dviejų lankelio padėčių.: 
*Jeigu yra, jie bus pažymėti Design Window lange, ir jūs būsit paprašytas redaguoti piešinį ar ištrinti objektus. 
Kitu atveju, DigitizerPro nustato kiek išėjimų už ribos. 
*Jeigu tiktai vienas arba du su pirmu viršuje, DigitizerPro sukuria vieną JEF failą, kuriame yra tie ‚išėjimai ‘ ir 
siunčia jį į mašiną. 
*Kitu atveju, ji paskaičiuoja kiek išviso yra tokių išėjimų ir paprašo jūsų atitinkamai veikti. Jeigu jūs sutinkate, 
ji sukuria daugybinius JEF failus  ir siunčia juos į mašiną. 
4.Spragtelėkite OK. 
JEF failų vardai sunumeruoti per brūkšnelį – ‚My Flower-1.JEF ir ‚My Flower-2.JEF‘ 
 
Pastaba Kai mašina užkrauna pirmą iš daugybinių JEF failų, ji pirmiausiai siuvinėja viršutinę dalį, tada prašo 
jūsų paslinkti lankelį į apatinę padėtį. Visuomet laikykite lankelį viršutinėje padėtyje, kai mašina pradeda 
siuvinėti naują JEF failą, kitaip, jūs tiesiai būsit paprašytas pastumti rėmelį.  
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Tai gali prireikti tokiais atvejais, kada išėjimų pora turi būti padalinta dėl per didelio dygsnių skaičiaus ar per 
didelio spalvų pasikeitimo skaičiaus. 
 
Fonų keitimas 
 
Digitizer programoje jūs galite pasirinkti spalvą lankelio viduje, kad prisiderinti prie siuvinėjamos medžiagos. 
Taip pat galite nustatyti fono spalvą už lankelio ribų, kad sudaryti kontrastą. Arba kitaip, jūs galite pridėti fono 
medžiagas, pagrįstas pavyzdžiais, patektais kartu su programine įranga.  
Fonai yra laikomi piešinio detalėmis, todėl išsaugojami kartu su piešiniu. 
 
 
 
Fonų spalvos keitimas 
Naudokite Work Environment (Setup meniu), kad pakeisti fono spalvą. 
 
Nustatykite spalvą lankelio viduje, kad prisiderinti prie siuvinėjamos medžiagos. Taip pat galite nustatyti fono 
spalvą už lankelio ribų, kad sudaryti kontrastą. Žr.taip pat pusl.142 Darbas su medžiagomis. 
__________________________________ 
 
Kad pakeisti fono spalvą 
1.Pasirinkite Setup>Work Environment arba spragtelėkite dešiniu pelės mygtuku ant Design Window (piešinio 
langas) ir pasirinkite iš popup meniu 
 Pasirinkti Work Environment 
 
Atsidaro dialogas Work Environment. 
 Pasirinkite, kad pakeisti foną lankelio viduje ar išorėje 
 
2.Jei jau pasirinkta ne, pasirinkite Colors variantą 
3.Pasirinkite Inside Hoop (viduj lankelio) arba Outside Hoop (už lankelio)  reikalingą variantą 

*Outside Hoop: Šiuo atveju jūs pasirenkate fono spalvą už lankelio ribų arba, kai lankelis nerodomas, 
viso piešinio lango. 
*Inside Hoop: Šiuo atveju pasirinkta fono spalva taikoma lankelio viduje. 

4.Pasirinkite spalvą iš paletės arba sumaišykite savo spalvą. Plačiau, skaitykite žemiau Savo fono spalvos 
maišymas. 
5.Spragtelėkite OK. 
 
 
Lankelio vidaus plotas perdažytas    Lankelio išorė perdažyta 
 
Nustatykite lankelio vidaus spalvą, derančią su medžiagos, ant kurios norite siuvinėti, spalva. 
Žr.taip pat pusl.142 Darbas su medžiagomis. 
_______________________________________ 
 
Kad pakeisti fono medžiagą 
1.Pasirinkti Setup>Environment arba spragtelėkite dešiniu pelės mygtuku ant Design Window ir pasirinkite iš 
popup meniu. Atsidaro dialogas Work Enwironment 
2.Pasirinkite variantą Fabrics. 
Dialogas pasikeis į tokį: 
  Spragtelėti, kad pasirinkti pavyzdį 
 
  Medžiagų peržiūra 
3.Spragtelėkite ant mygtuko Browse Fabrics (medžiagų rodyklė) 
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Select Fabrics dialogas parodo medžiagų pavyzdžių sąrašą, iš kurio galima pasirinkti. 
 
 
 
 
 
Pabandykite tai  Jūs galite pridėti savo pačių medžiagų pavyzdžius į bylą Fabrics bet kuriame iš palaikomų 
formatų. Jūs taip pat galite peržiūrėti kitą bylą savo PK ir pasirinkti failą bet kuriame iš šių formatų. Žr.taip pat 
pusl.257 Palaikomų siuvinėjimo failų formatai. 
4.Pasirinkite medžiagos pavyzdį ir spragtelėkite Open arba tiesiog du kartus spragtelėkite ant failo. 
Pasirinkta medžiaga bus rodoma lankelio peržiūroje dialoge Work Enwironment. 
5.Spragtelėkite OK. 
Pasirinkta medžiaga dabar bus taikoma visam piešinio langui 
 
 
 
   Taikoma fono medžiaga 
Jūsų pačių fono spalvos maišymas 
Naudokite Work Environment (Setup meniu), kad sumaišyti naują fono spalvą. 
 
Jūs galite sukurti naują fono spalvą naudoti piešinio lange. Visi nauji piešiniai naudoja standartines spalvas 
_____________________________ 
 
Kad sumaišyti jūsų pačių fona spalvą 
1.Pasirinkti Setup>Work environment. 
Atsidaro dialogas Wor Environment. 
 
  Spragtelėkite, kad sumaišyti spalvas 
  Pasirinkite spalvą pakeitimui 
   
2.Pasirinkti spalvos langelį paletėje 
3.Spragtelėti Mix Color (maišyti spalvas) 
Atsidaro dialogas Color. 
 
 
 
 
 
4.Iš bazinių Basic spalvų lentelės pasirinkite spalvą, kuri būtų labiausiai artima jūsų norimai spalvai. 
5.Spragtelėkite ir tempkite pele kryžiukus ant spalvos spektro, kad tiksliai pasiekti reikalingą spalvą. 
6.Tempkite slinktį, esančią dešinėje spalvos spektro, kad sureguliuoti spalvos ryškumą. 
Dialogo apatiniame dešiniajame kampe pasirodis Hue, Luminosity, ir Saturation (HLS) ir Red, Green ir Blue 
(RGB) reikšmės. Norėdami tiksliai apibrėžti spalvą, tiesiog įveskite šias reikšmes. 
7.Kai jau turite sumaišytą savo spalvą, spragtelėkite Add to Custom Color ir po to OK. 
Pasirinktame spalvos langelyje pasirodis nauja spalva. 
 
 
 
Pastaba  Nauja spalva yra išsaugojama tiktai su šiuo piešiniu. Nauji piešiniai naudoja standartines užduotas 
spalvas. 
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II Dalis 
 
ELEKTRONINIO GRAFINIO PROEKTAVIMO PAGRINDAI 
 
EasyDesign programoje jūs sukursite piešinių programas iš bazinių figūrų arba ‚siuvinėjimo objektų‘. Jie yra 
panašūs į paprastus piešimo objektus, tačiau turi apibrėžtas charakteristikas arba ‚savybes‘, kaip spalvą, dydį, 
padėtį ir t.t. Jie taip pat turi savybes charakteringas siuvinėjimui, kaip dygsnių tipas ir jų tankis. 
 
Rankinis projektavimas 
 
Šioje dalyje aprašyta, kaip nupiešti figūras, pritaikant pagrindines piešimo priemones. Čia taip pat aiškinama, 
kaip sureguliuoti piešimo nustatymus, kad gauti geriausius rezultatus. Plačiau, skaitykite pusl.57 Rankinis 
projektavimas. 
 
Užpildomieji dygsniai 
 
Šioje dalyje paaiškinta, kaip objektui parinkti dygsnių tipą, kaip pakeisti dygsnių nustatymus, kad pasiekti 
geriausių rezultatų. Čia aprašyti užpildomųjų dygsnių tipai, tokie kaip Satin, Weawe ir Embossed Fill. Plačiau 
skaitykite pusl.65 Užpildomieji dygsniai. 
 
Siuvinėjimo atspaudai ir motyvai 
Šiame skyriuje aprašyta, kaip į jūsų piešinį įterpti atspaudus ir kaip sureguliuoti juos, kad gauti norimus 
rezultatus. Taip pat paaiškinta kaip sukurti motyvų aibes ir kaip užpildyti piešinį motyvais iš sistemos 
‚bibliotekos‘. Plačiau, skaitykite pusl.71 Siuvinėjimo atspaudai ir motyvai. 
 
Siūlų spalvos 
 
Šiame skyriuje aprašyta, kaip pasirinkti spalvas iš Color Chart (spalvyno) ir kaip pakeisti fono spalvas lankelio 
viduje ir /arba išorėje. Plačiau, skaitykite pusl.79  Siūlų spalvos. 
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8 skyrius 
RANKINIS ELEKTRONINIŲ PIEŠINIŲ PROJEKTAVIMAS 
 
EasyDesign programoje jūs sukursite piešinių programas iš bazinių figūrų arba ‚siuvinėjimo objektų‘. 
Siuvinėjimo objektai turi apibrėžtas charakteristikas arba ‚savybes‘, kaip spalvą, dydį, padėtį ir t.t. Jie taip pat 
turi savybes charakteringas siuvinėjimui, kaip dygsnių tipas ir jų tankis 
 
Jūsų sukurtų objektų charakteriskos apibrėžiamos jums projektuojant, tačiau jos gali būti modifikuojamos bet 
kuriame etape. Pati svarbiausia savybė, charakteringa siuvinėjimo objektams, yra dygsnių tipas. Skirtingoms 
figūroms pritaikomi skirtingi dygsnių tipai. Plačiau skaitykite pusl.66 Užpildomųjų dygsnių pasirinkimas. 
 
Šioje dalyje aprašyta, kaip nupiešti figūras, pritaikant pagrindines piešimo priemones. Čia taip pat aiškinama, 
kaip sureguliuoti piešimo nustatymus, kad gauti geriausius rezultatus. 
 
Piešimo būdai 
 
Siuvinėjimo objektų sukūrimo ekrane procesas vadinasi ‚digitizing‘ (elektroninis piešimas). Panašiai, kaip 
kuriant grafinius piešinius, čia panaudota daugybė ‚piešimo‘ įrankių. Piešimo įrankiai DigitizerPro programoje 
yra panašūs į paprasto piešimo įrankius, išskyrus, tai kad galutinis rezultatas yra siuvinėjimo objektas daugiau 
negu paprastas piešinys. 
 
Piešimo būdų pasirinkimas 

Naudokite Single Run Line (Digitize įrankių juostoje), kad pagal nupieštą liniją patalpinti viengubus, 
trigubus, satin arba motyvų aibės dygsnius. 
 
Naudokite Turning Angle Fill (Digitize įrankių juostoje), kad sukurti Satin, Weave ir Embossed 
stulpelius su kintamu pločiu ir dygsnių kampu. 
 
Naudokite Border (Digitize įrankių juostoje), kad nupiešti stulpelius arba ribas su fiksuotu pločiu. 
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Naudokite Parallel Fill (Digitize įrankių juostoje), kad užprogramuoti uždaras figūras su Satin, Weave , 
Embossed arba Motif užpildymo dygsniais. 
 
Naudokite Parallel Fill Rectangle (Digitize įrankių juostoje), kad užprogramuoti stačiakampius su Satin, 
Weave , Embossed arba Motif užpildymo dygsniais. 
 
Naudokite  Parallel Fill  Circle (Digitize įrankių juostoje), kad užprogramuoti apskritimus su Satin, 
Weave , Embossed arba Motif užpildymo dygsniais. 

 
 
Skirtingų figūrų arba elementų programavimui yra pritaikyti skirtingi metodai areba ‚įrankiai‘. Programavimo 
būdai padalinti į dvi stambias kategorijas – kontūrų ir užpildų programavimo būdai. Kontūrų programavimui 
naudojami Single Run Line būdai. Turning Angle Fill and Border naudojami stulpelių formos figūroms, 
turinčioms skirtingas charakteristikas. Parallel Fill labiausiai naudojamas programavimo įrankis, jį galima 
panaudoti beveik bet kuriai uždarai figūrai. 
 
Baziniai ir kontroliniai taškai EasyDesign programoje. 
 
Kai tik pasirinkote programavimo būdą, galite tuo pačiu būdu, pasižymėdami bazinius taškus išilgai kontūro, 
programuoti figūras. Bendru atveju, bazinius taškus jums reikia pažymėti ten kur: 
 *kreivės kontūras keičia savo išlinkį, 
 *kontūras turi kampus 
 *kontūras iš tiesios linijos pereina į kreivę. 
 
 
 
 
 
 
 
1)Run Line įrankis;  2)Border įrankis;  3)Parallel Fill įrankis; 
 
Kampo taškui pažymėti visuomet naudokite kairį pelės mygtuką, o dešinį pelės mygtuką naudokite kreivės 
taškams.Du taškai, pažymėti su kairiu pelės mygtuku, visuomet sujungiami tiesia linija. Trys taškai, pažymėti 
su dešiniu pelės mygtuku, visuomet sujungiami su kreiva linija.Baziniai taškai,  kuriuos jūs pažymėjote 
programuodami figūrą, tampa pasirenkamų objektų ‚kontroliniais taškais‘. Kontroliniai taškai pasirodo ant 
objekto kontūro ir naudojami objektų redagavimui arba transformavimui, t.y. figūros formos keitimui, dydžio 
keitimui, raidžių išdėstymui, įvedimo ir išvedimo taškų keitimui. 
 
Klavišas į kontrolinius taškus. 
  =Įvedimo taškas 
  =Išvedimo taškas 
  =Kampo taškas 
  =Kreivės taškas 
  =Kampinių dygsnių linija 
 
Daugumą kontrolinių taškų galima pridėti, ištrinti, perkelti arba pakeisti iš kreivės taško  į kampinį arba 
atvirkščiai. Kai kurie kontroliniai taškai turi specifines funkcijas ir todėl jų negalima ištrinti, pavyzdžiui, 
įvedimo taško atžyma. 
 
Linijų programavimas 
Viengubų arba trigubų eilių linijų siuvinėjimui naudokite Single Line programavimo įrankį. Šis įrankis 
paprastai naudojamas prie piešinio pridėti rėmelį. 
 
 
 
 
Patarimas  DigitizerPro palengvina paversti linijas į Satin dygsnių rėmelius per Object Details>Line Stitch 
dialogą. Plačiau, skaitykite pusl.60 Stulpelio pločio ir tankio nustatymas. w
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Linijų eilių sukūrimas 

Naudokite Single Single Run Line (Digitize įrankių juostoje), kad išilgai programuojamos linijos 
patalpinti viengubą dygsnių eilę. 
Naudokite Triple Single Run Line (Digitize įrankių juostoje), kad išilgai programuojamos linijos 
patalpinti trgubą dygsnių eilę. 
Naudokite Motif Single Run Line (Digitize įrankių juostoje), kad išilgai programuojamos linijos 
patalpinti motyvų dygsnių eilę. 

 
Linijas iš viengubų arba trigubų siuvinėjimo eilių projektuokite su Single Run Line įrankiais. Kurkite objektus 
naudodami kairius ir dešinius pelės spragtelėjimus, kad atžymėti bazinius taškus kontūro formavimui. Kairiu 
spragtelėjimu įveskite kampinius taškus, o dešiniu kreivės taškus. Jūs galite pakeisti dygsnio ilgį ir tipą, įėję į 
Object Details dialogo lentelę Line Stitch. Prieš projektuodami objektus nustatykite Single Run Line reikšmes, 
pakeisdami esamas. Plačiau, skaitykite pusl.134 Esamų objekto detalių nustatymas. 
 
Kad sukurti viengubos eilės liniją 
1.Spragtelėkite piktogramą Single Run Line . 
2.Nubraižykite linijos figūrą, pažymėdami bazinius taškus. 
 *Sprgtelėkite, kad įvesti kampinius taškus. 
 *Dešiniu spragtelėjimu įveskite kreivės taškus. 
 
   Dešinys spragtelėjimas kreivės taškams   
 
   Kairys spragtelėjimas kampiniams taškams 
 *Brėžiant liniją 15o kampu, laikykite nuspaudę Ctrl. 
 
   Laikykite paspaudę Ctrl, kad brėžti linijas 15o kampu 
 
 *Apskritimui, atžymėkite tris taškus su dešiniu spragtelėjimu. 

*Ten kur kreivės susijungia su tiesia linija arba su kita kreive, spragtelėkite, kad pažymėti sujungimo 
tašką. 
 

Pabandykite tai  Jeigu jūs padarėte klaidą, paspauskite Backspace klavišą, kad ištrinti paskutinį bazinį tašką, 
tada tęskite braižymą 
3.Paspauskite Enter, kad užbaigti linijos braižymą. 
 
Viengubos dygsnių eilės linijos tipo keitimas 
Single Run Line dygsnių tipą galite pakeisti dialoge Object Detail. Jūs galite pasirinkti viengubą arba trigubą 
eilių liniją. Single Run Line patalpina viengubą dygsnių eilutę į braižomą liniją. Triple Run pakartoja kiekvieną 
dygsnį tris kartus, kad gauti storesnę liniją. Žr.taip pat pusl.73 Motyvų eilučių sukūrimas. 
 
 
 
 
Kad nustatyti Single Run Line (viengubų) dygsnių tipą 
1.Du kartus spragtelėkite ant Single Run Line 
Atsidaro object Details>Line Stitch dialogas. 
 
    Pasirinkti Single Run Line (viengubų) dygsnių tipą. 
 
2.Pasirinkti Single Run Line dygsnių tipą. 
3 Spragtelėti OK. 
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Single Run Line (viengubų) dygsnių ilgio nustatymas 
Single Run Line dygsnių ilgį reikia nustatyti tokį, kad tiktų projektuojamai figūrai. Kada objektas sudarytas iš 
tankių kreivių, pasirinkite trumpesnio ilgio dygsnius. Norėdami lėkštesnėms kreivėms sumažinti dygsnių 
skaičių, padidinkite jų ilgį. 
 
Pastaba  Tai galima taikyti tiktai objektams, kurie sukurti su Single Run Line braižymo metodais, ir netinka 
siuvinėjimui Travel arba Underlay eilėmis. 
_______________________________________ 
 
Kad nustatyti Single Run Line (viengubų) dygsnių ilgį 
1.Pasirinkti ir du kartus spragtelėti ant Single Run Line objekto. 
2.Atsidaro dialogas Object Details>Line Stitch 
 
  
3.Į dygsnių ilgio lauką įveskite dygsnio ilgį. 
 
 
 
Jeigu linijoje yra tankių aštrių kreivių, sumažinkite dygsnio ilgį, pavyzdžiui iki 1.8 mm, taip, kad dygsniai sektų 
pagal kreivę. 
 
Pabandykite tai  Imituokite rankinį siuvinėjimą, nustatę trieilius dygsnius iki 4.0mm ilgio. 
4.Spragtelėkite OK. 
 
Fiksuoto storio stulpelių programavimas 
 
Satino kontūrams programuoti naudokite Border įrankį. Jis paprastai naudojamas didelių figūrų pakraščių ir 
kontūrų programavimui. Border įrankis naudoja Satin  dygsnius. 
 
Stuylpelių ir pakraščių kūrimas 

Naudokite Border (Digitize įrankių juostoje), kad programuoti fiksuoto storio stulpelius ir pakraščius. 
 
Fiksuoto storio stulpelius ir pakraščius programuokite su Border įrankiu. Sukurkite objektus naudodamiesi 
kairiu ir dešiniu pelės spragtelėjimais, kad atžymėti bazinius taškus ir suformuoti kontūrą. Kairiu spragtelėjimu 
įveskite kampinius taškus, o dešiniu – kreivės taškus. Jūs galite palikti kontūrą atvirą arba sukurti pakraštį 
sujungiant pirmą ir paskutinį bazinius taškus. 
 
 
 
_________________________________ 
 
Kad sukurti stulpelius ir pakraščius 
1.Spragtelėti ant piktogramos Border. 
2.Suprojektuoti figūrą iš stulpelių, atžymint bazinius taškus. 
 *Kairiu spragtelėjimu įveskite kampų bazinius taškus. 
 *Dešiniu spragtelėjimu įveskite kreivės taškus. 
 
 
 
Pabandykite tai Jeigu padarėte klaidą, paspauskite Backspace, kad ištrinti paskutinį bazinį tašką, tada tęsti 
programavimą. 
3.Kada pabaigsite linijos projektavimą, tai 

*Paspaukite Enter, kad palaikyti paskutinį dygsnį ir patalpinti išėjimo tašką paskutiniame atžymėtame 
taške arba 
*Paspauskite Spacebar , kad praleisti paskutinį dygsnį ir patalpinti išėjimo tašką priešingoje stulpelio 
pusėje . 

 
Pabandykite tai  Kad sukurti kontūrą, ‚uždarykite‘ figūrą įvedant paskutinį bazinį tašką tiksliai ant pirmo taško 
viršaus. Jeigu taškai nebus tiksliai vienas ant kito, siuvinėjimas  nebus glotnus aplink kampą. 
Stulpelio pločio ir tankio nustatymas 
Pakraščio stulpelių plotį galite tiksliai nustatyti Object Details dialoge. w
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______________________________ 
 
Kad nustatyti stulpelio plotį ir tankį 
1.Pasirinkite ir spragtelėkite du kartus ant objekto (Border arba Run). 
Atsidaro Object Details>Line Stitch dialogas. 
 Įveskite reikalingą stulpelio plotį 
2.Width lauke įveskite plotį. 
3.Patempkite slinktį, kad nustatyti dygsnių tankį: 
 *Norėdami sudaryti zigzag efektą, naudokite žemesnį tankį. 
 *Naudodami ploną siūlą nustatykite didesnį tankį. 
4.Spragtelėkite OK. 
 
 
Stulpelių su kintamu pločiu programavimas 

Naudokite Turning Angle Satin Fill (Digitize įrankių juostoje), kad sukurti Satin užpildytus stulpelius su 
kintamu pločiu ir dygsnių kampu. 

 
Naudokite Turning Angle Weave Fill (Digitize įrankių juostoje), kad sukurti  Weave užpildytus 
stulpelius su kintamu pločiu ir dygsnių kampu. 
 
Naudokite Turning Angle Embossed  Fill (Digitize įrankių juostoje), kad sukurti Embosed užpildytus 
stulpelius su kintamu pločiu ir dygsnių kampu. 

 
Kad užprogramuoti stulpelius su kintamu pločiu ir dygsnių kampu, panaudokite Turning Angle Fill įrankius. 
Atžymėtos bazinių taškų poros apibrėžia kontūrą, tuo tarpu linijos jungiančios poras, apibrėžia dygsnių 
kampus. 
________________________ 
Kad užprogramuoti stulpelius su kintamu pločiu 
1.Spragtelėti ant piktogramos Turning Angle Fill. 
2.Sukurkite figūrą, pažymėdami bazinius taškus ant stulpelio priešingų pusių. 
 *Spragtelėkite, kad įvesti kampinius taškus. 
 *Dešiniu spragtelėjimu įveskite kreivės taškus. 
Pažymėkite porą taškų, kur keičiasi kontūras ir kur norite pakeisti dygsnių kampą. 
 
 Dygsniai laipsniškai keičia savo kampą; Dygsniai tarp lygiagrečių dygsnių kampų pasilieka lygiagretūs   
Pastaba  Kontroliniai taškai poroje negali būti vienodo tipo. Pavyzdžiui, vienas gali būti kampinis taškas, o 
kitas kreivės. 
 
Pabandykite tai  Jeigu suklydote, paspauskite Backspace, ištrinti paskutinį bazinį tašką, tada tęsti 
programavimą. 
3.Kada pabaigsite linijos projektavimą, tai 

*Paspaukite Enter, kad palaikyti paskutinį dygsnį ir patalpinti išėjimo tašką paskutiniame atžymėtame 
taške arba 
*Paspauskite Spacebar , kad praleisti paskutinį dygsnį ir patalpinti išėjimo tašką priešingoje stulpelio 
pusėje . 

 
Pabandykite tai  Jeigu sujungiate du stulpelius, praleiskite paskutinį dygsnį pirmajame stulpelyje taip kad 
išėjimo taškas būtų arti prie sekančio stulpelio įvedimo taško. 
 
Sudėtingų figūrų su fiksuotais dygsnių kampais programavimas 
 Naudokite Parallel Satin Fill (Digitize įrankių juostoje), kad sukurti uždaras figūras su Satin užpildu. 
 
 Naudokite Parallel Weave Fill (Digitize įrankių juostoje), kad sukurti uždaras figūras su Weave užpildu. 
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Naudokite Parallel Embossed Fill (Digitize įrankių juostoje), kad sukurti uždaras figūras su Embossed 
užpildu. 

 
 Naudokite Parallel Motif Fill (Digitize įrankių juostoje), kad sukurti uždaras figūras su Motif užpildu. 
 
Programuojant dideles ir sudėtingas figūras, naudokite Parallel Fill įrankius. Su šiuo įrankiu galima 
programuoti daugumą figūrų. Žr.taip pat pusl.75 Motif užpildų kūrimas. 
 
 
 
____________________________________ 
 
Kad sukurti Parallel Fill objektus 
1. Spragtelėkite ant piktogramos Parallel Fill. 
2.Programuokite figūros ribas, atžymėdami bazinius taškus aplink figūrą. 
 *Spragtelėkite, kad įvesti kampinius taškus. 
 *Dešiniu spragtelėjimu įveskite kreivės taškus. 
 
Pabandykite tai  Kad palengvinti projektavimą būklės juostoje sekite pranešimus. Jeigu suklydote, spauskite 
Backspace, kad ištrinti paskutinį bazinį tašką, tada tęskite darbą. 
 
3.Uždarykite figūrą. 

*Norėdami uždaryti figūrą su tokio pat tipo baziniais taškais – t.y. kampiniais arba kreivės – tiesiog 
spauskite Enter. 
* Norėdami uždaryti figūrą su skirtingo tipo baziniais taškais, ant pirmojo viršaus pažymėkite paskutinį 
tašką ir Norėdami uždaryti figūrą su tokio pat tipo baziniais taškais – t.y. kampiniais arba kreivės – 
tiesiog spauskite Enter. 
 spauskite Enter. 

 
 
 
 
 
 
 
Pastaba  Pakraščiai neturi persidengti 
4.Spausti Enter. 
 
Pastaba  Norėdami Parallel Fill objektuose sureguliuoti dygsnių kampus, skaitykite pusl.128 Dygsnių kampų 
reguliavimas. 
 
Apskritimų programavimas 

Naudokite Parallel Satin Fill: Circle (Digitize įrankių juostoje), kad sukurti apskritimus su Satin užpildu. 
Naudokite Parallel Weave Fill: Circle  (Digitize įrankių juostoje), kad sukurti apskritimus su Weave 
užpildu. 
Naudokite Parallel Embossed Fill: Circle (Digitize įrankių juostoje), kad sukurti apskritimus su 
Embossed užpildu. 

 
Galite sukurti apskritimus ir ovalus per keletą spragtelėjimų. Su apskritimais ir ovalais galite naudoti bet kurį 
dygsnių tipą. 
___________________________________ 
 
Kad sukurti apskritimą ir ovalą 
1. Iš Digitize įrankių juostos pasirinkite Parallel Fill: Circle būdą. 
2.Sukurkite apskritimą. 

*Spragtelėkite, kad atžymėti apskritimo arba ovalo centrą. Apskritimo išorinė linija sutaps su pelės 
žymekliu. 
*Paslinkite pėlės žymeklį nuo centro, kol apskritimo dydis nepasieks reikalingo dydžio, tada 
spragtelėkite, kad atžymėti spindulio bazinį tašką. w
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Šis taškas taip pat atžymi dygsnių įvedimo tašką. Dygsnių kampas bus statmenas į liniją, jungiančią 
centrinį tašką ir spindulio bazinį tašką. 
*Atleiskite pelės mygtuką. 

 
 
 
Kvadratų ir stačiakampių programavimas 
  

Naudokite Parallel Satin Fill: Rectangle (Digitize įrankių juostoje), kad sukurti kvadratus arba 
stačiakampius su Satin užpildu. 
Naudokite Parallel Weave Fill: Rectangle (Digitize įrankių juostoje), kad sukurti kvadratus arba 
stačiakampius su Weave užpildu. 
Naudokite Parallel Embossed Fill: Rectangle (Digitize įrankių juostoje), kad sukurti kvadratus arba 
stačiakampius su Embossed užpildu. 
Naudokite Parallel Motif Fill: Rectangle (Digitize įrankių juostoje), kad sukurti kvadratus arba 
stačiakampius su Motif užpildu 

 
Galite sukurti kvadratus ir stačiakampius per keletą spragtelėjimų. Su kvadratais ir stačiakampiais galite 
naudoti bet kokius užpildymo dygsnius. Žr.taip pat pusl. 75 Motyvų užpildų sukūrimas. 
 
 
 
____________________________ 
 
Kad sukurti kvadratus ir stačiakampius 
1.Spragtelėkite ant piktogramos Parallel Fill Rectangle 
2.Sukurkite kvadratą ar stačiakampį 
 *Spragtelėkite, kad pažymėti stačiakampio kampą. 
 *Tempkite pelės žymeklį, kol stačiakampio forma nepasieks reikiamo dydžio. 
 *Atleiskite pelės mygtuką. 
 *Kad sukurti kvadratą, laikykite paspaustą klavišą Ctrl , kol tempsite žymeklį. 
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9 skyrius 
UŽPILDYMO DYGSNIAI 
 
Visi siuvinėjimo objektai  DigitizerPro programoje susideda iš apibrėžiančio komplekto nustatymų arba 
‚reikšmių‘. Reikšmės, išsaugotos kartu su objektu, tampa jo ‚savybėmis‘. Visi objektai turi tam tikras savybes, 
bendros, tokios kaip, dydis ir padėtis. Yra kitos, specifinės objekto savybės, kurios priklauso nuo objekto tipo. 
 
Svarbiausia visų siuvinėjimo objektų savybė yra dygsnių tipas. 
 
Dygsnių savybės apibrėžiamos jums programuojant, tačiau jos gali būti keičiamos bet kuriame etape. Objekto 
programavimo metu konkrečiam metodui jūs galite priimti standartinius nustatymus arba pritaikyti naujus. 
Standartiniai nustatymai yra saugomi piešinio šablone. Plačiau, skaitykite pusl.133 Objektų Detalės ir Šablonai. 
 
Šiame skyriuje aprašyta, kaip objektui parinkti dygsnių tipą taip pat kaip pakeisti dygsnių nustatymus, kad 
pasiekti geriausių rezultatų. Čia aprašyti Satin, Weave ir Embossed užpildymo dygsnių tipai. 
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Užpildymo dygsnių pasirinkimas 
 
Skirtingiems objektams tinka skirtingo tipo dygsniai. Projektuojant objektą naudojami tokie dygsniai, kokie 
buvo parinkti veikiančiam programavimo metodui. Tačiau dygsnių tipą jūs galite pakeisti bet kuriuo metu. Jūs 
taip pat galite iš anksto prieš projektuojant užsiduoti dygsnio tipą kaip ‚veikiantį ‘.Plačiau, skaitykite pusl. 134 
Veikiančių objekto detalių nustatymas. 
____________________________________ 
 
Kad pasirinkti užpildymo dygsnius 
1.Du kartus spragtelėkite ant pasirinkto objekto(ų), kurių dygsnių tipą norite keisti. 
Atsidaro dialogas Object Details>Fill Stitch 
 
 
 
 
2.Pasirinkite užpildymo dygsnių tipą: 

*Satin Fill: gerai tinka siuvinėti siaurus stulpelius ir figūras. Plačiau, skaitykite pusl.66 Satin užpildymo 
sukūrimas. 
*Weave Fill: susideda iš dygsnių eilučių ir tinka didelių netaisyklingų figūrų užpildymui. Plačiau 
skaitykite pusl. 67 Weave užpildymo sukūrimas. 
*Embossed Fill: tinka didelių plotų su unikaliais meniniais efektais  užpildymui. Plačiau skaitykite pusl. 
67 Weave užpildymo sukūrimas. 

3.Spragtelėkite OK. 
 
Satin užpildymo sukūrimas 
 
Satin dygsniai gerai tinka siauriems stulpeliams ir figūroms, kur kiekvieno dygsnio ilgis formuoja stulpelio 
plotį. Satin dygsniai yra visuomet beveik lygiagretūs,.kas antras dygsnis nežymiai pakreiptas. Kadangi 
užpildymo viduje nėra adatos dūrių, tai Satin dygsniai sukuria žvilgantį aukštos kokybės efektą. 
 
Objektų su Satin užpildymu sukūrimas 
Sukurkite objektą su tokiomis procedūromis. Jeigu Satin figūra yra plati, tai kažkiek dygsnių gali viršyti 
maksimalaus dygsnio, kurį siuvimo mašina pajėgi atgaminti, dydį. Kada įjungtas nustatymas AutoSplit, 
EasyDesign padalina bet kurį ilgą dygsnį į trumpesnius. Programa taip pat atsitiktinai paskirsto adatos dūrius, 
kad jie figūros viduje neformuotų linijos. 
________________________________ 
 
Kad sukurti objektus su Satin užpildymu. 
1.Kai objektas dar nepasirinktas, spragtelėti ant piktogramos Object Details. 
Atsidaro Object Details>Fill Stitch dialogas. 
 
1)Pasirinkti Satin Fill 
2)Įjungti AutoSplit 
 
2.Pasirinkti Satin Fill. 
3.Sukurti objektą, pasinaudojant vienu iš įrankių Border arba Turning Angle Fill. 
 
AutoSplit išjungtas   AutoSplit įjungtas 
Pastaba  AutoSplit funkciją galite įjungti visų tipų Satin objektams. Pagal standartą ji išjungta. 
 
Satin dygsnių intervalo reguliavimas 
Dygsnių intervalas tai yra atstumas milimetrais tarp dviejų adatų dūrių toje pačioje stulpelio pusėje. Kur 
stulpelis yra siauras dygsniai yra glaudesni, todėl reikia mažiau dygsnių, kad uždengti medžiagą. Kur stulpelis 
yra labai siauras, ten reikia, kad dygsniai būtų ne tokie glaudūs, kadangi per dažni  adatos dūriai gali pažeisti 
medžiagą. 
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Pakeiskite dygsnių tankį Satin užpildyme, tempiant slinktį dialoge Object Details. Kuo didesnis intervalas tuo 
mažesnis tankis. Kuo mažesnis intervalas, tuo didesnis tankis. 
_______________________ 
 
Kad sureguliuoti Satin dygsnių tankį 
1.Pasirinkite ir du kartus spragtelėkite ant Satin objekto. 
Atsidaro Object Details>Fill Stitch dialogas. 
 
 Paslinkti, kad  nustatyti dygsnių tankį 
 
2.Paslinkite slinktį, kad sureguliuoti dygsnių tankį: 
 *Kad padidinti dygsnių tankį, paslinkite slinktį į dešinę 
 *Kad sumažinti dygsnių tankį, retesniam siuvinėjimui, slinktį paslinkite į kairę 
3.Spragtelėkite OK. 
 
Weave užpildymo sukūrimas 
 
Weave Fill užpildymas susideda iš dygsnių eilių, ir jis yra tinkamas didelių netaisyklingų figūrų užpildymui.. 
Dygsniai pratiesiami eilutėse pirmyn ir atgal skersai figūros. Eilutės gali būti lygiagrečios arba truputį pasuktos. 
Kiekvienoje eilutėje naudojami dygsnių poslinkiai, kad išvengti horizontalių dalijimo linijų. 
 
 
Dygsnių tankį Weave Fill užpildymo objektuose galite kontroliuoti, reguliuodami piešinį, dygsnių intervalą ir 
ilgį. 
 
Objektų su Weave Fill užpildymu sukūrimas 
Objektų su Weave Fill užpildymu sukūrimo procedūra: 
Kad sukurti objektą su Weave Fill užpildymu 
1.Neesant pasirinktų objektų, spragtelėkite ant piktogramos Object Details. 
Pasirodo Object Details>Fill Stitch dialogas. 
 
 
2.Pasirinkti Weave Fill 
3.Sukurti objektą su Parallel Fill arba Turning Angle Fill įrankiais. 
 
Weave Fill pavyzdžių pasirinkimas 
Jūs galite pasirinkti daugelį Weave Fill pavyzdžių. Bendrai, geriausius rezultatus duotų standartinis dydis ir 
intervalas, tačiau jums gali prireikti pakeisti dygsnių kampą. 
_________________________ 
 
Kad pasirinkti Weave Fill pavyzdį 
1.Pasirinkite ir du kartus spragtelėkite ant Weave Fill objekto. 
Atsidaro Object Details>Fill Stitch dialogas. 
 
 
 
2.Spragtelėkite langelyje su rodyklėmis, kad peržiūrėti pavyzdžių sąrašą arba tiesiog į lauką įveskite pavyzdžio 
numerį. 
3.Spragtelėkite OK. 
 
Weave Fill dygsnių intervalo reguliavimas 
Weave Fill užpildymui dygsnių tankis apsprendžiamas atstumu tarp dygsnių eilučių. Intervalo nustatymas yra 
atstumas tarp dviejų tiesioginės krypties eilučių. 
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Kad sureguliuoti Weave Fill dygsnių intervalą 
1.Pasirinkite ir du kartus spragtelėkite ant Weave Fill objekto. 
Atsidaro Object Details>Fill Stitch dialogas. 
 
 Dygsnių intervalo reguliavimas 
 
2.Stitch Spacing lauke įveskite naują intervalo reikšmę. 
Ši reikšmė yra atstumas tarp dviejų tiesioginės krypties dygsnių eilučių. 
*Kad padidinti tankį, įveskite mažesnę reikšmę. 
*Kad sumažinti tankį, įveskite didesnę reikšmę. 
3.Spragtelėkite OK. 
 
Dygsnių intervalas 0.4 mm  Dygsnių intervalas 0.8 mm 
 
Weave Fill dygsnių ilgio reguliavimas 
Nurodykite Weave Fill objektams generuojamų dygsnių ilgį . Dygsnių ilgis Weave Fill užpildymuose kinta 
nežymiai, taip užtikrinama, kad figūros kraštuose  nebūtų generuojami maži dygsniai. 
_______________________ 
  
Kad sureguliuoti Weave Fill dygsnių ilgį 
1.Pasirinkite ir du kartus spragtelėkite ant Weave Fill objekto. 
Atsidaro Object Details>Fill Stitch dialogas. 
 
 Dygsnių ilgio reguliavimas 
 
2.Stitch Length lauke įveskite jums reikalingą dygsnių ilgį. 
3.Spragtelėkite OK. 
 
 
Ilgis: 2.5 mm     Ilgis: 4.5 mm 
Minimalus dygsnis:0.4 mm  Minimalus dygsnis:0.4 mm 
 
Embossed užpildymų sukūrimas 
 
Embossed Fill yra dekoratyvinių dygsnių tipas. Naudokite juos, kad užpildyti didelius plotus su unikaliais 
meniniais efektais, išlaikant vientiso siuvinėjimo lauko vaizdą. 
 
Embossed Fill adatų dūriai formuoja plytelių raštą. Raštas kartojamas pagal tinklelį. Jūs galite pakeisti dygsnių 
reikšmes, kad suteikti netgi didesnes variacijas. 
 
Užpildymų su Embossed Fill sukūrimas 
Sukurkite Embossed Fill objektus: 
______________________________ 
 
Kad sukurti užpildymus su Embossed Fill 
1.Neesant pasirinktų objektų, spragtelėkite ant piktogramos Object Details. 
Pasirodo Object Details>Fill Stitch dialogas. 
 
Pasirinkti Embossed Fill 
2.Pasirinkite Embossed Fill 
3.Sukurkite objektą su įrankiu Parallel Fill arba Turning Angle Fill. 
Įjunkite Vizualizer arba peržiūrėkite Display Needle Points, kad pamatyti Embossed Fill efektą. 
 
Embossed Fill pavyzdžio pasirinkimas 
 
Jūs galite pasirinkti daugelį Embossed Fill pavyzdžių. Bendrai, geriausius rezultatus suteikia standartiniai 
dydžiai ir intervalai, tačiau  jums gali prireikti pakeisti dygsnių kampą. 
________________________ 
 
Kad pasirinkti Embossed Fill pavyzdį 
1.Pasirinkite ir du kartus spragtelėkite ant Embossed Fill objekto. 
Atsidaro Object Details>Fill Stitch dialogas. 
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 Pasirinkti pavyzdį 
 
2.Iš pavyzdžių Patern sąrašo pasirinkite reikiamą pavyzdį. 
Pasirodis pavyzdžio bendras vaizdas. 
3.Spragtelėkite OK. 
 
Embossed Fill dydžio reguliavimas 
Galite pakeisti pavyzdžio dydį, kad išgauti skirtingų efektų. 
 
 
Kad pakeisti Embossed Fill dydį 
1.Pasirinkite ir du kartus spragtelėkite ant Embossed Fill objekto. 
Atsidaro Object Details>Fill Stitch dialogas. 
 
 Pavyzdžio dydžio reguliavimas 
 
2.Size lauke įveskite jums reikalingą dydžio reikšmę. 
3.Spragtelėkite OK. 
 
Embossed Fill intervalo reguliavimas 
Embossed Fill intervalo nustatymas reiškia atstumą tarp dviejų fragmentų. Jūs galite pakeisti horizontalų (X) ir 
vertikalų (Y) intervalus tarp pasikartojančių fragmentų. 
 
 
 
Kad nustatyti Embossed Fill intervalus 
1.Pasirinkite ir du kartus spragtelėkite ant Embossed Fill objekto. 
Atsidaro Object Details>Fill Stitch dialogas. 
 
 Pavyzdžio fragmentų intervalo reguliavimas 
 
2.Spacing lauke įveskite naują intervalo dydžio reikšmę. Ši reikšmė yra atstumas tarp dviejų tiesioginės 
krypties fragmentų eilučių  X yra horizontalus, o Y vertikalus intervalas. 
 *Kad padidinti intervalą, įveskite didesnę reikšmę 
 *Kad sumažinti intervalą, įveskite mažesnę reikšmę. 
3.Spragtelėkite OK. 
 
Embossed Fill dygsnių kampo reguliavimas 
Kad išgauti geriausių rezultatų, galite pakeisti dygsnių kampą. 
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___________________________ 
 
Kad sureguliuoti Embossed Fill dygsnių kampą 
1.Pasirinkite ir du kartus spragtelėkite ant Embossed Fill objekto. 
Atsidaro Object Details>Fill Stitch dialogas. 
 
 Fragmento orietacijos reguliavimas 
 
2.Rotate lauke įveskite jums reikalingą posūkio kampą. 
3.Spragtelėkite OK. 
 
 Posūkio kampas 0o  Posūkio kampas 90o  
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10 skyrius 
 
 
ATSPAUDŲ IR MOTYVŲ SIUVINĖJIMAS 
 
 
 
Siuvinėjimo atspaudai yra paruošti piešinio elementai. Bendrai, jie susideda iš vieno arba daugiau paprastų 
objektų, paruoštų siuvinėjimui Run ir/arba  Satin dygsniais. Panaudokite siuvinėjimo atspaudus ant savo pačių 
piešinių kaip dekoratyvius elementus. DigitizerPro taip pat užtikrina siuvinėjimo motyvų biblioteką, 
pastaruosius galima susieti kartu, kad sukurti ornamentines serijas ir užpildymus. 
 
Šiame skyriuje aprašoma, kaip įterpti atspaudus į jūsų piešinį ir kaip juos suderinti, kad gauti geriausią norimą 
rezultatą. Jame taip pat aiškinama kaip sukurti motyvų serijas ir užpildymus, naudojantis motyvų vidine 
biblioteka. 
 
Darbas su siuvinėjimo atspaudais 
Ebroidery Gallery (siuvinėjimo pavyzdžių galerėja) užtikrina paruoštų darbui piešinių atspaudų (štampų) 
kolekciją. Jų yra didelis pasirinkimas. Įdėjus ataspaudą į jūsų piešinį, jį galima redaguoti, keisti jo dydį ir 
formą. Juos taip pat galima naudoti motyvų serijose ir užpildymuose. 
 
Pastaba  Pilną pavyzdžių katalogą rasite Atspaudų,  motyvų ir apvadų pavyzdžiai. 
 
Atspaudų pasirinkimas ir įkėlimas 
 Naudokite Embroidery Gallery (Digitize įrankių juostoje), kad pavyzdžius (atspaudus) įterpti į piešinį. 
 
Siuvinėjimo atspaudai yra siuvinėjimui paruošti piešinio elementai, pavyzdžiui, širdelės, lapai arba geometrinės 
figūros. Naudokite juos, kad savo piešiniuose sukurti dekoratyvius efektus. Įkėlę atspaudą į savo piešinį, galite 
jį pasukti kitu kampu, pakeisti dydį arba sukurti veidrodinį jo vaizdą, galite jį redaguoti kaip bet kokį kitą 
objektą. 
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Pastaba  Jeigu atspaudas susideda iš dviejų arba daugiau objektų, pastarieji automatiškai sudaro grupę, 
atspaudą įdėjus į piešinį. 
____________________________ 
 
Kad pasirinkti ir įdėti atspaudus 
1.Spragtelėti ant Embroidery Gallery  piktogramos. 
Atsidaro Embroidery Gallery dialogas 
 
 
2.Pasirinkti atspaudą 
3.Spragtelėti OK. 
4.Perkelkite žymeklį į pageidaujamą vietą, kur norite įkelti atspaudą, ir spragtelėkite pele, kad pažymėti įkėlimo 
(anchor) tašką. 
5.Perkelti pelės žymeklį į orientavimo (guide) tašką. 
6.Slankioti pelės žymeklį, kol atspaudas neužims jums norimos padėties, tada vėl spragtelėkite, kad pažymėti 
orientavimo tašką. 
7.Paspausti Enter. 
 
 
  Spragtelėkite ant orientavimo taško 
 
8.Pakartokite, jei vėl norite įkelti atspaudą. 
 
  Pakartokite, kad įkelti 
Įkėlimo metu galite atspaudus pasukioti. Plačiau skaitykite pusl.72 Atspaudų sukiojimas, apvertimas, mastelio 
keitimas. 
9.Kad baigti, spausti Esc. 
 
Pastaba  Kiekvienas atspaudas apdorojamas kaip atskiras objektas. Norint redaguoti atskirą atspaudo dalį, 
reikia atspaudą išgrupuoti.  
  Išgrupuotas atspaudas, kad panaudoti dalimis 
 
Sukimas, apvertimas ir mastelio keitimas 
Atspaudus galite pasukti, apversti, pakeisti mastelį, įkeliant juos į piešinį, naudojantis klaviatūra ir pele. Tai 
galite atlikti ir vėliau, kaip ir su bet kuriuo iš objektų. 
 
 
___________________________ 
 
Kad pasukti, apversti, ir pakeisti mastelį 
1.Pasirinkti atspaudą įkėlimui. Plačiau žr. pusl. 71 Atspaudų pasirinkimas ir įkėlimas. 
2.Nustatyti pelės žymeklį į padėtį, kurioje norite įkelti atspaudą, ir spragtelėkite, kad atžymėti įkėlimo tašką. 
Atspaudas susiejamas su pelės žymekliu. Kai tik paslenkate pelės žymeklį, atspaudas sukasi aplink pažymėtą 
įkėlimo tašką. 
3.Pasukite atspaudą su pele 

*Pasukite atspaudą, vesdami pelės žymeklį, kai tik pasieksite tinkamą kampą, spragtelėkite. Laikykite 
paspaustą Ctrl klavišą, kad fiksuoti posūko kampą. 
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Tempkite atspaudą, kad jį pasukti 

 
   Pasuktas atspaudas 
 *Kad apversti atspaudą, spragtelėkite dešiniu pelės mygtuku 
 
 
 Dešiniu spragtelėjimu apverskite atspaudą 
     Atspaudas apverstas 
 

*Norėdami pakeisti mastelį, spauskite Shift. Traukite žymeklį, kol atspaudas netaps reikiamo dydžio, 
tada vėl spragtelėkite. 

 Laikykite paspaustą Shift, kad pakeisti mastelį 
 
      Atspaudo mastelis pakeistas 
 
4.Spauskite Enter. 
5.Norėdami vėl įkelti atspaudą, pakartokite. 
 
Pabandykite tai  Apverčiant ir keičiant mastelį, prieš kairį arba dešinį spragtelėjimą, įsitikinkite, kad atspaudas 
yra pasuktas reikalingu kampu. 
6.Spauskite Esc, kad išeiti. 
 
Mastelio keitimas iki tikslių matmenų 
Užpildyme galite tiksliai nustatyti atspaudo matmenis. 
 
 
______________________________________ 
 
Kad pakeisti mastelį iki tikslių matmenų 
1.Pasirinkite ir du kartus spragtelėkite ant atspaudo objekto. 
Atsidaro Object Details dialogas. 
2.Pasirinkite Dimensions lentelę. 
  Įveskite naują atspaudo plotį ir aukštį   
 
3.Į Dimensions lentelę įveskite naujus atspaudo matmenis milimetrais arba procentus nuo originalo. 
 
 
    Matmenys sureguliuoti 
4.Spragtelėti OK. 
 
Motyvų serijų sukūrimas 
Motif Run (motyvų serija) yra įvedimo būdas, kuris sukuria motyvų pasikartojimą pagal programuojamą liniją. 
Galite sukurti dekoratyvius rėmelius, panaudojant bet kokius iš sąrašo pasirinktus motyvus. Galite pakeisti 
posūkio kampą, orientaciją ir mastelį, pakeisti intervalą tarp motyvų. 
 
 
 
 
Motyvų serijos objekto sukūrimas 

Naudokite Motif Run Line (Digitize įrankiu juostoje), kad sukurti motyvų virtinę išilgai projektuojamos 
linijos. 

 
Naudokite Motif Run įrankį, kad sukurti motyvų virtinę pagal projektuojamą liniją. Motyvus galite pasirinkti 
prieš ir po linijos projektavimo. Galite taip pat sureguliuoti matmenis ir intervalą. 
_________________________________ 
 
Kad sukurti Motyvų serijos objektą 
1.Pasirinkti piktogramą Motif Run. 
2.Baziniais taškais sukurti liniją, pagal kurią norėsite matyti motyvus. 
 *Kairiu spragtelėjimu padėkite kampinį tašką w
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 *Dešiniu spragtelėjimu padėkite kreivės tašką. 
3.Suprojektavę liniją, paspauskite Enter. 
Prie jūsų žymeklio prisijugs veikiančių motyvų kontūras.  
  Pakeiskite motyvų kontūro matmenis pagal mastelį 
 
 *Norėdami naudoti motyvų originalų dydį  ir orientaciją, spauskite Enter. 

*Norėdami pakeisti motyvų mastelį, patempkite pelės žymeklį, kol motyvas netaps reikiamo dydžio, 
spragtelėkite ir po to paspauskite Enter. 

 
Motyvo pasirinkimas motyvų serijoms 
 Naudokite Motif Run (Digitize įrankiu juostoje), kad sukurti motyvų virtinę pagal suprojektuotą liniją. 
 
Motyvą galite pasirinkti prieš arba po motyvų serijos projektavimo. Jeigu naudosite Motif Run, nepasirinkę 
motyvo, bus panaudotas standartis motyvas. Norėdami pakeisti motyvą po projektavimo, panaudokite Object 
Details  dialogą, kaip čia aprašyta. 
 
 
 
 
 
Pastaba  Pilną pavyzdžių katalogą galite surasti Atspaudų, motyvų ir apvadų pavyzdžiai.  
_________________________ 
 
Kad pasirinkti motyvą motyvų serijai 
1.Du kartus spragtelėkite ant Motif Run  objekto 
Atsidaro Object Details>Line Stitch>Motif Run dialogas 
 
 
 
 
2.Pasirinkti pavyzdį iš išsiskleidusio sąrašo. 
3.Spragtelėkite OK. 
Pasirinktas Motif Run objektas atnaujinamas su naujai pasirinktu motyvu. 
 
Pabandykite tai  Pasirinkite motyvą, kai dar Motif Run objektas nepasirenktas, ir spragtelėkite OK, kad 
pasirinktas motyvas būtų veikiantis. 
 
Motyvo dydžio ir intervalo reguliavimas motyvo serijoje 

Naudokite Motif Run Line (Digitize įrankiu juostoje), kad sukurti motyvų virtinę pagal suprojektuotą 
liniją. 

 
Per Motif Run  dialoge Object Details nustatykite tikslius motyvo matmenis ir intervalą prieš arba po 
projektavimo. 
 
 
 
 
 
 
Kad sureguliuoti motyvo dydį ir intervalą motyvo serijoje. 
1.Du kartus spragtelėkite ant Motif Run  objekto 
Atsidaro Object Details>Line Stitch>Motif Run dialogas 
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 Sureguliuoti dydį ir intervalą 
2.Pakeiskite motyvo dydį, kad pritaikyti jį motyvų serijos masteliui. 
3.Spragtelėti OK. 
Pasirinktas Motif Run objektas atnaujinamas su naujai pasirinktu motyvu 
 
Pabandykite tai  Motyvų mastelį galite sureguliuoti taip pat projektuodami patį Motif Run objektą. Plačiau, 
skaitykite pusl.73 Motif Run objektų sukūrimas. 
4.Į Spacing lauką įveskite atstumo tarp pasikartojančių motyvų reikšmę. 
 
 
Jeigu motyvai tiksliai neatitinka suprojektuotai linijai, EasyDesign programa tiksliai sureguliuoja intervalą. 
 
Pabandykite tai  Galite taip pat pakeisti kontūro formą, kad tiksliai pasiekti reikalingą intervalą. Žr. plačiau 
Motif Run objektų formos keitimas. 
 
Motif Run objektų formos keitimas. 
 Spragtelėkite Reshape (Edit įrankių juostoje), kad parodyti pasirinkto objekto kontrolinius taškus. 
 
Motif Run objektų formos keitimas vyksta tokiu pat būdu, kaip ir raidinių objektų. Žr.taip pat pusl.179 
Orientacijos reguliavimas. 
_________________________________ 
 
Kad pakeisti Motif Run Formą 
1.Pasrinkite Motif Run objektą ir spragtelėkite ant Reshape piktogramos 
Aplink motyvą pasirodo kontroliniai taškai. 
 
 
 
 
2.Reikiamai sureguliuokite kontūrą ir motyvų intervalus: 
 *Pakeiskite padėtį ir/arba pakeiskite mazgų nuo kampo iki kreivės formą 
 *Pridėkite arba ištrinkite mazgus 
 *Spragtelėkite ir tempkite atskirus motyvus , kad sureguliuoti intervalus. 
 
  Tempti, kad paslinkti motyvą.  Tempti, kad proporcionaliai pakeisti objekto mastelį  
   
 
 
 Kairys/dešinys spragtelėjimas, kad    Pasirinkti ir paspausti Spacebar, kad pesijungti tarp  
 Pridėti formos pakeitimo mazgą   kampinių ir kreivių formos pakeitimo mazgų 
 
3.Tempkite proporcianalaus formos keitimo ‚rankenėlę‘, kad proporcianaliai pakeisti objekto mastelį. 
4.Spauskite Esc, kad užbaigti. 
 
Užpildymų motyvais sukūrimas 
 
Motif Fill yra dekoratyvus siuvinėjimas, naudojamas uždarų objektų užpildymui. Fragmentai yra kartojami 
lygiagrečiose eilutėse, kad užpildyti figūrą. Galite fragmentų išdėstymo schemą sukurti ekrane arba reguliuojant 
objektų detales. 
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Motif Fill objektų sukūrimas 

Naudokite Parallel Motif Fill (Digitize įrankiu juostoje), kad sukurti užpildymą motyvais, panaudojant 
veikiančius nustatymus.  
Naudokite Parallel Motif Fill: Rectaangle (Digitize įrankiu juostoje), kad sukurti stačiakampes figūras, 
užpildytas motyvais, panaudojant veikiančius nustatymus.  
 

Suprojektuokite Parallel Fill objektus su Parallel Motif Fill įrankiu, panaudojant veikiančius nustatymus. Arba 
pritaikykite tai egzistuojančiam Parallel Fill objektui. Galite pasirinkti fragmentus, sureguliuoti nustatymus arba 
pakeisti išdėstymo schemą bet kada, prieš arba po projektavimo. 
 
Pastaba  Dygsnių kampas neturi įtakos į motyvų išdėstymą. 
____________________________ 
 
Kad sukurti Motif Fill objektą 
1.Pasirinkite Parallel Motif Fill įrankį ir sukurkite objektą. Kai tik įėjimo iš išėjimo taškai bus įvesti, bus 
generuojami Motif Fill dygsniai, panaudojant veikiančius nustatymus. Žr.taip pat pusl.61 Sudėtingų figūrų su 
fiksuotais dygsnių kampais projektavimas. 
 
 
2.Du kartus spragtelėkite ant Motif Fill objekto 
Atsidaro Object Details>Fill Stitch>Motif Fill dialogas. 
 
 
 
 
3.Spragtelėkite Select, kad pakeisti fragmento nustatymus reikalingais. Žr. žemiau Motyvų užpildymų 
nustatymų reguliavimas. 
4.Pasirinkite iš išsiskleidusio sąrašo fragmentą ir spragtelėkite OK. 
 
Pasirinktas Motif Fill objektas atnaujintas 
 
 
 
Pabandykite tai  Pasirinkite motyvą, dar nepasirinkus objekto ir spragtelėkite OK, kad pasirinktas motyvas 
būtų veikiantis. 
 
Motyvų užpildymų nustatymų reguliavimas 
Galite įkelti motyvų užpildą prie jų originalaus dydžio ir intervalo ir tada vėliau sureguliuoti nustatymus. Taip[ 
pat, įkeliant fragmentus, galite nustatyti tikslų jų dydį ir intervalus. Intervalas tai yra atstumas tarp 
pasikartojančių fragmentų. 
 
 
Patarimas  Blackwork  gavęs pavadinimą iš juodo šilkinio siūlo, kurį tradiciškai naudoja šios formos 
siuvinėjimui. Naudokite specialų Blackwork Fill fragmentų rinkinį, kad sukurti įdomius ornamentus arba 
geometrinius raštus. 
______________________________ 
 
Kad sureguliuoti motyvų užpildymų nustatymus 
1.Du kartus spragtelėkite ant Motif Fill objekto. 
Atsidaro Object Properties>Fill Stitch dialogas su veikiančiu fragmentu ankstesnėle lentelėje. 
 
Motyvo dydžio reguliavimas 
 
Motyvo intervalo reguliavimas 
 
2.Spragtelėkite Select, kad pakeisti fragmentų rinkinius į reikalingus. 
Atsidaro Select Motif dialogas. 

w
w
w
.V
isk
as
Si
uv
im
ui
.lt
 



77 
Pakeisti motyvų rinkinį 
 
Pasirinkti motyvą 
 
3.Pasirrinkti reikalingą motyvų rinkinį iš Symbol Set  skleistinės – pavyzdžiui, Black Work. 
4.Pasirinkti fragmentą iš bibliotekos ir spragtelėti Make Current (padaryti veikiančiu). 
5.Nustatyti reikalingas Size (X) ir/arba Size (Y) reikšmes, kad užduoti motyvo plotį ir aukštį. 
 
 
 
 
6.Sureguliuoti reikalingus intervalus Spacing (X) ir/arba Spacing (Y), kad nustatyti intervalus tarp motyvų. 
 
 
 
Pabandykite tai  Preview panelė reaguoja į bet kurį reguliavimą SizeX, SizeY, SpacingX ir SpacingY 
laukuose, tokiu būdu jūs galite matyti naujai pakeistas figūras 
7.Spragtelėkite OK. 
Projektuojamas objektas užsipildis pasirinktais motyvais, pritaikant veikiančius nustatymus. 
 
Pastaba  Jeigu didesnė motyvo pusė atsidurtų už ribos, jis bus nukirptas pagal ribą. 
 
Motyvų užpildo išdėstymas ekrane 

Naudokite Parallel Motif Fill (Digitize įrankiu juostoje), kad sukurti užpildymą motyvais, panaudojant 
veikiančius nustatymus.  
Naudokite Parallel Motif Fill: Rectaangle (Digitize įrankiu juostoje), kad sukurti stačiakampes figūras, 
užpildytas motyvais, panaudojant veikiančius nustatymus.  

 
Išdėstykite motyvus ekrane, panaudojant ‚orietacinius motyvus‘, kad pakeisti mastelį, intervalą, transformuoti ir 
paslinkti visą motyvų užpildymą.Yra trys mėlyni orientaciniai motyvai. Kiti pavyzdiniai motyvai pasirodo 
geltona spalva. Kiekvienas orientacinis motyvas leidžia jums keisti įvairius išdėstymo elementus. Kada keičiate 
orientacinį motyvą, visi motyvai pasikeičia atitinkamai. 
 
 
Patarimas  Motif Fill objektų padėtį, dydį ir orientaciją taip pat galite pakeisti perkeliant, keičiant mastelį ir 
transformuojant juos kaip jūs atliekate tai su bet kuriuo objektu. Plačiau, žr. pusl.119 Objektų tvarkymas ir 
transformavimas. 
___________________________________ 
 
Kad išdėstyti ekrane motyvų užpildymą  
1.Sukurkite Motif Fill objektą iš eskizo arba du kartus spragtelėkite ant egzistuojančio. Žr. pusl.76 Motif Fill 
objektų sukūrimas. 
Atsidaro Object Details>Fill Stitch>Motif Fill dialogas. 
 
 
 
     Spragtelėti, kad išdėstyti 
 
2.Spragtelėti, kad išdėstyti 
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Piešinio lange pasirodo pavyzdiniai ir orientaciniai motyvai. Jums pakeitus orientacinį motyvą, visi motyvai 
užpildyme pasikeis atitinkamai. 
 
  Padidinkite mastelį, kad pasirinkti teisingą orientyacinį motyvą  
 
3.Padidinkite mastelį ir sureguliuokite orientacinius motyvus, kad pasiekti norimą efektą. 

*Naudokite viršutinį orientacinį motyvą, kad pakeisti eilučių intervalą, eilučių poslinkį ir kad pakeisti 
motyvų mastelį. 
*Vidurinį orientacinį motyvą naudokite, kad perkelti, pasukti, pakreipti motyvus ir pakeisti motyvų 
mastelį. 
*Kraštinį orientacinį motyvą naudokite, pakeisti stulpelių intervalą ir pakeisti motyvų mastelį. 
 
  Mastelis keičiasi proporcingai 
 
     Mastelis keičiasi horizontaliai 
 
  Mastelis keičiasi vertikaliai 

 
*Pasukite motyvus, du kartus spragtelėję ant vidurinio orientacinio motyvo, kad atsirastų sukimo 
valdymo rankenėlės. Spragtelėkite į rankenėlės kampą ir tempkite, kad pasukti. 
*Pakreipkite motyvus, du kartus spragtelėję ant vidurinio orientacinio motyvo ir  tempkite kreipimo 
rankenėles. 
 
*Pakeiskite stulpelių intervalą, pasirinkę kraštinį orjentacinį motyvą ir tempdami jį į kairę arba į dešinę. 
 
     Pakeisti stulpelių intervalą. 
 
 
*Kakeiskite eolučių intervalą, pasirinkę viršutinį orientacinį motyvą ir tempdami jį aukštyn arba žemyn. 

 *Pakeiskite eilučių poslinkį, pasirinkę viršutinį orientacinį motyvą ir tempdami jį į kairę arba į dešinę. 
 
  
 
 
4.Spauskite Enter, kad užbaigti. 
Dydžio ir išdėstymo nustatymai, kuriuos jūs pasirinkote, tampa veikiančiais Motif Fill nustatymais. 
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11 Skyrius 
SIŪLŲ SPALVOS 
 
 
 
Projektavimo metu kiekvienam kuriamam objektui iš spalvyno Color Chart jūs pasirenkate siūlų spalvas. Nauji 
objektai projektuojami naudojantis pasirinkta spalva. DigitizerPro leidžia jums tvarkyti siūlų spalvas jūsų 
spalvyne Color Chart. Galima pasirinkti iš plataus diapazono komercinių siūlų spalvynų. DigitizerPro 
programoje jūs galite užduoti spalvą lankelio viduje, kad prisiderinti prie medžiagos, ant kurios planuojate 
siuvinėti, spalvos. Fono spalvos yra laikomos kaip piešinio detalėmis ir išsaugojamos kartu su piešiniu. 
 
Jums reikia nuspręsti, kiek skirtingų spalvų panaudoti siuvinėjimo sekoje.Projektavimo metu jūs pasirenkate 
siūlų spalvas iš spalvyno. Visuomet, kiek įmanoma, prastinkite piešinį, kad sumažinti spalvų kiekį.Visada 
pradėkite nuo galinių figūrų ir judėkite į priekį, sluoksnis po sluoksnio 
 
Šiame skyriuje aprašoma, kaip pasirinkti spalvas iš Color Chart ir kaip pakeisti fono spalvas lankelio viduje 
ir/arba išorėje. 
 
Siūlų spalvų tvarkymas 
Color Chart spalvyne yra iki 128 spalvinių mygtukų. Nauji objektai projektuojami, panaudojant veikiančias 
spalvas. Spalvas galite keisti prieš ir po projektavimo. DigitizerPro taip pat leidžia jums tvarkyti spalvas jūsų 
Color Chart spalvyne. Yra platus pasirinkimo diapazonas komercinių siūlų spalvynų. Spalvyne Color Chart 
galima sureguliuoti tikslų norimų spalvų skaičių. Jiegu reikia, galima pridėti papildomų spalvinių mygtukų. 
 
Patarimas  Kada jūs vieną piešinį įkeliate į kitą, du Color Chart spalvynai susilieja 
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Naujos spalvos pasirinkimas 
 Spragtelėkite Current Color (Digitize įrankių juosta), kad atidaryti spalvyną Color Chart. 
 
Programuojant naują objektą, programa automatiškai paima spalvą, kuri parinkta iš spalvyno Color Chart. Tai 
yra ‚veikianti‘ spalva. 
__________________________________ 
 
Kad parinkti veikiančią spalvą 
1.Atšaukti visus objektus. 
2.Įeiti į Color Chart vienu iš būdų: 
 *Spragtelėti ant Current Color piktogramos Digitize įrankių juostoje. 
 *Pasirinkti View>Color Chart , arba  
 *Spausti klavišų rinkinį Ctrl+R 
 
Pabandykite tai  Išskleisti, spragtelėti ir tempti Color Chart bet kurioje vietoje piešinio lango viduje. 
3.Pakabinti pelės žymeklį virš spalvos, kad pamatyti jos gamyklinį ženklą, kodą ir pavadinimą. 
 
 
 
4.Pasirinkite norimą spalvą 
Pastaroji taps veikiančiaja spalva. 
 
Pasirinktų objektų pespalvinimas 
Galite bet kada pakeisti spalvą viename arba daugiau objektų jūsų piešinyje. Su viena komanda galite pasirinkti 
visus objektus su vienoda spalva. Šią savybę naudokite, norėdami pakeisti spalvą visų objektų, kurie turi 
vienodą spalvą. Plačiau skaitykite pusl. 34 Peržiūrėjimas objektų su vienoda spalva. 
___________________________ 
 
Kad perspalvinti pasirinktus objektus 
1.Pasirinkite objektą (objektus), kurį norite perspalvinti. 
2.Pasirinkti spalvą iš Color Chart. 
Objektai pasirodis su nauja spalva. Veikianti spalva nepasikeis. 
 
 
 
Rankinis spavos keitimo būdas 
DigitizerPro EasyDesign leidžia jums pakeisti bet kurio pageidaujamo dygsnio spalvą. Bet kurios pasirinktos 
spalvos pakeitimas vyksta veikiančioje pelės žymeklio padėtyje. Tai ypač naudinga, dirbant su monogramomis 
arba kitokiais raidiniais objektais, įskaitant ir atskirus simbolius. Bet kuriuo metu galite pašalinti rankiniu būdu 
įvestus spalvų pakeitimus. Žr. taip pat pusl.178 Raidžių perspalvinimas ekrane. 
 
 
 
 
 
_____________________________________ 
 
Kad rankiniu būdu pakeisti spalvą 
1.Spauskite Esc, kad atšaukti visus pasirinktus objektus piešinyje ir išjunkite įrankį Stitch Select While 
Traveling. 
2.Naudokite bet kurį iš galimų keliavimo per piešinį įrankį pagal objektus arba spalvą. Plačiau žr.pusl.35 
Kelionė siuvinėjimo seka EasyDesign programoje. 
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3.Naudokite rodyklių klavišus, kad surasti objekto viduje atskirą dygsnį, kurio spalvą norite pakeisti. 
Plačiau žr.pusl.36 Kelionė pagal dygsnius. 
 
 
 
 
Pastaba  Kai keliaujate tiktai pagal objektus arba pagal spalvas, dygsnių žymeklis visuomet bus objekto 
pradžioje. Šiame taške įterpus rankinį spalvos pakeitimą, pasikeis spalva viso objekto. 
4.Pasirinkite norimą spalvą iš Color Chart. Spalvos pakeitimas įterpiamas dygsnių kursoriaus veikimo vietoje. 
 
 
 
 
5.Kartoti tiek kartų, kiek reikia. 
 
 
 
Pastaba  Edit>Remove Color Change komanda yra įjungta, kada dygsnių žymeklis patalpintas ant dygsnio, 
nešančio rankinį spalvos pakeitimą. Pasirinkus šią komandą, spalvos pakeitimas atšaukiamas. 
 
 Kelionė link spalvos keitimo  Pasirinkta Edit>Remove Color Change 
 
 
Pabandykite tai  Galima kitaip, pasirinkite visą objektą ir pasirinkite spalvą iš Color Chart. Visas objektas 
nusispalvina pasirinkta spalva. 
 
Siūlų spalvynų nustatymas 
DigitizerPro leidžia jums tvarkyti siūlų spalvas jūsų Color Chart paletėje. Pasirinkite vieną iš komercinių siūlų 
palečių. Pridėkite arba išimkite spalvas – jūs galite priskirti iki 128 spalvinių mygtukų. Suraskite ir surūšiuokite 
specifines spalvas su Color Code. Sureguliuokite tikslų reikalingų spalvų skaičių  - pavyzdžiui, jeigu jūs savo 
piešinyje naudojate tiktai 6 spalvas, apribokite rodomų spalvų skaičių Color Chart paletėje iki šešių. Jeigu 
reikia galite pridėti papildomų spalvinių mygtukų 
_____________________________________ 
 
Kad nustatyti siūlų spalvyną 
1.Įeiti į Thread Colors dialogą vienu iš būdų: 
 *Pasirinkti Setup>Thread Colors, arba 
 *Dešiniu spragtelėjimu ant spalvos Color Chart spalvyne. 
 
  Pasirinkti siūlų spalvyną 
 
   Pakeisti arba pridėti siūlų į paletę. 
 
2.Pasirinkti siūlų paletę iš Thread Chart išsiskleidusio sąrašo. 
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3.Patalpinkite norimą spalvą iš sąrašo. 
 
Pabandykite tai  jeigu jūs žinote ieškomos spalvos kodą, įveskite jį į Find Color  lauką.  
4.Panaudokite vieną mygtukų, kad perkelti pasirinktą spalvą į Color Palette. 

*Replace: spalva pakeis tuo metu pasirinktą spalvą Color Palette sąraše. Dvgubas spragtelėjimas ant 
siūlo Thread Chart sąraše, duos tą patį rezultatą. 
*Add: spalva bus pridėta į Color Palette sąrašą. Skaičius Number of Colors lauke automatiškai padidės 
vienetu. 

 
Pastaba  Jeigu veikiančiame piešinyje spalva Color Palette buvo panaudota viename arba daugiau objektų, tai 
spalvos lauko centre Color Palette sąraše bus rodoma ‚varnelė‘. 
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III Dalis 
 
PIEŠINIŲ PROGRAMAVIMAS SU ILIUSTRACIJOMIS 
 
 
 
 
 
Yra dvi stambios iliustracijų failų kategorijos, kuriuos galima importuoti į EasyDesign ir panaudoti kaip 
projektinę dekoraciją – t.y. vector ir bitmap failai. Kad sukurti geros kokybės siuvinėjimo piešinį, jums reikia 
pasirinkti arba sukurti tinkamą iliustraciją arba formatuoti. 
 
Projektavimas su dekoracijomis 
Šiame skyriuje aprašyta, kaip nuskenuoti vaizdą į DigitizerPro ir redaguoti jį prieš panaudojant kaip dekoraciją. 
Taip pat aprašoma, kaip įkelti į DigitizerPro ir išsaugoti vaizdus, taip pat, kaip parodyti ir paslėpti juos 
projektavimo metu. Vaizdų redagavimas išorinėse grafinėse programose taip pat paliestas. Plačiau skaitykite 
pusl.85 Projektavimas su dekoracijomis. 
 
Vaizdų paruošimas automatiniam projektavimui 
Šiame skyriuje aprašyta, kaip paruošti automatiniam projektavimui vaizdus su apibrėžtais kontūrais ir be jų. 
Plačiau skaitykite pusl.93 Vaizdų paruošimas automatiniam projektavimui. 
 
Automatinis projektavimas 
Šiame skyrius aprašyta kaip bitmap vaizdus automatiškai paversti į siuvinėjimo objektus ir užbaigti piešinius, 
taip pat, kaip sukurti siuvinėjimo piešinius iš juodai baltų vaizdų. Plačiau skaitykite pusl.101 Automatinis 
projektavimas. 
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12 Skyrius 
PIEŠINIŲ PROJEKTAVIMAS SU DEKORACIJOMIS 
 
 
Iliustraciją galima įterpti, įkelti arba nuskenuoti į DigitizerPro, kaip projektavimo šablonus arba ‚dekoracijas‘. 
 
Šiame skyriuje aprašyta, kaip nuskenuoti vaizdą į DigitizerPro ir redaguoti jį prieš panaudojant kaip dekoraciją. 
Taip pat aprašoma, kaip įkelti į DigitizerPro ir išsaugoti vaizdus, taip pat, kaip parodyti ir paslėpti juos 
projektavimo metu. Vaizdų redagavimas išorinėse grafinėse programose taip pat paliestas. 
 
 
Dekoracijos gali pagelbėti jums: 
 *Piešti figūras rankiniu būdu 

Jūs galite prasekti figūras ir linijas ant iliustracijos, panaudojant atitinkamus įvedimo metodus. Tokiu būdu, 
Bitmap vaizdo panaudojimas čia yra panašus į padidintą piešinį ir digitaizerio lentą, išskyrus tai, kad viskas 
yra padaryta ekrane. Plačiau skaitykite pusl.57 Projektavimo vadovas. 
*Automatiškai sukurti figūras, panaudojant Click-to-Stitch (Spragtelėti į dygsnius). 
Jūs pasirenkate figūrą ir Click-to-Stitch automatiškai nustato reikalingus dygsnius. Plačiau skaitykite 
pusl.104 Automatinis vaizdų projektavimas su Click-to-Design. 
*Pilnai automatiškai užbaigti piešinio projektavimą su Click-to-Design. 
Jūs pasirenkate vaizdą ir Click-to-Design automatiškai nustato figūras ir reikalingus dygsnius, kad 
suprojektuoti piešinį. Plačiau skaitykite pusl. 104 Siuvinėjimo piešinių sudarymas su Click-to-Design 
Advanced. 

Iš DigitizerPro jūs galite atidaryti vaizdus tokiose programose kaip Paint, Corel PhotoPaint arba  Paint Shop 
Pro. Tokiu būdu atnaujinti vaizdai automatiškai iš naujo importuojami į DigitizerPro. 
 
Tinkamos iliustracijos pasirinkimas 
Rankiniam ir automatiniam projektavimui geriausia vaizdus ‚apvalyti‘, kartais primena ‚animaciją‘. Tokie 
vaizdai turi ribotą skaičių ištisinių spalvų, turinčių gerai apibrėžtus kontūrus. Idealiu atveju jie atrodo taip: 
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 *gerai apibrėžti, kur kiekviena figūra sudaryta iš vienodos spalvos vaizdo taškelių (pixel). 
 *aiškiai ;blokuotas‘, kur kiekviena figūra siuvinėjamo dydžio, mažiausiai 1kvadr.mm. 

*išsaugotas mažiausiai 256 spalvų spalviniame gylyje (8bit) arba geriausiai milijonai spalvų (16 bit). 
(Vaizdai  automatiškai sumažinami iki 256 spalvų arba mažiau, importavus juos į DigitizerPro) 

 
 
      Apvalyti piešinį iki gerai apibrėžtų kontūrų 
 
      Apvalyti piešinį iki gerai apibrėžtų spalvų blokų 
 
      Sudėtingas piešinys, reikalinga redaguoti, kad pašalinti  
      foną ir apvalyti spalvinius blokus. 
 
DigitizerPro automatinio projektavimo būdai - Click-to-Design  ir Click-to-Stitch  - sukuria geriausius 
rezultatus su vaizdais, kurie randami meninių vaizdų elektroninėse bibliotekose arba sukuriami iš eskizų, 
randamų grafinėse programose. Automatinis projektavimas gali veikti su vaizdais ir iš kitų šaltinių, tačiau jiems 
būtinas paruošimas. Tai yra todėl, kad dauguma galimų vaizdų yra sudaryti ne  iš ištisinių spalvų. Skeneriai 
įveda triukšmus, tuo tarpu grafinės programos įveda ‚dithering‘ (‚virpėjimą‘) ir ‚anti-aliasing‘(anti-aljanso), kad 
pagerinti vaizdų spausdinimo kokybę. 
 
Automatinis projektavimas prasčiausiai veikia su foto vaizdais, kuriuose gali būti daug ‚virpančių‘ spalvų ir 
sudėtingų formų. Tačiau iš fotografijų jūs galite paimti figūras, kurias norėtumete išsiuvinėti, pašalinus 
nereikalingas detales. 
 
Skenuoti vaizdai 
Skenuoti vaizdai iš kopijuotų piešinių arba egzistuojančių siuvinėjimo piešinių paprastai turi savyje daug 
‚triukšmo‘. Tačiau juos dar kartą galima panaudoti automatiniam projektavimui, bet geriausių rezultatų 
pasiekiama su santykinai švariais vaizdais, sisidedančiais iš ištisinių spalvinių blokų. Paprastai, logo ir paprasti 
piešiniai nuskenuoti iš vizitinių kortelių, firminių blankų, knygų, atvirukų priskiriami šiai kategorijai. 
     Vaizde yra daug skenavimo ‚triukšmo‘ 
 
Triukšmingiems piešiniams paprastai reikia paruošimo, sumažinti spalvų kiekį ir kontūro aštrumą. Plačiau 
skaitykite pusl. 94 Vaizdų paruošimo būdai.  
 
Vaizdai su ‚virpėjimu‘ 
‚Virpėjimas‘ yra programinis būdas, kuris pateikia egzistuojančias spalvas spalviniais taškeliais išdėstytais 
šachmatine tvarka. Jis paprastai naudojamas, kad imituoti spalvas, kurių nėra vaizdo paletėje.  
 
      ‚Virpėjimo‘ spalvų blokai 
 
 
Kaip ir triukšmingus vaizdus, taip ir vaizdus su ‚virpėjimu‘ prieš naudojimą būtina apvalyti, mažinant spalvų 
kiekį. Atkreipkite dėmesį, kad programinė įranga puikiai apdoroja ‚virpėjimo‘ spalvas viduje apibrėžtų kontūrų, 
tačiau ji ne taip gerai veikia, jei vaizdas neturi apibrėžto kontūro. Plačiau skaitykite pusl. 93 Vaizdų paruošimas 
automatiniam projektavimui.  
 
‚Anti-aljanso‘ vaizdai 
‚Anti-aliasing‘ yra programinis būdas panašus į ‚virpėjimo‘ būdą. Jis naudojamas sušvelninti ryškius kontūrus, 
kur susikerta spalvų blokai. Spalvų susidūrimo vietose, jis sukuria švelnesnius kontūrus, išsklaidant spalvinius 
taškelius. 
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  Kontūrai su išsklaidytais spalviniais taškeliais 
 
 
 
Ten, kur sąmoningai panaudotas ‚anti-aliasing‘ būdas sušvelninti kontūrus, prieš panaudojant atomatinį 
projektavimo būdą, tas vietas reikia ‚užaštrinti‘.Plačiau skaitykite pusl. 93 Vaizdų paruošimas automatiniam 
projektavimui.  
 
Iliustracijų skenavimas į DigitizerPro 
Jeigu turite iliustraciją, tai su TWAIN-suderinamu skeneriu, panaudojant DigitizerPro skenavimo funkciją, 
galite ją nuskenuoti. Labai svarbu tinkamai nuskenuoti jūsų iliustraciją, jeigu ruošiatės panaudoti vieną iš 
automatinių projektavimo būdų; nuskenuoto vaizdo kokybė turės įtaką į galutinio išsiuvinėto piešinio kokybei. 
 
Iliustracijos paruošimas skenavimui 
Siuvinėjimo piešiniams, kuo mažiau tuo daugiau. Jum nereikia visų detalių atkurti piešinyje. Jūs labiau 
panaudokite vaizdo ‚struktūrą‘ negu smulkias tekstūros ir spalvines detales. Kad supaprastinti iliustraciją, galite 
uždengti ją kopijavimo popieriumi ir ant jo nupiešti tiktai pagindines figūras ir linijas, kurios bus užpildytos su 
dygsniais. Skanuojant, iliustracijos originalą padėkite į šalį, o kitoje kopijavimo popieriaus pusėje paklokite 
švarų baltą popierių. Blizgūs paviršiai, kaip glencuotos fotografijos, gali blogai nusiskenuoti. Uždenkite juos 
kopijavimo popieriumi. Jeigu iliustracijoje yra labai šviesių spalvų, paryškinkite kontūrus su plonu juodu 
flamasteriu. 
 
Skenavimo skiriamoji geba 
Dauguma skenerių paprašys jūsų įvesti informaciją apie skenavimo skiriamąją gebą. Skiriamoji geba reiškia 
taškelių skaičių per colį (dpi), naudojamų piešinio sukūrimui. Kuo reikšmė didesnė, tuo vaizdas aiškesnis, 
tačiau jo failas yra didesnis. Projektavimui naudokite maksimalią skiriamąją gebą 300 dpi (taškų per colį). 
Dažnai pakankama skiriamoji geba (ekrano) yra 72 dpi. Bendrai kalbant, kuo mažesnis vaizdo šaltinis ir/arba 
daugiau detalių jame yra, tuo turi būti didesnė skiriamoji geba. Naudokitės šia lentele: 
 
Ilioustracijos tipas Skenavimo skiriamoji geba 
Vizitinės kortelės, firminiai blankai 150-300 dpi 
Rankiniai eskizai 150-300dpi 
Fotografijos ir paveikslai 150-300dpi 
Komercinis menas, linijų piešiniai 72-150dpi 
 
Spalvinis režimas 
Dauguma skenerių paprašys jūsų įvesti informaciją apie spalvų režimą. Pirmiausiai, nuspręskite ar jūsų 
paveiklas yra meninis piešinys iš linijų (juodas ir baltas piešinys), eskizas, spalvotas paveikslas ar juodai balta 
ar spalvota fotografija, tuomet pasirinkite tinkamiausią režimą.  Juodai baltas režimas sukuria mažiausius failus. 
Spalvotos fotografijos ir pilkos skalės režimai generuoja 256 spalvų vaizdus ir sudaro panašius failus. ‚RGB‘, 
‚True Color‘ arba ‚milijonai spalvų‘ režimai generuoja 16.7 milijonų spalvų ir sudaro didžiausius fialus. 
Naudokite lentelę, žemiau, kad nuspręsti, kuris režimas yra tinkamiausias jūsų piešiniui. 
Vaizdo šaltinis Pavyzdys Aprašymas Rekomenduojamas 

spalvos režimas 
Spalvų kiekis 

Meninis piešinys iš 
linijų 

 Paprastai dvi spalvos, 
juoda ir balta 

Black/white drawing 
Line art 

2 
2 

Piešinys  Eskizas arba piešinys 
su pilkais atspalviais 

Grayscale  
Line art 

256 
2 

Spalvotas 
paveiksliukas 

 Dvi arba  
Daugiau spalvų 

Color 
RGB 
Milijonai spalvų 
Spalvotas piešinys 

16 
milijonas 
16 
2-256 

*Skirtingos skenavimo programos naudoja skirtingą tų pačių režimų terminologiją. 
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Skenavimo patarimai 
Čia pateikiame patarimų skenuojant iliustracijas, kurios naudotinos piešinių projektavimui. 

*Neskenuokite linijinių meninių paveiksliukų grayscale režime; grayscale skenavimas sukuria pašiauštus  
kraštus. 
*Skenuokite spalvotus paveiksliukus RGB režime (milijonai spalvų), geriau negu 256 spalvų režime. 
Ekrane jūs galite nepastebėti skirtumo. Faktiškai 256 spalvų vaizdas gali atrodyti geriau negu RGB vaizdas. 
Tačiau DigitizerPro visus vaizdus verčia į 256 spalvas arba mažiau priklausomai nuo vaizdo. Ji naudoja 
papildomą informaciją, kad sukurti geresnį vaizdą už tą, kuris būtų nuskenuotas prie 256 spalvų. 
 
       Nuskenuotas 256 spalvų režime 
 
 
 
Nuskenuotas RGB spalvų režime (milijonai spalvų) 
 
 
*Neskenuokite spalvotų paveksliukų CMYK režime, kadangi pastarasis naudojamas vaizdams, kurie 
numatyti spausdinami, ir spalvos gali skirtis nuo RGB spalvų. 
*Jeigu paveiksliukui reikia pakeisti matmenis, pakeiskite mastelį skenavimo metu. Vėlesnis mastelio 
keitimas gali iškreipti vaizdą. 
 
Paryškinimas  
Kai kurios skenavimo programos leidžia jums skenavimo metu taikyti funkciją ‚sharpening‘ (paryškinimas). 
Ši funkcija truputį paryškina nuskenuotą vaizdą, stebint skirtumus tarp spalvų. Ji paryškina tuos skirtumus, 
kurie daro vaizdo kraštus labiau apibrėžtus. Paryškinimo funkcija nepadidina vaizdo detalių; ji daro jas 
aiškesnėmis.Bendrai, naudokite paryškinimą su vaizdais, kurie turi gerai apibrėžtus kontūrus. Nenaudokite 
vaizdams be kontūrų. 
 
  Nuskenuota su paryškinimu 
 
        Nuskenuota be paryškinimo 
 
 
Vaizdų importavimas į DigitizerPro 
 

Bitmap vaizdus į DigitizerPro galima įterpti, įkelti arba nuskenuoti ir panaudoti tolimesniam projektavimui. 
Tiek rankiniam tiek automatiniam projektavimui ‚apvalyti‘ vaizdai, kartais panašiai kaip ‚animacija‘, veikia 
geriausiai. Skeneriai įveda triukšmus, tuo tarpu grafinės programos įveda ‚dithering‘ (‚virpėjimą‘) ir ‚anti-
aliasing‘(anti-aljanso), kad pagerinti vaizdų spausdinimo kokybę. Plačiau skaitykite pusl. 93 Vaizdų 
paruošimas automatiniam projektavimui.  
 
 
 
 
 
Prasektas skenuotas vaizdas      Automatiškai projektuotas 
 
 
Patarimas  Galite keisti mastelį ir transformuoti vaizdus po importo, tačiau, bendrai, geriau tai daryti 
skenavimo metu. Keičiant mastelį vėliau, galima iškreipti vaizdą. 
 
Vaizdų įterpimas 
Naudokite Insert Image (Image meniu), kad įterpti vaizdą ir panaudoti jį kaip pagrindą projektavimui. 
 
Galite įkrauti skirtingų formatą bitmap vaizdus, kad panaudoti juos kaip pagrindą projektavimui. Žr. taip pat 
pusl.85 Tinkamos iliustracijos pasirinkimas. 
 
 
 
Bitmap vaizdą galima panaudoti kaip pagrindą projektavimui 
            Dalinai apdorotas bitmap vaizdas 
              
 
Pastaba  Vector tipo piešiniai, įkraunant juos į DigitizerPro, paverčiami į bitmap vaizdus. w
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Kad įterpti vaizdą 
1.Pasirinkti Image>Insert Image. 
Atsidaro Open dialogas. 
 
  Pasirinkti bylą 
 
 
 
 
    Pasirinkti reikalingą formatą 
 
2.Pasirinkti bylą iš sąrašo Look In. 
3.Pasirinkti failo formatą iš sąrašo Type of Files. 
4.Pasirinkti failo tipą, kurį norėsite įterpti. 
5.Spragtelėkite Open. 
 
 
Pabandykite tai  Pasirinkite Preview kontrolinį langelį, kad pamatyti pasirinkto failo vaizdą. 
 
Vaizdų kopijavimas ir įkėlimas  
  Spragtelėti Paste (standartinių įrankių juosta), kad įkelti vaizdo kopiją į piešinį. 
 
Galite kopijuoti ir įkelti vaizdą į EasyDesign, kopijuodami jį iš kito siuvinėjimo piešinio arba grafinio vaizdo ir 
įkeliant jį į jūsų piešinį. 
 
Pastaba  Negalima kopijuoti ir įkelti vaizdą į EasyEdit. 
_______________________________________ 
 
Kad kopijuoti ir įkelti vaizdą 
1.Pasirinkite vaizdą, kurį norite kopijuoti ir įkelti. 
2.Paspaudę Ctrl+C, kopijuokite jį Windows buferinę atmintį. 
3.Sukurkite naują failą programoje EasyDesign arba atidarykite piešinio failą, į kurį norite įkelti piešinį. 
4.Spragtelėti ant Paste piktogramos arba spauskite Ctrl+V. 
Vaizdas įkeltas piešinyje. 
 
 
 
 
Pastaba  Jums reikia pakeisti vaizdo matmenis, kad jis tilptų lankelio viduje. Plačiau skaitykite pusl.122 
Objektų mastelio keitimas, panaudojant Object Details. Žr.taip pat Vaizdų redagavimas grafikoje. 
 
Bitmap vaizdų skenavimas 
Naudokite Scan (Image meniu), kad nuskenuoti vaizdą į DigitizerPro. 
 
Galite nuskenuoti vaizdus tiesiai į DigitizerPro, kad panaudoti jį kaip pagrindą projektavimui. DigitizerPro 
skenavimo savybė labiausiai leidžia jums naudoti TWAIN suderinamus skenerius. Jūs galite panaudoti bet 
kurią skenavimo programinę įrangą, kuri pajėgi būtų išsaugoti vaizdą viename iš suderinamų formatų. Žr.taip 
pat pusl. 87 Iliustracijų skenavimas į DigitizerPro. 
_______________________________________ 
 
Kad skanuoti bitmap vaizdą 
1.Nustatykite savo skenerį. Žr.taip pat pusl.6  Skenerių nustatymas. 
2.Paruoškite iliustraciją skenavimui. Plačiau skaitykite pusl.87 Iliustracijų paruošimas skenavimui. 
3.Paleiskite DigitizerPro. 
4.Sukurkite naują failą arba atidarykite piešinį, į kurį norite įterpti vaizdą. 
5.Pasirinkite Image>Scan. 
Atsidaro jūsų skenavimo programa. 
6.Pasirinkite skenavimo režimą ir skiriamąją gebą. 
Plačiau skaitykite pusl. 87 Skenavimo skiriamoji geba ir Spalvų režimas. 
7.Peržiūrėkite vaizdą skenavimo programoje. w
w
w
.V
isk
as
Si
uv
im
ui
.lt
 



90 
8.Pasirinkite vaizdo plotą, kurį būtina skenuoti. 
9.Skenuoti iliustraciją 
10.Išsaugoti skenuotą vaizdą trečios grupės programoje. 
Pačiau, žr. pusl.91 Vaizdų ir grafikos redagavimas. 
Išsaugokite suderinamo formato vaizdo faile į C:\Embroidery Album bylą. 
 
Importuotų vaizdų redagavimas 
Rankiniam ir automatiniam projektavimui, galbūt prieš projektavimą jums prireiks apkarpyti vaizdą. Jūs tai 
galite atlikti DigitizerPro viduje  arba trečios grupės grafikos programoje. Kartais, jūs galite panorėti išsaugoti 
bazinius vaizdus, kaip atskirus failus, po skenavimo arba apkarpymo. 
 
Vaizdų apkarpymas projektavimui 
Naudokite Crop Image (Image meniu), kad apkarpyti vaizdą naudojimui su Photo Click. 
 
DigitizerPro leidžia jums apkarpyti vaizdus iki panaudojimo. Prie panaudojimą bitmap vaizdų siuvinėjimo 
piešinių projektavimui, apkarpykite juos, kad pašalinti nereikalingas detales ir sutaupyti laiko redagavimui. Ši 
savybė pirmiausiai skirta naudojimui su Photo Click įrankiu. Plačiau skaitykite pusl.106 Siuvinėjimo piešinių 
sukūrimas iš fotografijų. 
 
Perspėjimas  Photo Click įrankis su apkarpytais vaizdais sukuria dygsnius tiktai matomuose vaizdo plotuose. 
Tačiau, apkarpyti vaizdai gali duoti  netikėtus rezultatus, panaudojus Click-to Stitch arba Click-to-Design 
įrankius. Šiuo atveju, sprendimas yra redaguoti vaizdą trečios grupės grafinėje programoje ir kartu pašalinti 
nepageidaujamus vaizdo plotus. Plačiau skaitykite pusl. 91 Vaizdų ir grafikos redagavimo programos. 
____________________________________ 
 
Kad apkarpyti vaizdą projektavimui 
1.Nuskenuokite arba įkraukite norimą vaizdą. Žr. pusl.88 Vaizdų importas į DigitizerPro. 
2.Pasirinkite vaizdą ir apkarpymo įrankį: 

*Pasirinkite Image>Crop Image>Rectangle, spagtelėkite ir tempkite ribojantį rėmelį aplink apkarpomą 
plotą. 
 
 
 
 
 
*Pasirinkite Image>Crop Image>Freehand Shape ir pažymėkite bazinius taškus, kad apkarpyti laisva 
forma, panaudojant dešinį ir kairį spragtelėjimus. 
 
 
 
 
 
DigitizerPro apkerpa plotą, esantį viduje pasirinkto ploto. 
 
Apkirptų vaizdų formos keitimas 
  Spragtelėti Reshape (Edit įrankių juostoje), kad parodyti apkarpytų plotų kontrolinius taškus. 

 
Kai vaizdas jau apkarpytas, jūs galite pakeisti jo formą ir transformuoti kirpimo kontūrus tokiu pat būdu kaip 
jūs keičiate formą ir transformuojate raidinius objektus. Jūs taip pat galite panaudoti įrankį, kad pakeisti 
kirpimo kontūrų vietą. 
________________________ 
 
Kad pakeisti apkarpytų vaizdų formą. 
1.Apkirpkite vaizdą. Žr. pusl.90 Vaizdų apkarpymas projektavimui. 
2.Pasirinkite apkarpytą vaizdą. 
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3.Spragtelėkite Reshape object piktogramą. 
Kirpimo linija pasirodis su formos ketimo taškais. 
 
 
 
 
Pabandykite tai  Pasipraktikuokite su matmenų valdymo rankenėlėmis, pakreipimo ir pasukimo rankenėlėmis. 
Pastebėsite, kad sukimo ašies negalima perkelti. Žr.taip pat pusl.119 Objektų tvarkymas ir transformavimas. 
4.Sureguliuokite formavimo mazgus, kad pakeisti formą. 
 
 
 
 
Pastaba  Formavimo mazgų negalima ištrinti, pridėti arba sukeisti tarp kampinių ir apskritimo taškų. Žr.taip 
pat pusl.126 Objektų formos keitimas. 
5.Spausti Esc, kad užbaigti 
 
Vaizdų redagavimas grafinėse programose. 
Naudokite Touch Up Picture (Image meniu), kad redaguoti vaizdus grafinėse programose. 
 
Kartais jums gali prireikti redaguoti tiesiog trečios grupės grafinėse programose. Normaliai, jūs tai atliekate, 
kad pašalinti fonus, uždažyti atskirus plotus su ištisine spalva arba pridėti kontūrus, uždengti tarpus arba 
sustiprinti kontūrus. Iš DigitizerPro vidaus galite atidaryti vaizdus tiesiogiai programose Paint, Photo paint 
arba Paint Shop Pro ir juos atnaujinti. Atnaujinti tokiu būdu vaizdai iš naujo importuojami į DigitizerPro. 
 
 
 
 
 
 
Yra daug įvairių grafinių programų, kurios gali pagelbėti jums, tobulinant jūsų nuskenuotus vaizdus. Tokių 
programų spektro gale yra paprasta programa Paint. Ji nemokamai komplektuojama su Windows, tačiau gali 
palaikyti keletą formatų, atlikti spalvų pakeitimus. Kitame gale, profesionalųs įrankiai, kaip Photoshop. Tokios 
programos gali atlikti bet ką, tačiau jos galbūt perdaug brangios atsitiktiniam naudojimui. Kompromisas yra 
programa Paint Shop, kuri turi daug galimybių turinčių galingų įrankių, tačiau žemesne kaina. 
________________________________ 
 
Kad redaguoti vaizdus grafinėse programose 
1.Pasirinkite Image>Insert Image, kad įkrauti vaizdą. 
2.Pasirinkite vaizdą 
 
  Galima pavalyti foną , paredaguoti akių kontūrus ir ragus. 
 
 3.Pasirinkite Image>Touch Up Picture ir pasirinkite grafinę programą. 
Vaizdas atsidarys grafinėje programoje. 
4.Redaguokite vaizdą ir po to išsaugokite. 
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  Fonas išvalytas, akys turi kontūrus 
 
5.Pasirinkite File>Update<Filename>. (Atnaujinti failo vardą) 
Vaizdas pasirodis DigitizerPro langelyje su juostelėmis. Tai reiškia, kad jis dar atidarytas grafinėje programoje. 
 
    Failas dar atidarytas grafinėje programoje 
 
 
Pabandykite tai  Pasirinkite File>Exit&Return<Filename> , kad išeiti iš grafinės programos ir parodyti 
atnaujintą vaizdą DigitizerPro programoje. Juostelės išnyks. 
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14 Skyrius 
 
 
VAIZDŲ PARUOŠIMAS AUTOMATINIAM PROJEKTAVIMUI 
 
 
 
DigitizerPro palaiko automatinį ir pusiau automatinį bitmap vaizdų ir vector piešinių projektavimą. Gatavų 
piešinių kokybė smarkiai priklauso nuo originalių iliustracijų kokybės. Bendrai kalbant, vector piešiniai išlaiko 
paveiksliuko kokybę, keičiant jų matmenis, tuo tarpu, didinant ar mažinant bitmap vaizdus, pablogėja jų 
kokybė, pakinta spalvinių taškų kiekis. Tačiau, kiekvienas būtinas mastelio keitimas  turi būti atliekamas prieš 
vaizdo importą į EasyDesign, kadangi importo operacija automatiškai vector piešinius transformuoja į bitmap 
vaizdus. Kad bitmap vaizdus geriau paruošti automatiniam projektavimui, DigitizerPro taip pat užtikrina vaizdo 
apdorojimo galimybes ir ryšį su grafinėmis programomis. 
 
Šiame skyriuje aprašyta, kaip paruošti vaizdus su kontūrais ir be kontūrų automatiniam projektavimui. 
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Vaizdų paruošimo būdai 
 
Iki automatinio projektavimo taikymo jums dažnai reikės patobulinti arba ‚apvalyti‘ iliustraciją. Efektyviam 
darbui, tiek Click –toDesign tiek Click –to-Stitch reikia įvesti vaizdus su ištisinėmis spalvomis. Jūs galite 
iliustracijas tobulinti tiek su bitmap redagavimo įrankiais grafinėse pakuotėse tiek su vaizdų apdorojimo 
įrankiais pačioje programoje DigitizerPro. Ištikrųjų, DigitizerPro neleis jums taikyti Click-to-Design, kol 
tinkamai neapdorosite vaizdo, t.y. neparuošite jo automatiniam projektavimui. 
 
Vaizdų apvedžiojimas kontūrais 
 
Prieš paruošimą reikia įvertinti kokį vaizdo tipą jūs naudojate, ar kontūru ar be jo. Idealiai, vaizdai su kontūrais 
turi ištisines  juodas linijas apibrėžtas aplink kiekvieną nuspalvintą plotą. Bekontūriniai vaizdai, idealiai, 
sudaryti iš ištisinių spalvotų plotų. Kontūriniams ir bekontūriniams vaizdams reikalingi skirtingi paruošimo 
būdai. 
 
       Vaizdas be kontūrų 
 
 
    Vaizdas su kontūrais 
 
Vaizdų apvalymas 
Praktikoje skenuotų vaizdų valymui gali prireikti bet kurio vieno arba kelių žemiau išvardintų būdų: 
 *spalvų skaičiaus mažinimas 
 *pridėti arba paryškinti kontūrus 
 *pašalinti triukšmą, virpėjimą arba antialjansavimą 
 *pašalinti nebūtinas detales 
 *apkarpyti dalis 

*pašalinti fonus 
Žr.taip pat pusl.85 Tinkamos iliustracijos pasirinkimas. 
 
Spalvų mažinimas 
Kartais vaizdas atrodo švarus, tačiau skenavimo metu arba grafinėje programoje jis galimai pasipildė 
pašalinėmis spalvomis. Spalvų sumažinimas reiškia realių spalvų skaičiaus sumažinimą, kad pašalinti nebūtinas 
detales ir sumažinti kiekvieną bloką iki vienetinės spalvos. Spalvų mažinimas taip pat reiškia vaizdo valymą, 
triukšmo ir aljansavimo (jeigu yra) šalinimą. Tai tai pat padeda sumažinti siūlo nukirpimo ir spalvų 
persijungimo skaičių, reikalingų piešinio siuvinėjimo metu. Mažinant spalvų kiekį  nekontūriniuose vaizduose, 
naudokite Image Preparation įrankį, o kontūriniuose – Outlined Image Preparation įrankį. 
 
Spalvų mažinima reikia taikyti tiktai, jeigu detalių pašalinimas nepaveiks figūros vaizdo. Iki spalvų 
sumažinimo,  nuspalvinti plotai, žr.paveiksliuką pavaizduotame žemiau, apima daug spalvų. Po sumažinimo, 
kiekvienas plotas turi tik po vieną spalvą. Detalė yra išsaugota. 
 
 
 
 
 Vaizdas iki spalvų mažinimo      Vaizdas po spalvų mažinimo. 
 
 
Skenuodami vaizdus įsitikinkite, kad tai atliekate teisingai, kad pasiekti geriausio rezultato. Žr.taip pat pusl.87 
Iliustracijų skenavimas į DigitizerPro. 
 
 
 
 Vaizdas nuskenuotas RGB spalvų režime,   Vaizdas nuskenuotas 256 spalvų režime,    

tada spalvų sumažinta iki 8.      tada spalvų sumažinta iki 8. 
 
 
Žinokite, kad įrankis Image Preparation yra geras pašalinti triukšmą ir antialjansą, tačiau nėra geras, apdorojant 
‚virpėjimą‘ ir nekontūrinius vaizdus. Priešingai, įrankis Outlined Image Preparation yra puikus apdorojant 
virpėjimo spalvas, kadangi jis apibrėžto kontūro viduje sulygina spalvinius taškus.Žr.taip pat pusl.88 Vaizdų 
įterpimas. w
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Image Preparatio įrankis panaudotas su bekontūriniu vaizdu,- virpėjimas spalvų blokuose nevisiškai pašalintas, kraštai pašiaušti (neryškūs). 
 
 
 
 
 
 
 
Outlined Image Preparation įrankis panaudotas su kontūriniu vaizdu, - virpėjimas spalvų blokuose išvalytas, kraštai ryškūs. 
 
Kontūrų paryškinimas 
Kontūrų ryškinimas siuvinėjimo piešinyje reiškia aiškiau apibrėžti ribojančius kontūrus tarp spalvų blokų arba 
figūrų. Jie neryškūs galėjo būti originale arba galėti nublankti skenavimo metu. Kontūrų ryškinimas yra svarbus 
automatiniam projektavimui, kadangi programai yra lengviau atpažinti skirtingus plotus, kurie pabaigoje tampa 
piešinio siuvinėjimo opbjektais. 
 
Pastaba  Kontūro ryškinimas veikia tiktai vaizduose su juodais arba tamsiais kontūrais. 
 
     Vaizdas prieš kontūro paryškinimą 
 
 
 
  Vaizdas po kontūro paryškinimo 
 
Kai kurie vaizdai turi ištisinius kontūrus, tačiau neryškius arba neužbaigtus. Tokius kontūrus reikia išlyginti su 
DigitizerPro vaizdų paruošimo įrankiais arba grafinėse programose. Plačiau skaitykite pusl.91 Vaizdų 
redagavimas grafinėse programose. 
 
Triukšmo filtravimas 
Triukšmo filtravimas reiškia originalių vaizdų ištisinių spalvinių blokų atgaminimą skenuotuose vaizduose. Tai 
pasiekiama suliejus skirtingus atspalvius į vieną ištisą spalvą. Triukšmo filtravimas yra svarbus automatiniam 
projektavimui, kadangi, tai atlikus, programai yra lengviau atpažinti ištisinių spalvų blokus, kurie pabaigoje 
tampa piešinio siuvinėjimo opbjektais. Jis taip pat apvalo vaizdą nuo neryškių arba dėmėtų plotų. 
 
 
 
 
 
Vaizdas iki triukšmo filtravimo, spalva dėmėta    Vaizdas po triukšmo filtravimo, viena spalva 
 
Vaizdo paruošimo įrankiai 
 
Vaizdo paruošimui automatiniam projektavimui naudokite vaizdo paruošimo įrankius. Jūsų pasirinktas įrankis 
priklauso nuo vaizdo. Yra trys įrankiai: 
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Įrankis Paskirtis Galimybės 
Edit Image Ryšiui su grafine programa – pavyzdžiui, Paint 

Shop Pro – vaizdo redagavimui už Digitizer ribų 
Leidžia apkarpyti, paryškinti, pakeisti spalvą, pridėti kontūrus, 
pašalinti triukšmą ir vaizdo 

Image 
Preparation 

Paruošti bet kurį bekontūrinį vaizdą Leidžia sumažinti spalvų, iki nurodyto skaičiaus. Automatiškai: 
 *sumažina kiekvieną bloką iki vienos spalvos 
 *pašalina ‚antialjansą‘, triukšmą ir ‚virpėjimą‘ 
 *pašalina spalvas, kurių plotas mažesnis už nurodytą 

Outlined 
Image 
Preparation 

Paruošia kontūrinius vaizdus Leidžia reguliuoti kontūrų šviesumą arba tamsumą. Automatiškai: 
 *kiekvieną kontūru apibrėžtą bloką paverčia vienspalviu 
 * pašalina ‚antialjansą‘, triukšmą ir ‚virpėjimą‘ 
 *paryškina  kontūrus 

 
Pastaba  Netgi, jeigu jūsų vaizdas atrodo paruoštas siuvinėjimui, įkėlus jį į programą, jam vistiek reikia 
paruošimo prieš transformaciją. Programa neleis jums taikyti automatinio programavimo metodų, neatlikus 
preliminarinio vaizdo apdorojimo. 
 
Vaizdo paruošimo įrankių panaudojimas 
Yra svarbu jūsų vaizdui panaudoti teisingą paruošimo įrankį. Pavyzdyje žemiau parodytas vaizdas su neryškiais 
kontūrais. Jeigu panaudoti įrankį Outlined Image Preparation, kontūrus galima būtų patamsinti ir paryškinti, 
kad pagerinti siuvinėjimą. Kitu būdu, prieš siuvinėjimą panaudojus įrankį Image Preparation, paveiksliukas 
gausis prastai išsiuvinėtas. 
 
    Panaudotas Image Preparation-kontūrai neišryškinti, 
    siuvinėjimas prastas 
 
 
Vaizdas su neryškiais kontūrais 
 
 
    Panaudotas Outlined Image Preparation-  
    siuvinėjimas geras 
 
Vaizdas su ištisiniais kontūrais 
 
Prieš naudodami Outlined Image Preparation įrankį, įsitikinkite, kad vaizdas turi ištisinius kontūrus. Jeigu yra 
plyšių, atskiri spalvų plotai bus smaišyti į vieną. 
 
          Panaudotas įrankis 

 Outlined Image Preparation. 
 
Vaizdas dalinai su kontūru,          Vaizdo spalvos sumaišytos  
kažkuris plotas neuždaras 
 
 
Jeigu jums reikia pridėti kontūrus, uždaryti plyšius arba sustiprinti kontūrą, jūs prieš skenavimą galite nubrėžti 
tai ranka. Arba tai galite atlikti po skenavimo grafinėje programoje. Plačiau skaitykite pusl.91 Vaizdų 
redagavimas grafinėse programose. 
 
Patarimas  Kontūrus patamsinti galite pabandyti su kontūros išvaizdos slinktimi. 
 
         Panaudotas įrankis 

 Outlined Image Preparation. 
 
 
 
Vaizdo kontūras paruoštas          Kontūrai paryškinti 
grafinėjėje programoje 
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Vaizdo paruošimo suvestinė 
 
Veiksmas Vaizdas su kontūru Bekontūrinis vaizdas 
Vaizdo skenavimas 
 
Skenuoti linijinį piešinį 
 
Apdorojimas grafinėje 
programoje 
 
 
 
Outlined Image 
Preparation  įrankio 
panaudojimas 
DigitizerPro programoje 
 
Image Preparation  
įrankio panaudojimas 
DigitizerPro programoje 
 
Piešinio projektavimas 
 
 

*Skanuoti RGB režime 
*Paryškinti 
Skenuoti dviejų spalvų režime 
*Apkarpyti 
*Pridėti arba redaguoti kontūrus 
*Redaguoti spalvas 
*Pašalinti triukšmą 
 
 
Paryškinti kontūrus ir pašalinti triukšmą 
 
 
 
 
 
 
 
 
*Rankinis 
*Click-to-Stitch 
*Click-to-Design 

*Skenuoti RGB režime 
*Neryškinti 
 
*Apkarpyti 
*Redaguoti vaizdo figūras 
*Redaguoti spalvas 
*Pašalinti triukšmą 
 
 
 
 
 
 
 
Sumažinti spalvų ir pašalinti triukšmą 
 
 
 
*Rankinis 
*Click-to-Stitch 
*Click-to-Design 

 
Bekontūrinių vaizdų paruošimas 

Naudoti Image Preparation (Digitize įrankis), sumažinti spalvų skaičių ir pašalinti vaizdo ‚triukšmą‘ 
bekontūriniuose vaizduose. 

 
Naudokite Image Preparation , kad paruošti bekontūrinį vaizdą automatiniam projektavimui. Įrankis 
automatiškai sumažina spalvų blokų bitmap vaizduose iki vienos spalvos, šalinant ‚antialijansą‘ ir triukšmą. Jūs 
galite leisti programai automatiškai sumažinti spalvų kiekį arba nurodyti tikslų jų skaičių. Pastarasis yra 
naudingas, jeigu jūs norite suderinti piešinio spalvas iki tikslaus siūlų spalvų skaičiaus. 
 
Patarimas  Priklausomai nuo skenuoto vaizdo kokybės, prieš perduodant jį į DigitizerPro, jūs galbūt panorėsite 
patobulinti vaizdą rankiniu būdu. Paprastai, jūs tai darysite, kad pašalinti fonus, užpildyti spalvomis ištisinius 
plotus arba pridėti kontūrus, uždaryti plyšius, apkarpyti plotus arba sustiprinti kontūrus. Plačiau skaitykite pusl. 
91 Vaizdų redagavimas grafinėse programose. 
 
Kad paruošti bekontūrinį vaizdą 
1.Nuskenuokite arba įkraukite vaizdą. Plačiau skaitykite pusl.87 Iliustracijų skenavimas į DigitizerPro. 
 
 
           Vaizdas skenuotas RGB spalvų režime- 
           transformuotas į 256 spalvas įkrovimo metu 
 
2.Spragtelėkite Image Preparation piktogramą 
Atsidaro Image Preparation dialogas. 
 
 
 
Įveskite spalvų skaičių 
 
Peržiūros panelėje pasirodo vaizdas. Available laukas parodo vaizdo spalvų kiekį. 
 
 
 
Sumažinta iki 3 spalvų       Sumažinta iki 5 spalvų 
 
3.Patikrinkite, kiek spalvų yra piešinyje. Tai nurodyta lauke Available. Jeigu pasirodo, kad jų perdaug, 
tikriausiai vaizde yra triukšmo. 
4.Įveskite reikalingų spalvų kiekį. Peržiūros panelėje pamatysite, kaip atrodis vaizdas. 
5.Spragtelėkite OK , kad pritaikyti pakeitimus. w
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98. 
Kontūrinių vaizdų paruošimas 

Naudokite Outlined Image Preparation (Digitizer įrankis), kad paryškinti kontūrus ir sumažinti triukšmą 
kontūriniuose vaizduose. 

 
Naudokite Outlined Image Preparation įrankį, kad paruošti kontūrinius  vaizdus automatiniam projektavimui. 
Įrankis automatiškai paryškina kontūrus ir sumažina triukšmą. Plotai, apsupti juodu kontūru, yra nuspalvinami 
viena spalva. Kontūrų paryškinimas palengvina programai atpažinti atskirus vaizdo plotus. Šie plotai vėliau 
galutiniame piešinyje tampa siuvinėjimo objektais. Naudokite šį įrankį ypatingai, jeigu kontūrai išplaukę, 
pašiaušti arba neryškūs. 
 
Patarimas   Priklausomai nuo skenuoto vaizdo kokybės, prieš perduodant jį į DigitizerPro, jūs galbūt 
panorėsite patobulinti vaizdą rankiniu būdu. Paprastai, jūs tai darysite, kad pašalinti fonus, užpildyti spalvomis 
ištisinius plotus arba pridėti kontūrus, uždaryti plyšius, apkarpyti plotus arba sustiprinti kontūrus. Plačiau 
skaitykite pusl. 91 Vaizdų redagavimas grafinėse programose. 
_______________________________________________ 
 
Kad paruošti kontūrinius vaizdus. 
1.Nuskenuokite arba įkraukite vaizdą. Plačiau skaitykite pusl.87 Iliustracijų skenavimas į DigitizerPro. 
 
 
 
 
 
2.Spragtelėkite Outlined Image Preparation  piktogramą. Atsidaro Outlined Image Preparation  dialogas. 
 
 
Nustatyti kontūro vaizdą 
 
Spalvų skaičius vaizde 
 
Spragtelėkite, kad peržiūrėti triukšmo 
sumažinimo rezultatą. 
 
 
Vaizdas pasirodo peržiūrėjimo panelėje. Available Colors lauke pamatysite spalvų kiekį vaizde. 
3.Tempdami slinktį nustatykite kontūro kontrastą. Atsiras pasirinkto kontūro juodai baltas vaizdas. 
 
 
 
 
 
 
Paslinkite slinktį, kad paryškinti kontūrą  
ir pašalinti dėmeles. 
 
Pabandykite tai  Paslinkite slinktį į dešinę, kol pasieksite perdaug juodo, tuomet lėtai grįžkite atgal į kairę. 
Sustokite tuomet, kai vaizdas parodis visus jums reikalingus kontūrus. 
4.Spragtelėkite Show Color Areas, kad pamatyti atnaujintą vaizdą. 
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Kontūrai nešryškinti 
 
 
 
 
 
 
 
 
 
Slinktis pastumta į kairę 
 
 
 
 
 
 
Slinktis paslinkta į dešinę 
 
 
5.Spragtelėkite OK, kad pritaikyti pakeitimus 
 
 
     Padidintas plotas 
 
 
 
 
Kontūrai paryškinti ir sumažintas triukšmas 
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14 Skyrius 
AUTOMATINIS PROJEKTAVIMAS 
 
Click-to-Stitch įrankiai yra naudingi greitam siuvinėjimo objektų sukūrimui iš vaizdų, kurie nereikalauja 
ypatingų meninių efektų arba siuvinėjimo specifikos žinojimo. Tai išlaisvina jus nuo laiko eikvojimo 
meniškiems ir prigimtinai sudėtingiems jūsų piešinio plotams. 
 
Click-to-Design automatiškai paverčia iliustraciją į pilnai suprojektuotą siuvinėjimo piešinį su mažu arba be 
jūsų įsikišimo.Gali būti panaudotos įvairios iliustracijų formos – ir įvairūs vartotojo ‚pagalbos‘ lygiai, taikomi 
procesui. 
 
Panaudokite Photo Click, kad sukurti siuvinėjimo piešinį iš fotografijų arba kitų vaizdų, spalvotų arba pilkos 
skalės. Photo Click piešiniai sudaryti iš dygsnių eilučių įvairiais intervalais. Efektas primena linijinio 
spausdintuvo spaudinį.  
Šiame  skyriuje aprašoma, kaip automatiškai bitmap vaizdus paversti į siuvinėjimo objektus, taip pat kaip 
sukurti siuvinėjimo piešinius iš pilkų vaizdų. 
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Naudokite Click-to-Parallel Weave Fill (Digitize įrankis), kad projektuoti didelias iliustracijų figūras su 
Parallel Weave Fill, išsaugojant bet kokias skylutes viduje. 
 
Naudokite Click-to-Parallel Weave Fill without Holes (Digitize įrankis), kad projektuoti didelias 
iliustracijų figūras su Parallel Weave Fill, ignoruojant bet kokias skylutes viduje. 
 
Naudokite Click-to-Turning Angle Satin Fill (Digitize įrankis), kad projektuoti siaurų stulpelių 
iliustracijų figūras su Satin dygsniais. 
 
Naudokite Click-to-Centerline (Digitize įrankis), kad projektuoti centrines linijas iliustracijoje su 
linijinių dygsnių eilėmis. 
 
Naudokite Click-to-Outline (Digitize įrankis), kad projektuoti ribas tarp figūrų su Run dygsniais, 
naudojant veikiančias savybes. 
 
Naudokite Match to Palette (Digitize įrankis), kad surasti artimiausią derinį tarp pasirinktos vaizdo 
spalvos ir siūlo spalvos. 

 
Click-to-Stitch įrankiai užtikrina viską, kas būtina automatiniam figūrų projektavimui bitmap formate, netaikant 
rankinio įvedimo metodų. Šie įrankiai yra naudingi greitai sukuriant siuvinėjimo objektus iš skenuotų vaizdų, 
kuriems nereikia įpatingų meninių efektų arba specifinių siuvinėjimo žinių. Tai išlaisvina jus nuo laiko 
eikvojimo meniškiems ir prigimtinai sudėtingiems jūsų piešinio plotams. Click-to-Stitch yra pateikiama kaip 
‚įskrendanti įrankių juosta‘ ant Digitizer įrankių juostos, užtikrinanti šešias parinktis, parodytas aukščiau. Šie 
įrankiai paleidžia to paties pavadinimo funkcijas, randamas Embroidery>Click-to-Stitch meniu. 
 
Pastaba  Net jeigu jūsų iliustracija atrodo paruošta siuvinėjimui, ją reikia pirmiausiai apdoroti kaip vaizdą. 
Plačiau skaitykite pusl.93  Automatinis projektavimas. 
 
Spalvų paletės derinimas prie vaizdo 

Naudokite Match to Palette (Digitize įrankis), kad surasti artimiausią derinį tarp pasirinkto vaizdo spalvos ir 
siūlo spalvos. Jeigu įrankis nepasirinktas, projektavimui naudojama veikianti paletės spalva. 

 
Naudokite Match to Palette įrankį, kad surasti artimiausią derinį tarp pasirinkto vaizdo spalvinio bloko ir 
paletės spalvos. Jeigu Match to Palette nepasirinktas, spalvos blokas projektuojamas su veikiančia paletės 
spalva. 
_____________________________________ 
 
Kad suderinti paletės spalvą su vaizdu 
1.Nuskenuokite arba įkraukite vaizdą. Plačiau skaitykite pusl.87 Iliustracijų skenavimas į DigitizerPro. 
 
 
 
2.Pasirinkite vaizdą ir apdorokite jį. Detaliau žr.pusl.93 Vaizdų paruošimas automatiniam projektavimui. 
3.Spragtelėkite Match to Palette piktogramą. 
4.Pasirinkite Click-to-Stitch projektavimo būdą. 
5.Spragtelėkite į figūrą, kurią norėtumete projektuoti. Objektas bus suprojektuotas pagal artimiausią paletės 
spalvą. 
 
 
 Suderintas prie paletės        Suprojektuotas veikiančioje spalvoje. 
 
Pastaba  Jeigu Match to Palette  nebuvo pasirinktas, objektas bus suprojektuotas veikiančioje paletės spalvoje. 
 
Užpildymų projektavimas su Click-to-Stitch 

Naudokite Click-to-Parallel Weave Fill (Digitize įrankis), kad projektuoti didelias iliustracijų figūras su 
Parallel Weave Fill, išsaugojant bet kokias skylutes viduje. 
 
Naudokite Click-to-Parallel Weave Fill without Holes (Digitize įrankis), kad projektuoti didelias 
iliustracijų figūras su Parallel Weave Fill, ignoruojant bet kokias skylutes viduje. 
 
Naudokite Click-to-Turning Angle Satin Fill (Digitize įrankis), kad projektuoti siaurų stulpelių 
iliustracijų figūras su Satin dygsniais. w
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Click-to-Stitch galima panaudoti, kad sukurti ‚uždarus‘ Weave Fill objektus taip pat objektus su 
pasisukančiais Satin Fills dygsniais. Naudoti Click-to-Parallel Weave Fill, kad projektuoti didelius 
plotus jūsų iliustracijose su Weave Fill dygsniais, išlaikant bet kokias skylutes viduje. Jeigu norite 
ignoruoti skylutes, naudokite įrankį Click-to-Parallel Weave Fill without Holes. Naudokite Click-to-
Turning Angle Satin Fill įrankį, kad projektuoti siaurų stulpelių figūras su pasisukančiais Satin Fill 
dygsniais. Vaizdus galite modifikuoti prieš arba po įrankių panaudojimo. 
__________________________________ 
 

Kad panaudoti užpildymą su Click-to-Stitch 
1.Nuskenuokite arba įkraukite vaizdą. Plačiau skaitykite pusl.87 Iliustracijų skenavimas į DigitizerPro. 
2.Pasirinkite vaizdą ir apdorokite jį. Detaliau žr.pusl.93 Vaizdų paruošimas automatiniam projektavimui. 
3.Pasirinkite iš Color paletės siūlo spalvą. 
Alternatyviai, panaudokite įrankį Match to Palette, kad surasti artimiausią siūlo spalvos derinį. Plačiau 
žr.pusl.102 Spalvų paletės derinimas prie vaizdo. 
4.Pasirinkite reikalingą Click-to-Stitch užpildymo įvedimo metodą. 
5.Spragtelėkite ant figūros, kurią norite projektuoti 
6.Spauskite Enter. 
 Figūra iškarto užsipildis dygsniais. 
 
     Spragtelėkite ant objekto 
 
 
 
       Objektas užpildytas dygsniais 
 
 
7.Tokiu pat būdu projektuokite ir kitas figūras iš iliustracijos, keisdami siūlo spalvą ir reikalingą įvedimo būdą. 
 
 
     Visi užpildyti plotai  yra suprojektuoti  

ir parodyti Vizualizer lange 
 

8.Spragtelėkite Vizualizer, kad parodyti rezultatą. 
 
Pastaba  Dygsniai bus sugeneruoti atitinkamai veikiantiems dygsnių nustatymams. 
 
Kontūrų projektavimas su Click-to-Stitch 

Naudokite Click-to-Centerline (Digitize įrankis), kad projektuoti centrines linijas iliustracijoje su 
linijinių dygsnių eilėmis. 
 
Naudokite Click-to-Outline (Digitize įrankis), kad projektuoti ribas tarp figūrų su Run dygsniais, 
naudojant veikiančias savybes. 

 
Naudokite Click-to-Stitch  , kad projektuoti ribas ir detales su dygsnių eilėmis. Taikomos veikiančios savybės. 
Galite  juos modifikuoti kaip reikalinga prieš arba po įrankių naudojimo. 
__________________________________ 
 
Kad projektuoti kontūrus su Click-to-Stitch 
1.Nuskenuokite arba įkraukite vaizdą. Plačiau skaitykite pusl.87 Iliustracijų skenavimas į DigitizerPro. 
2.Pasirinkite vaizdą ir apdorokite jį. Detaliau žr.pusl.93 Vaizdų paruošimas automatiniam projektavimui. 
3.Pasirinkite iš Color paletės siūlo spalvą. 
Alternatyviai, panaudokite įrankį Match to Palette, kad surasti artimiausią siūlo spalvos derinį. Plačiau 
žr.pusl.102 Spalvų paletės derinimas prie vaizdo. 
4.Pasirinkite reikalingą Click-to-Stitch kontūro įvedimo būdą: 
 *Naudokite Click-to-Centraline, kad projektuoti centrines linijas jūsų iliustracijoje 
 
 
 
      Spragtelėkite, kad projektuoti centrinę liniją 
 *Naudokite Click-to-Outline, kad projektuoti figūrų kontūrus su eilių dygsniais. 
 
 
    Spragtelėkite, kad sukurti kontūrą w
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Pastaba  Dygsniai generuojami sutinkamai su veikiančiais nustatymais. Pastaruosius galima modifikuoti. 
 
Automatinis vaizdų projektavimas su Click-to-Design 
Click-to-Design, kaip Click-to-Stitch tąsa, atpažįsta kontūrus, esančius iliustracijoje, ir padaro sprendimus, 
kuriuos dygsnių tipus geriausia panaudoti. Jis taip pat nustato dygsnių seką, kuri pagrįsta artimiausiais 
ribojimaisi. Iliustracija efektyviai apdorojama, kad sukurti daugelį siuvinėjimo objektų, kurie sudaro gatavą 
piešinį. Click-to-Design buvo patobulintas su ‚išplaukiančiu‘ įrankiu, kuris užtikrina dvi parinktis: Click-to-
Design Instantly (standartinis) ir Click –to-Design Advanced.  Šie įrankiai paleidžia funkcijas su vienodais 
vardais, surastas Embroidery>Click-to-Design meniu. 
 
Pastabas  Vienu metu galima pasirinkti tiktai vieną vaizdą. Komanda išjungiama, jeigu yra pasirinkta dar 
kažkas daugiau negu vaizdas. 
 
Siuvinėjimo piešinių kūrimas su Click-to-Design Instantly įrankiu 

Naudokite Click-to-Design Instantly(Digitize įrankis),kad sukurti siuvinėjimo piešinius tiesiogiai iš 
importuotų vaizdų, panaudojant standartinius nustatymus. 

Iš esmės, siuvivinėjimo piešinių sukūrimas su Click-to-Design Instantly įrankiu yra paprastas reikalas, 
pasirinkti vaizdą, kurį norėtumėte konvertuoti, ir spragtelėti ant įrankio. Sistema automatiškai nustato spalvas, 
kurias reikia atmesti, užpildymo spalvas, detalių spalvas ir tinkamiausius dygsnių tipus, kuriuos reikia taikyti 
vaizdui, panaudojant standartinius nustatymus. Ji nedelsiant generuoja dygsnius pasirinktam vaizdui. 
_____________________________ 
 
Kad sukurti siuvinėjimo piešinius su Click-to-Design Instantly 
1.Nuskenuokite arba įkraukite vaizdą. Plačiau skaitykite pusl.87 Iliustracijų skenavimas į DigitizerPro. 
 
 
 
 
2.Pasirinkite vaizdą ir spragtelėkite ant Click-to-Design Instantly piktogramos.  
Netgi jeiguvaizdas prieš tai nebuvo apdorotas su Image Preparation  įrankiu, Click-to-Design Instantly 
automatiškai apdoros pasirinktą vaizdą ir pavers jį į siuvinėjimo piešinį. 
 
Siuvinėjimo piešinių kūrimas su Click-to-Design Advanced įrankiu 

Naudokite Click-to-Design Advanced (Digitize įrankis) geresnei kontrolei, sukuriant siuvinėjimo 
piešinius tiesiogiai iš importuotų vaizdų. 

 
Jeigu pageidaujate geresnės vaizdo kontrolės, spragtelėkite ant Click-to-Design Advanced įrankio, kuris vaizdo 
pavertimo metu leidžia jums kontroliuoti spalvas ir dygsnių tipus. Netgi, jeigu jūsų iliustracija, įkeliant ją į 
programą, atrodo paruošta siuvinėjimui, ją vistiek prieš pavertimą būtina apdoroti. Programa neleis jums taikyti 
automatinio projektavimo be preliminariniovaizdo apdorojimo. Plačiau skaitykite pusl.94 Vaizdo paruošimo 
būdai. 
___________________________ 
 
Kad sukurti siuvinėjimo piešinius su Click-to-Design Advanced 
1.Nuskenuokite arba įkraukite vaizdą. Plačiau skaitykite pusl.87 Iliustracijų skenavimas į DigitizerPro. 
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2.Pasirinkite vaizdą ir apdorokite jį. Detaliau žr.pusl.93 Vaizdų paruošimas automatiniam projektavimui. 
3.Pasirinkite vaizdą ir spragtelėkite ant Click-to-Design Advanced įrankio 
Atsidaro Click-to-Design dialogas. Pasirodo teisingai apdorotas vaizdas , Fill Colors stulpelyje  pasirodo visos 
galimos spalvos pagal standartą. Informacija apie vaizdą yra patekta, įskaitant pločio  ir aukščio reikšmes taip 
pat ir vaizdo spalvų skaičių. 
 
   Dygsnių tipo ir detalių reguliavimas 
 
 
 
   Spragtelėti, kad apdoroti vaizdą, jeigu aktyvuotas 
 
 
 
   Spragtelėkite ir tempkite spalvas į laukus 
 
 
 
   Parinkti spalvas, kurias reikia atmesti 
 
Pastaba  Jeigu vaizdas netinkamai buvo apdorotas, nepasirodis spalvos ir bus aktyvuotas mygtukas Image 
Preparation.Spragtelėkite, kad pradėti apdorojimą. Plačiau žr.pusl.94 Vaizdo paruošimo būdai. 
4.Spragtelėkite ir bet kurias spalvas, kurias norėtumete atmesti iš automatinio dygsnių apdorojimo, tempkite į 
Omit stulpelį. 
5.Panašiai, spragtelėkite ir tempkte arba palikite stulpelyje Fill spalvas, kurias norėtumete panaudoti piešinio 
plotų užpildymui. 
 
    Fono spalva praleista 
 
 
 
 
    Žalios spalvos praleistos 
 
6.Bet kurias spalvas, kurias norite apdoroti kaip ‚detales‘, – pavyzdžiui, kontūrus, ribas arba mažus plotus, 
kuriuos norėtumete siuvinėti paskiausiai –spragtelėkite ir tempkite į stulpelį Details.  
7.Iš sąrašo pasirinkite siuvinėjimo tipą ir užpildymą. 
 *Auto Select: sistema nusprendžia, kuris tinkamas dygsnių tipas. 
 *Weave: tinkamiausias daugeliui plotų 
 *Satin: tinkamas mažesniems plotams 
 
Pastaba  Nenaudokite Satin užpildymo plotams, kur dygsnių ilgis viršija 7 mm. 
 
      Fills: Satin 
      Details: Satin 
 
 
      Fills: Weave 
      Details: Satin 
 
 
8.Iš sąrašo pasirinkite dygsnių tipą detalėms. 
 *Satin: tinkamiausias storesnėms linijoms arba mažesnėms figūroms su kintamu pločiu. 
 *Double Run: tinkamiausias plonoms linijoms. 
 *Sartin Line: tinka naudoti su storesnėmis linijomis. 
9.Spragtelėkite OK. 
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Click-to-Design  paverčia iliustraciją į siuvinėjimo objektus ir generuoja dygsnius. 
 
Pabandykite tai  Programa suderina spalvas iš egzistuojančios paletės. Jeigu atrodo, kad piešinio spalvos 
prastai konvertuotos, patikrinkite ar jūsų PK vaizduoklis nustatytas į 16 Bit Colors. 
 
Siuvinėjimo piešinių sukūrimas iš fotonuotraukų 

Naudokite Photo Click Instantly (Digitize įrankis), kad sukurti siuvinėjimo piešinius tiesiogiai iš 
fotonuotraukų arba kitų vaizdų, naudojantis standartiniais nustatymais. 
 
Naudokite Photo Click Advanced (Digitize įrankis) didesnei kontrolei, kurtiant siuvinėjimo piešinius 
tiesiogiai iš fotonuotraukų arba kitų vaizdų. 

 
Naudokite Photo Click, kad sukurti siuvinėjimo piešinį iš fotonuotraukų arba kitų vaizdų, spalvotų arba iš 
pilkos skalės. Pilkos skalės vaizdai padaryti iš skirtingų pilkų atspalvių taškelių. Spalvoti vaizdai automatiškai 
bus verčiami į pilkos skalės vaizdus, jei panaudosite Photo Click. Photo Click piešiniai susideda iš dygsnių 
eilučių su skirtingu intervalu (PhotoSatin Fill). Efektas primena linijinio spausdintuvo spaudinį. Reguliuokite 
eilučių ir/arba pačių dygsnių kampus. 
 
 
 
Patarimas  Geriausiems rezultatams, naudokite vaizdus su  gerai apibrėžtais subjektais arba su nuolat 
besikeičiančiais atspalviais. 
_____________________________ 
 
Kad sukurti siuvinį iš fotonuotraukų 
1.Nuskenuokite arba įkraukite vaizdą. Plačiau skaitykite pusl.87 Iliustracijų skenavimas į DigitizerPro. 
2.Pasirinkite siūlo spalvą. 
3.Pasirinkę vaizdą, spragtelėkite tuo metu aktyvią Photo Click piktogramą. 

*Jeigu Photo Click tuo metu yra aktyvi, photovaizdas bus apdorojamas, panaudojant veikiančius nustatymus 
ir pasirinktą siūlo spalvą. 
*Jeigu Photo Click Advanced yra aktyvus, atsidaro Object Details>Photo Click dialogas. 

 
 
 
 
 
 
4.Resolution panelėje pasirinkite skiriamosios gebos parinktį: Coarse (grubi), Medium (vidutinė) arba Fine 
(smulki). 
 
 
 
 
 Smulki skiriamoji geba      Grubi skiriamoji geba 
 
Pastaba  Kuo grubesnė skiriamoji geba, tuo intervalas tarp eilučių didesnis. 
 
5.Panelėje Row įveskite naują kampą  
 
 
 
 
 Eilutės kampas: 0o.   Elutės kampas 90o. 
 
6.Panelėje Background pasirinkite fono parinktį: 

*Light: taikoma maksimali eilutės pločio reikšmė šviesiausiai vaizdo daliai. 
 *Dark: taikoma maksimali eilutės pločio reikšmė tamsiausiai vaizdo daliai. 
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 Šviesus fonas     Tamsus fonas 
 
Pabandykite tai  Jūsų pasirenkama parinktis paprastai priklauso nuo to ar medžiaga yra šviesi ar tamsi. 
Parinktis Dark sukuria vaizdo negatyvą 
 
7.Panelėje Fill pareguliuokite reikalingą grūdelių kampą Grain Angle. 
 
 
 
 
 
  Grūdelių kampas  0o.       Grūdelių kampas  45o.  
 
Spragtelėkite OK. 
EasyDesign pasirinktam vaizdui generuoja dygsnius. 
 
Pabandykite tai  Tikslesnei vaizdo peržiūrai naudokite Vizualizer‘į. 
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IV Dalis 
 
SIUVINĖJIMO PIEŠINIŲ MODIFIKAVIMAS  
 
Suprojektavę piešinį, jūs galite jį modifikuoti visą, redaguoti atskirus objektus arba net atskirus dygsnius.  
 
Objektų  vienijimas ir sekos keitimas 
Šiame skyriuje aprašyta, kaip sujungti objektus ir piešinius, juos kopijuojant ir įkeliant, dublikuojant ir 
įterpiant. Čia taip pat aprašyta, kaip pakeisti objektų seką, iškerpant ir įkeliant, pagal spalvas arba objektus. 
Plačiau skaitykite pusl.111 Objektų vienijimas ir sekos keitimas. 
 
Objektų tvarkymas ir transformavimas 
Šiame skyriuje aprašomos operacijos su objektais, kaip patalpinti, užrakinti ir grupuoti taip pat kaip pakeisti 
mastelį, pasukti, pakreipti ir apversti objektus. Plačiau skaitykite pusl.119 Objektų tvarkymas ir 
transformavimas. 
 
Objektų formos keitimas ir redagavimas 
Šiame skyriuje aprašoma, kaip pakeisti objektų formą pagal kontrolinius taškus, kaip reguliuoti dygsnių 
kampus ir kaip pakeisti įėjimo ir išėjimo taškus. Plačiau skaitykite  pusl.125 Objektų formos keitimas ir 
redagavimas. 
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15 Skyrius 
 
 
OBJEKTŲ VIENIJIMAS IR SEKOS KEITIMAS 
 
 
DigitizerPro leidžia jums greitai padidinti piešinius, dublikuojant ir kopijuojant egzistuojančius piešinius. Jis 
taip pat leidžia jums suvienyti piešinius, įterpiant vieno failo turinį į kitą failą. 
 
Siuvinėjimo seka paprastai vyksta tvarka, pagal kurią piešinys buvo projektuojamas. Tačiau, jūs galite pakeisti 
šią tvarką įvairiais būdais. 
 
Šiame skyriuje aprašyta, kaip suvienyti objektus ir piešinius, juos kopijuojant ir įkeliant, dublikuojant ir 
įterpint. Čia taip pat aprašyta, kaip pakeisti objektų seką, iškerpant ir įkeliant, pagal spalvas arba objektus. 
 
 
 
Piešinių ir objektų suvienijimas 
 
Piešinius arba piešinių objektus galima kopijuoti arba iškirpti ir patalpinti į Window Clipboard atmintinę 
laikinam saugojimui. Vėliau kopiją galima įkelti kiek norima kartų arba į tą patį arba į kitą piešinį, kol ją 
atmintinėje pakeis kita kopija. Jūs galite taip pat iškirpti įkelti raidinius objektus į piešinius ir tarp kitų objektų. 
Kada įterpiate vieną piešinį į kitą, suvienijamos abi Color Chart lentelės. 
 
Piešinių įterpimas 
Naudokite Insert Design (Embrodery meniu), kad suvienyti du arba daugiau piešinių. 
 
DegitizerPro leidžia vieną piešinį įterpti į kitą. Du (arba daugiau) piešinių galima  tada išsaugoti kaip suvienytą 
piešinį. 
___________________________ 
 
Kad įterpti piešinius 
 
1. Atidaryti pirmą piešinį. 
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2.Siuvinėjimo seka nukeliaukite į tašką, kur norite įterpti antrą piešinį. Plačiau žr.pusl.35 Kelionė siuvinėjimo 
seka EasyDesign programoje. 
Galite įterpti piešinį tarp objektų sekoje arba ‚įsodinti‘ piešinį objekto viduje. 
3.Pasirinkite Embroidery>Insert Design. Atsidaro Open  dialogas. 
 
 
 
 
 
4.Iš išsiskleidusio Look In sąrašo pasirinkite bylą, kurioje yra saugojamas piešinys, kurį norite įterpti, taip pat iš 
išsiskleidusio sąrašo Files of type pasirinkite reikalingą formatą. 
5.Pasirinkite piešinio, kurį norite įterpti, failą ir spragtelėkite Open. 
Piešinys bus įterptas esamoje adatos padėtyje. 
6.Paslinkite antrą piešinį į reikalingą padėtį. Plačiau skaitykite pusl. 116 Objektų išdėstymas, panaudojant 
spragtelėjimą ir tempimą.  
 
 
     Perkelkite į reikalingą padėtį 
 
 
Pabandykite tai  Kad užtikrinti, kad visi objektai įterptame piešinyje pasiliktų kartu, sugrupuokite objektus 
piešinyje, dirbdami su juo. Plačiau žr.pusl.121 Objektų grupavimas. 
7.Išsaugokite suvienytą piešinį pradiniu arba kitokiu vardu. 
Piešiniai, kuriuos jūs įterpėte dabar sudaro vieną piešinį. 
 
Objektų kopijavimas ir įkėlimas 
  Spragtelėkite Copy (Standartinis įrankis), kad kopijuoti pasirinktą piešinį į atmintinę. 
  Spragtelėkite Paste (Standartinis įrankis), kad įkelti kopijuotą objektą iš atmintinės į piešinį. 
 
Galite kopijuoti objektus, kad sukurti daugybinius, identiškus objektus arba kad įterpti objektus iš kitų piešinių. 
 
    Nukopijuoti ir įkelti objektai 
 
 
 
Pastaba  Jūs taip pat galite pašalinti objektus iš piešinio panaudojant Cut komandą ir įkelti juos vėl atgal. Cut ir 
Paste  keičia siuvinėjimo seką piešinyje. Plačiau žr. pusl.115 Objektų sekos keitimas su Cut ir Paste. 
__________________________________ 
 
Kad kopijuoti ir įkelti objektus 
1.Pasirinkite objektą (us), kopijavimui. 
 
 
 
 
2.Spragtelėkite Copy piktogramą 
Pasirinktas objektas nukopijuotas į atmintinę. 
3.Siuvinėjimo seka nukeliaukite į padėtį, kurioje norite įkelti objektą. Plačiau žr.pusl.36 Kelionė siuvinėjimo 
seka EasyEdit programoje. 
 
 
     Nukeliaukite į padėtį 
 
 
Galite įkelti tarp kitų objektų pagal seką arba ‚pasodinti‘ nukopijuotą objektą kito objekto viduje. Plačiau 
žr.pusl.114 Objektų įsodinimas. 
 
4.Spragtelėkite Paste piktogramą. 
Objektas įkeltas į piešinį. Nukopijuotas objektas dar pasilieka tarpinėje atmintinėje ir gali būti įkeltas 
pakartotinai iki sekančių komandų Cut ir Paste įvykdymo. w
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    Objektas įkeltas ir apverstas 
 
Objektų dubliavimas 
Pasirinkite Dublikate (Edit meniu), kad dublikuoti pasirinktus objektus. 
 
Objektus galima dubliuoti greičiau negu kopijuoti. Dublikuojant objektą, jis nekopijuojamas į tarpinę atmintinę. 
Tai leidžia laisvą atmintinę panaudoti iškirpimui arba kopijavimui.  
 
 
 
 
 Kad sukurti įvairumo efektą, dubliuotas objektas nutolintas ir pakeista jo spalva 
_________________________________________________ 
 
Kad dubliuoti objektus 
1. Siuvinėjimo seka nukeliaukite į tašką, kur norite patalpinti objektą. Plačiau žr.pusl.35 Kelionė siuvinėjimo 
seka EasyDesign programoje. 
Galite patalpinti objektą tarp kitų objektų sekoje arba ‚įsodinti‘objekto viduje. Plačiau žr. pusl.114 Objektų 
įsodinimas. 
2.Pasirinkite objektą(us) dubliavimui. 
3.Pasirinkite Edit>Dublicate. 
Objekto dublis patalpinamas tiesiogiai  ant originalo nurodytoje sekos vietoje. 
 
Perspėjimas  Įsitikinkite, kad vienoje vietoje yra tiktai vienas dublis. Jeigu objektas vienoje vietoje bus 
patalpintas du kartus, tai ji bus siuvinėjamas du kartus. 
 
Objektų klonavimas 
 Spragtelėkite Select (Edit įrankis) ir spragtelėkite ant objekto, kad pasirinkti jį. 
 
Quicck Clone galimybė leidžia jums greitai dubliuoti pasirinktus objektus, spragtelėjus juos dešiniu pelės 
mygtuku, tempiant ir atleidžiant kitoje vietoje. 
_________________________ 
 
Kad klonuoti objektus 
1.Pasirinkite objektą arba objektus 
2.Laikant paspaustą dešinį pelės mygtuką, tempkite objektą(us) į naują vietą. 
Pasirodo juodas objekto kontūras. Pelės žymeklyje bus ženklas plius. 
 
 
        Dešinys objekto spragtelėjimas 
 
   Tempti ir paleisti 
 
 
        Objektas dubliuotas 
 
 
Pabandykite tai  Kad tiksliau patalpinti dublį, tempiant laikykite paspaustą klavišą Ctrl – judėsys bus 
apribotas X arba Y ašių kryptimi. 
3.Paleiskite pelę. 
Pelės paleidimo vietoje bus sukurta objekto(ų) dublis. 
 
 
 
 
Dešinys spragtelėjimas, laikyti paspaustą Ctrl      Paleisti ją 
ir patempus paleisti objektą(us) 
 
Pabandykite tai  Tokiu pat būdu klonuokite objektą į kitą langą. Kad laikinai išjungti automatinę slinktį, 
laikykite paspaustą klavišą Shift, kai tempiate.  w
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Identiška pasirinkto objekto kopija bus sukurta tose pačiose koordinatėse kaip ir pirmame lange, visiškai 
nesvarbu, kur paleisite pelę. 
 
Objektų trynimas 
Pasirinkite Delete (Edit meniu), kad ištrinti pasirinktus objektus. 
 
Objektų trynimų galimi įvairųs būdai. 
_______________________________ 
 
Kad ištrinti objektus 
*Pasirinkite objektą, kurį norite ištrinti ir atlikite vieną iš operacijų: 
  *Spauskite Delete. 
  *Pasirinkite Edit>Delete. 
 
Objektų įsodinimas 
Jūs galite įdėti arba ‚įsodinti‘ objektą į kito objekto suvinėjimo sekos vidurį, kad išvengti ilgų sujungimų 
(perėjimų) generavimo. Įsodinimas leidžia sukurti arba įterpti objektą tiksliai numatytame siuvinėjimo sekos 
taške.Ši galimybė ypač naudinga su atspaudais ir kitokiais piešiniais, kur gali būti generuojami ilgi sujungimai 
 
 
 
Objektas neįsodintas – ilgi sujungimai 
 
 
 
 
 
Objektai įsodinti – trumpi sujungimai ir geresnė siuvinėjimo seka 
 
 
Pastaba  Įsodintų objektų siuvinėjimo seka palaikoma, išnaujo generavus dygsnius abiems objektams. Tačiau, 
jeigu išnaujo sudarinėsite piešinio su įsodintu objektu siuvinėjimo seką, ji siuvinės objektus originalaus objekto 
seka. 
________________________ 
 
Kad įsodinti objektus 
1.Keliaukite per pirmą objektą iki adatos padėties žymeklio, kur pageidaujate įterpti antrą objektą. Plačiau 
žr.pusl.36 Kelionė siuvinėjimo seka EasyEdit programoje. 
 
 
  Atkeliauta iki taško 
 
 
2.Įterrpkite antrą objektą. Kad tai atlikti, šioje vietoje sukurkite naują objektą arba iškirpkite ir įkelkite esamą. 
 
   Pasirinktas objektas 
 
  
 
   Iškirptas ir įkeltas objektas 
 
 
Antras objektas yra įsodintas į pirmojo objekto siuvinėjimo seką. Visos reikalingos  funkcijos automatiškai 
įsijungia ir antram objektui. 
 
Pabandykite tai  Kad pamatyti sujungimus, generuotus įsodintam objektui, naudokite normalią peržiūrą. 
 
Siuvinėjimo objektų sekos sudarymas išnaujo 
Siuvinėjimo objektai piešinyje formuoja siuvinėjimo seką. Iš pradžių, objektai siuvinėjami jų sukūrimo tvarka. 
Jūs galite pakeisti pasirinkto objekto padėtį, jį iškirpus ir įkėlus kitoje sekos vietoje arba pasinaudojant 
komanda Resequence. w
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Naujos sekos sudarymas su Cut ir Paste 
  Spragtelėti Cut (Standartinis įrankis), kad iškirpti pasirinktus objektus ir patalpinti juos atmintinę. 
 
  Spragtelėti Paste (Standartinis įrankis), kad įkelti objektų kopiją į piešinį. 
 
Galite naujai išrykiuoti objektus, iškerpant juos iš piešinio ir įkeliant juos atgal į kitą sekos vietą. Tai nekeičia 
fizinės objekto vietos. 
_______________________________ 
 
Kad sudaryti naują objektų seką su Cut ir Paste 
1.Pasirinkti objektą(us) perrykiavimui. 
2.Spragtelėti Cut piktogramą. Pasirinktas objektas pašalinamas iš piešinio ir perkeliamas į atmintinę. 
 
 
 
Užbaigtas piešinys, kuriame       Pasirinktas ir iškirptas objektas,  
pirmiausiai siuvinėjimas centras     skirtas pakeitimui 
 
3.Nukeliaukite siuvinėjimo seka į vietą, kur norite atgal įkelti objektą. Plačiau žr.pusl.35 Kelionė siuvinėjimo 
seka EasyDesign programoje. 
Jūs galite įkelti sekoje tarp kitų objektų arba ‚įsodinti‘ iškirptą objektą kito objekto viduje. Žr. pusl. 114 
Objektų įsodinimas. 
Jeigu nepakeisite adatos žymeklio esamos padėties, objektas bus įkeltas į sekos pabaigą. 
4.Spragtelėkite Paste piktogramą. 
 
      Adatos padėties žymeklis 
 
 
 
 
Keliauti į piešinio pabaigą        Įkelti objektą 
 
 
Objektas įkeltas atgal į piešinį. 
 
Pastaba  Objektas išlieka atmintinėje ir gali būti pakartotinai įkeltas iki kol neatsinaujins komandos Copy ir 
Cut. 
 
Pasirinktų objektų perrykiavimas 
  Naudoti Resequence (Edit įrankis), kad perrykiuoti pasirinktų objektų seką. 
 
Galite perrykiuoti objektus, pasirinkdami juos reikalingoje siuvinėjimo sekoje. Dialogas Resequence  yra ‚be 
rėžimo‘, tai reiškia, kad jis pasilieka piešinio lange tiek, kiek jums reikia. Žr.taip pat pusl.44 Resequence 
dialogas. 
___________________________ 
 
Kad perrykiuoti pasirinktus objektus 
1.Spragtelėkite Resequence piktogramą. Atsidaro Resequence dialogas. 
2.Pasirinkite reikalingą mygtuką Objects. 
 
 
 
 
3.Pasirinkite pirmą objektą, kurį norite perrykiuoti. 
  *Laikant paspaustą Ctrl, pasirinkite daugybinius objektus perrykiavimui. 
  *Laikant paspaustą Shift, pasirinkite eilę objektų, kad perrykiuoti. 
4.Spragtelėkite mygtukus, kad perstatyti pasirinktus objektus siuvinėjimo sekoje: 
 *Top (viršutinis): objektą perkelia į sekos pradžią. 
 *Up (aukštyn): perkelia jį viena vieta aukščiau sekoje 
 *Down (žemyn): perkelia jį viena vieta žemiau sekoje 
 *Bottom (apačia): perkelia jį į sekos pabaigą. 
 *Delete (ištrinti): pašalina jį iš sekos. 
5.Spragtelėkite OK. w
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Pabandykite tai  Galite taip pat pasiekti komandas per Resequence dialogą, įskaitant ir Lock/Unlock 
(užrakinti/atrakinti) ir objekto detales. 
 
 
 
 
       Dešinys spragtelėjimas, kad pasiekti  
       popup  (iššokusį) meniu 
 
Objektų perrykiavimas pagal spalvas 
  Spragtelėti Resequence (Edit įrankis), kad perrykiuoti objektus pagal spalvas. 
 
Galite perrykiuoti objektus pagal spalvas. Tai sumažinns spalvų pasikeitimų skaičių piešinyje. Dialogas 
Resequence  yra ‚be rėžimo‘, tai reiškia, kad jis pasilieka piešinio lange tiek, kiek jums reikia.  
___________________________ 
 
Kad perrykiuoti objektus pagal spalvas 
1.Spragtelėkite Resequence  piktogramą. 
Atsidaro Resequence dialogas. 
2.Pasirinkite reikalingą mygtuką Colors. 
 
 
 
 
 
     Pažymėta siuvinėjimo seka,  
     po kiekvieno objekto keičiasi spalva 
 
 
3.Pasirinkite pirmą spalvą, kurią norėsite perrykiuoti. 
  *Laikant paspaustą Ctrl, pasirinkite daugybinius objektus  perrykiavimui. 
  *Laikant paspaustą Shift, pasirinkite eilę objektų, kad perrykiuoti. 
4.Spragtelėkite mygtukus, kad perstatyti pasirinktą spalvą (as) siuvinėjimo sekoje: 
 *Top (viršutinis): spalvą perkelia į sekos pradžią. 
 *Up (aukštyn): perkelia ją viena vieta aukščiau sekoje 
 *Down (žemyn): perkelia ją viena vieta žemiau sekoje 
 *Bottom (apačia): perkelia ją į sekos pabaigą. 
 *Delete (ištrinti): pašalina ją iš sekos. 
 
 
 
      Pasirinktos spalvos perstatymas 
 
 
 
 
5.Spragtelėkite OK. 

w
w
w
.V
isk
as
Si
uv
im
ui
.lt
 



117 
 
     Pakeista siuvinėjimo tvarka, 
     sumažėjo spalvų persijungimų  
     skaičius     
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16 Skyrius 
 
 
OBJEKTŲ TVARKYMAS IR TRANSFORMAVIMAS 
 
 
Keisdami objektų vietą, mastelį ir formą, jūs galite pakeisti objektų vietą, dydį ir orientaciją piešinyje. Galima 
sugrupuoti objektus, kad pakeitimus taikyti visai grupę iškarto, užrakinti juos, kad išvengti nepageidaujamų 
modifikacijų. Galite modifikuoti objektus tiesiog ekrane arba keisdami nustatymus. Taip pat galite kai kurias iš 
šių funkcijų pasiekti per popup (iššokantį) meniu. 
 
Mastelio ir siuvinėjimo kokybė galiausiai priklauso nuo originalo šaltinio. Tiktai tikrieji JAN piešiniai savyje 
turi pilną komplektą informacijos apie piešinį, kurios reikia 100% kokybiškam masteliui ir transformavimui. Žr. 
taip pat pusl.202 Siuvinėjimo piešinių formatai. 
Šiame skyriuje aprašyta, kaip reguliuoti objektų padėtį, kaip juos užrakinti ir sugrupuoti, o taip pat kaip keisti jų 
mastelį, pasukti, pakreipti ir apversti. 
 
 
Objektų išdėstymas ir išlyginimas 
 
Objektus į kitą piešinio vietą galima  perkelti tempiant juos su pele, nustumti juos su rodyklių klavišais arba 
dialoge Object Details nurodant X:Y koordinates.  
 
Objektų perkėlimas spragtelėjus ir tempiant  su pele 
Paprasčiausias objektų perkėlimo į kitą piešinio vietą būdas yra spragtelėti ir tepmti jį su pele į norimą vietą. 
Alternatyvus būdas yra nustumti objektus į kitą vietą su rodykliniais klavišais. 
______________________________ 
 
Kad perkelti objektus, spragtelėjimo ir tempimo būdu 
1.Pasirinkite objektą(us), kurį reikia perkelti. 
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2.Spragtelėkite ir tepmkite objektą su pele į naują vietą. 
 
 
 
 
        Kryžmas žymeklis centruoja objektus 
 
3.Kad tiksliau pastatyti objektą į vietą, spauskite rodyklių klavišus ir pastumkite objektą į reikiamą vietą. 
 
Pabandykite tai  Norėdami atlikti mažus reguliavimus, padidinkite mastelį. Atstumas, kuriuo objektas pajuda, 
priklauso nuo mastelio koeficiento. Kuo didesnis mastelio koeficientas, tuo mažesniu žingsneliu pajuda 
objektas. 
 
Objektų perkėlimas, panaudojant objektų detales 
Galite perkelti pasirinktus objektus piešinio centro atžvilgiu, įvedant koordinačių X:Y reikšmes į Details 
dialogą. 
_____________________ 
 
Kad perkelti objektus panaudojant jų detales 
1.Pasirinkti objektus, kuriuos reikia perkelti 
2.Du kartus spragtelėkite ant objekto, kad atidaryti dialogą Objects Details  ir pasirinkite lentelę Diamensions. 
 
 
      Įveskite naujas koordinates 
 
3.Įveskite naujas objekto koordinates į Position  laukus. 
4Spragtelėkite OK. Objektas bus sucentruotas ant naujai nurodytų koordinačių. 
 
Objektų rykiavimas 
  Naudokite Align Left (Edit įrankis), kad rykiuoti pasirinktus objektus iš kairės 

Naudokite Align Centers Vertically (Edit įrankis), kad rykiuoti pasirinktus objektus per jų centrų 
vertikalią. 
Naudokite Align Right (Edit įrankis), kad rykiuoti pasirinktus objektus iš dešinės 
Naudokite Align Top (Edit įrankis), kad rykiuoti pasirinktus objektus viršuje. 
Naudokite Align Centers Horizontally (Edit įrankis), kad rykiuoti pasirinktus objektus per jų centrų 
horizontalią. 
Naudokite Align Bottom (Edit įrankis), kad rykiuoti pasirinktus objektus pagal apačią. 
Naudokite Align Centers (Edit įrankis), kad rykiuoti pasirinktus objektus per jų centrus. 

 
Galima greitai surykiuoti pasirinktus objektus piešinyje iš kairės, iš dešinės, viršuje, apačioje arba per specifinių 
objektų centrus. Naujas Align įrankis Edit įrankių juostoje siūlo mygtukų rinkinį to paties vardo funkcijų 
perjungimui Align  popup meniu viduje. Jei pasirinkta du arba daugiau objektų, įsijungia visi įrankiai. 
____________________________ 
 
Kad surykiuoti objektus 
1.Pasirinkite objektus, kuriuos norite surykiuoti 
 
Pastaba  Objektai lygiuojami su paskutiniu pasirinktu objektu 
2.Pasirinkite objektą, pagal kurį norite rykiuoti 
3.Spragtelėkite rykiavimo įrankį arba pasirinkite Align popup meniu viduje dešiniu spragtelėjimu ant objekto. 
 
              Rykiavimas pagal centrus 
 
 
              Rykiavimas iš kairės 
 
 
              Rykiavimas apačioje 
 
Pabandykite tai  Pasiekti komandas taip pat galite per Resequence  dialogą. Žr.taip pat pusl.115 Pasirinktų 
objektų perrykiavimas. w
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    Dešinys spragtelėjimas ir pasirinkti Align 
 
 
Objektų užrakinimas ir grupavimas 
 
Kai jūs užrakinate objektą, jūs apsaugojate jį nuo netyčinio perkėlimo ar modifikavimo. Kai jūs sugrupuojate 
objektus, jūs galite taikyti pakeitimus iškarto visiems objektams, taupote laiką ir įsitikinate, kad pakeitimas  
tarpusavy dera visiems objektams. 
 
Objektų rakinimas 
 Pasirinkite Lock (Edit meniu), kad užrakinti pasirinktus objektus. 
 Pasirinkite Unlock (Edit meniu), kad atrakinti objektus. 
 
Rakinkite objektus, kad apsaugoti juos nuo netyčinio perkėlimo ar modifikavimo. Pavyzdžiui, šabloninių 
vaizdų arba vektor piešinių rakinimas palaiko juos vietoje, kai jūs šalia jų projektuojate, transformuojate arba 
keičiate siuvinėjimo objektų formą. Užrakintus objektus bet kuriuo metu galima atrakinti, kad atlikti pakeitimą. 
______________________________ 
 
Kad užrakinti objektus 

*Pasirinkite objektą, kurį norite užrakinti ir tada pasirinkite Edit>Lock. Pasirinkimo rankenėlės išnyksta, tai 
reiškia, kad šio objekto jau negalima pasirinkti ar modifikuoti. 
*Kad atrakinti objektą, pasirinkite Edit>Unlock. Visi užrakinti objektai piešinyje bus atrakinti. 
 
Pabandykite tai  Spragtelėkite dešiniu mygtuku pasirinktus objektus ir pasirinkite Lock iš popup meniu. 
 
Objektų grupavimas 
 Spragtelėkite Group (Edit meniu), kad sugrupuoti pasirinktus objektus. 
 
Galite sugrupuoti pasirinktus objektus arba visą piešinį, kad palaikyti jį kaip visumą, perkeliant, keičiant 
mastelį ir transformuojant 
_____________________________ 
 
Kad sugrupuoti objektus 
1.Pasirinkti objektus į grupę. 
2.Pasirinkti Edit>Group 
 
 
      Sugrupuotų objektų pasirinkimas, perkėlimas 
      matmenų keitimas, transformavimas vyksta 

 kaip vieno objekto 
 

Pasirinkti objektai yra sujungti į grupę. Ją galima pasirinkti , perkelti, pakeisti matmenis ir transformuoti kaip 
atskirą vieną objektą. 

 
Pabandykite tai  Kad pasirinkti su apibrėžiančiu kontūru (rėmeliu), tiesiog patempkite kontūrą virš vieno iš 
sudedamųjų objektų ir visa grupė bus pasirinkta. Žr.taip pat pusl.42 Objektų pasirinkimas su ribojančiu 
rėmeliu. 

 
Objektų išgrupavimas 

 Spragtelėkite Ungroup (Edit meniu), kad išgrupuoti pasirinktus objektus. 
 

Kai atlikote visus pakeitimus grupei, galite ją išgrupuoti ir toliau dirbti su objektais individualiai. 
 
Pastaba  Objektus jums reikia išgrupuoti, kad galėtumete nustatyti siuvinėjimo savybes individualiai 
kiekvienam objektui. 
__________________________ 
 
Kad išgrupuoti objektus 
1.Pasirinkite objektą-grupę. 

2.Pasirinkite Edit>Ungroup. Objektas-grupė išgrupuotas,  ir parinkti sudedamieji objektai. w
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Objektas-grupė išgrupuotas,       Išgrupuotus objektus galima  
parinkti sudedamieji objektai      pasirinkti individualiai 
 
Objektų mastelio keitimas 
 
Objektų mastelį galite pakeisti tempiant su pele už objekto pasirinkimo rankenėlių, nurodant tikslius matmenis 
Object Details dialoge arba nustatant atstumus tarp bazinių piešinio taškų. Pakeitus piešinio mastelį, pasikeičia 
dygsnių skaičius, kad išlaikyti veikiantį dygsnių intervalą. 
 
Pastaba  Tiktai tikrieji JAN piešiniai turi pilną piešinio informaciją, reikalingą 100% tiksliam mastelio 
pakeitimui ir transformacijai. 
 
Objektų mastelio keitimas, naudojant spragtelėjimą ir tempimą su pele 
Jūs galite pakeisti objekto aukštį ir plotį arba keisti jo dydį proporcionaliai, tempiant už pasirinkimo rankenėlių. 
Galima mastelį keisti vienam atskiram objektui arba pasirinkus daugybę objektų, keisti juos kartu. 
________________________________ 
 
Kad pakeisti objektų mastelį su pele 
1.Pasirinkti objektą(us) 
Aplink objektą atsiranda aštuonios pasirinkimo rankenėlės. 
2.Spragtelėkite ant rankenėlės ir tempkite ją, kad pakeisti objekto dydį. 
 
 
 
 Matmenys keisis proporcionaliai   Matmenys keisis proporcionaliai  
            aplink centrą 
 *Kad keisti aukščio ir pločio matmenis propocionaliai, naudokite kampines rankenėles 
 
 
 
 *Norėdami keisti tik aukštį, naudokite centrines rankenėles viršuje arba apačioje. 
 
 
 
 * Norėdami keisti tik plotį, naudokite centrines šonines rankenėles. 
 
Pabandykite tai  Norėdami pakeisti matmenį simetriškai centriniam taškui, tempdami už rankenėlės laikykite 
paspaustą klavišą Shift. 
 
 
   Matmuo kinta vertikaliai 
   abiem kryptimis 
               Matmuo kinta horizontaliai 
               abiem kryptimis   
 
Objektų mastelio keitimas per Object Details 
 
Naudojantis Object Details,  galite pakeisti pasirinktų objektų arba viso piešinio mastelį. Kad išlaikyti pradinį 
dygsnių tankį, dygsniai generuojami išnaujo. 
 
Perspėjimas  Jeigu siuvinėjimo piešinio mastelį pakeisite daugiau nei 5%, dygsnių tankio pokitis paveiks 
piešinio kokybę. Žr.taip pat pusl.202 Siuvinėjimo piešinių formatai. 
__________________________ 
 
Kad pakeisti mastelį per Object Details 
1.Pasirinkite objektą 
2.Du kartus spragtelėkite atn objekto, kad atidaryti dialogą Object Details, pasirinkite lentelę Dimensions. 
 
3.Lentelėje Dimensions pakeiskite mastelį į reikalingą. 
Vienu iš būdų: w
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 *Įveskite tikslias aukščio ir pločio reikšmes. 
 *Įveskite naujus aukštį ir plotį procentine išraiška nuo veikiančių matmenų. 
4.Spragtelėkite OK. 
 
        Aukščio matmuo pakeistas 150% 
 Pradinis objektas         
              Aukštis pakeistas 50%, plotis 125% 
 
Pastaba  Pakeitus mastelį, naujas objekto dydis vėl priimamas už 100%. 
 
Objektų sukiojimas 
Jūs galite pasukti objektą tiesiog ekrane arba naudoti Rotate įrankį. 
 
Objektų sukiojimas su pele 
Kada pasirenkate objektą, jo kraštuose pasirodo pasirinkimo rankenėlės. Jeigu spragtelėsite ant objekto 
pakartotinai, rankenėlės pasikeis į sukimo rankenėles. 
_______________________ 
 
Kad pasukti objektą su pele 
1.Pasirinkite objektą 
2.Spragtelėkite ant objekto pakartotinai. Objekto kampuose pasirodis sukimo rankenėlės, ir objekto centre 
atsiras sukimosi centras. 
 
        Sukimo rankenėlė 
        Pavertimo rankenėlė 
        Sukimo centras 
 
 Po pirmo spragtelėjimo        Po antro spragtelėjimo pasirodo 
 pasirodo pasirinkimo rankenėlės     sukimo rankenėlės 
 
Pastaba  jeigu spragtelėsite per greitai, pasirodis dialogas Object Details 
3.Jeigu būtina, galite su pele sukimo centrą patraukti į kitą vietą. 
4.Spragtelėkite ant sukimo rankenėlės ir tempkite ją pagal arba prieš laikrodžio rodyklę. Sukimo metu pasirodis 
kontūras ir kryžminis žymeklis. 
 
 
Tempkite kampą, kad pasukti aplink centrą 
          Nutempkite sukimo centrą 
                Tempkite kampą, kad pasukti aplink centrą 
 
Objektų sukimas, panaudojant Rotate CCW/CW 

Spragtelėkite ant Rotate 45o CCW/CW (Edit įrankis), kad pasukti pasirinktą objektą arba piešinį 45o 
pagal laikrodžio rodyklę. 
Dešiniu spragtelėjimu, kad pasukti 45o prieš laikrodžio rodyklę. 

 
Naudokite įrankį Rotate 45o CCW/CW, kad pasukti objektus 45o abiem kryptimis. 
_____________________________ 
 
Kad pasukti objektus, naudojant Rotate CCW/CW 
1.Su Select įrankiu pasirinkite objektą(us) 
 
2.Spragtelėkite Rotate 45o CCW/CW įrankių juostoje 
*Spragtelėkite kairiu klavišu, kad pasukti 45o pagal laikrodžio rodyklę. 
*Spragtelėkite dešiniu klavišu,  kad pasukti 45o prieš laikrodžio rodyklę. 
 
Kaip paversti objektus su pele 
Galite paversti objektus horizontalioje plokštumoje, spragtelėjus ant pavertimo rankenėlių ir tempiant iki 
reikalingo kampo. 
______________________________ 
Kad paversti objektus su pele 
1.Pasirinkite objektą(us) 
2.Spragtelėkite į objektą antrą kartą. Aplink objektą atsiras sukimo ir pavertimo rankenėlės. Pavertimo 
rankenėlės yra rombo pavidalo ir yra ties objekto viduriu viršuje ir apačioje. 
3.Patempkite pavertimo rankenėles į kairę arba į dešinęw
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Objektas pavirsta horizontalioje plokštumoje. Kontūras ir kryžminis žymeklis parodo objekto formos pakitimą 
 
    Patempkite pavertimo rankenėlę į kairę arba į dešinę 
 
Objektų apvertimas 
  Spragtelėkite Flip Vertically (Edit įrankis), kad apversti pasirinktą objektą arba piešinį aukštyn/žemyn 
  Spragtelėkite Flip Horizontally (Edit įrankis), kad apversti pasirinktą objektą arba piešinį  kairėn/dešinėn 
 
Naudodami tam skirtus įrankius, galite apversti objektus horizontaliai arba vertikaliai 
________________________ 
 
Kad apversti objektus 
 *Pasirinkti objektus 
 *Spragtelėkite Flip Horizontally įrankį, kad apversti objektą kairėn/ dešinėn 
 * Spragtelėkite Flip Vertically , kad apversti aukštyn/žemyn 
Arba kitokiu būdu, spragtelėkite dešiniu klavišu į objektą ir pasirinkite Flip Horizontally arba Flip Vertically  iš 
popup meniu. 
 
Pabandykite tai  Komandas galite pasiekti taip pat per Resequence dialogą. Žr.pusl.115 Pasirinktų objektų 
perrykiavimas. 
 
 
 
 
     Po dešinio spragtelėjimo pasirinkite Flip. 

w
w
w
.V
isk
as
Si
uv
im
ui
.lt
 



125 
17 Skyrius 
 
OBJEKTŲ FORMOS KEITIMAS IR REDAGAVIMAS 
 
 
 
 
 
DigitizerPro leidžia keisti objektų formą su bazinių taškų pagalba. Pastarieji kinta labai nedaug, priklauso nuo 
objekto tipo. Kai kuriems objektams įmanoma pakeisti kontrolinius taškus iš kampinių į kreivių. Aplink 
pasirinktus objektus pasirodo kampinių dygsnių linijos ir įėjimo ir išėjimo žymekliai. Dygsnių kampų 
reguliavimai priklauso nuo objekto, su kuriuo dirbate, tipo. Kai kuriems objektams dygsnių kampus galite 
nustatyti visam objektui. Kitiems galite reguliuoti pasisukančių dygsnių kampus. Taip pat atskiriems objektams 
galite pakeisti dygsnių įėjimo ir išėjimo taškus. Tai yra naudinga mažinant perėjimų tarp objektų skaičių. 
 
Šiame skyriuje aprašoma, kaip pakeisti objektų formą su kontroliniais taškais, kaip reguliuoti dygsnių kampus 
ir pakeisti įėjimo ir išėjimo taškus. 
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Objektų formos keitimas 
 
Objekto formą galite pakeisti, pasirenkant jį su Reshape įrankiu ir ant kontūro perkeliant, pridedant arba 
ištrinant kontrolinius taškus.Kai kuriems objektams galite taip pat pakeisti kontrolinius taškus iš kampinių į 
kreivių. 
 
Patarimas  Reshape įrankis leidžia modifikuoti figūras nepaveikiant dygsnių kampų. 
 
Objektų formos keitimas, naudojant kontrolinius taškus 
  Spragtelėkite Reshape (Edit įrankis), kad parodyti pasirinkto objekto kontrolinius taškus. 
 
Pakeiskite objekto formą, pasirenkant jį su Reshape įrankiu ir pakeičiant galimus kontrolinius taškus. 
____________________________ 
 
Kad pakeisti objekto formą, naudojant kontrolinius taškus 
1.Pasirinkite objektą. 
2.Pasirinkite Reshape piktogramą. Aplink objektą pasirodis kontroliniai taškai. 
 
3.Modifikuokite kontūrą, pridedant, ištrinant, keičiant arba perkeliant kontrolinius taškus, priklausomai nuo 
objekto tipo ir reikalingo keitimo. 
4.Pakeiskite įėjimo ir išėjimo taškus ir dygsnių kampus pagal poreikį. 
5.Spauskite Esc, kad užbaigti. 
 
Kontrolinių taškų pasirinkimas 
Kontrolinius taškus perkėlmui arba modifikacijai galima pasirinkti individualiai arba kartu. 
______________________________ 
 
Kad pasirinkti kontrolinius taškus 
 *Spragtelėkite, kad pasirinkti vieną kontrolinį tašką. 
  
 
 
 

*Laikant paspaustą Ctrl, spragtelėkite, kad pasirinkti daugybę kontrolinių taškų. 
 
 
 *Spragtelėkite ir užtempkite ribojantį rėmą aplink kontrolinių taškų grupę, kad juos pažymėti. 
 
 
Kontrolinių taškų perkėlimas 
 
Galite perkelti kontrolinius taškus, kad pakeisti kontūro formą. 
___________________________ 
 
Kad perkelti kontrolinius taškus 
 *Spragtelėkite ir tempkite atskirą kontrolinį tašką į naują vietą 
 *Panašiai, spragtelėkite ant daugybės pažymėtų kontrolinių ir tempkite juos į naują vietą. 
 
 
 
Kontrolinių taškų pridėjimas 
  Spragtelėkite Reshape (Edit įrankis), kad pakeisti pasirinktų objektų formą 
 
Kai pasirinktas įrankis Reshape , spragtelėję, jūs galite pridėti kontrolinių taškų į objekto kontūrą. 

w
w
w
.V
isk
as
Si
uv
im
ui
.lt
 



127 
Pastaba  Jūs negalite pridėti kontrolinių taškų į objektus, kurie buvo sukurti su įrankiu Parallel Fill Circle. 
Žr.taip pat pusl.127 Apskritų objektų formos keitimas. 
_________________________________ 
 
Kad pridėti kontrolinių taškų 
1.Patalpinkite žymeklį, kur norite pridėti kontrolinį tašką. 
2.Spragtelėkite, kad pridėti kontrolinį tašką. 
 *Kairiu spragtelėjimu pridedamas kampo taškas. 
 *Dešiniu spragtelėjimu pridedamas kreivės taškas 
3.Sureguliuokite kontrolinio taško padėtį, nutempdami jį su pele pagal kontūrą į reikiamą vietą. 
 
Kontrolinių taškų keitimas 
Objekto kontūrų formą galima pakeisti, keičiant kontrolinius taškus iš kampinių į kreivių arba atvirkščiai.  
 
Pastaba  Jūs negalite pakeisti Turning Angle Fill  stulpelių pabaigos taškų arba bet kurių taškų objektuose, 
kurie sukurti su Parallel Fill Circle įrankiu. Žr.taip pat pusl.127 Apskritų objektų formos keitimas. 
______________________________ 
 
Kad pakeisti kontrolinius taškus 
1.Pasirinkti kontrolinį tašką 
2.Spausti Spacebar.  Kampinis kontrolinis taškas pasikeičia į kreivės tašką ir atvirkščiai. 
 
Kontrolinių taškų ištrynimas 
Galima ištrinti nereikalingus kontrolinius taškus, kad pakeisti kontūrą arba pašalinti nereikalingas ribas iš 
Parallel Fill  objektų. 
 
Pastaba  Jūs negalite ištrinti kontrolinių taškų iš objektų, kurie buvo sukurti su įrankiu Parallel Fill Circle. 
Žr.taip pat pusl.127 Apskritų objektų formos keitimas. 
______________________________ 
 
Kad ištrinti kontrolinius taškus 
1.Pasirinkite kontrolinį tašką arba taškus 
2.Spauskite Delete. 
 
 
 
Pastaba  Jeigu objektas turi tiktai du kontrolinius taškus  (arba dvi poras kontrolinių taškų, kaip Turning Angle 
Fill objektų atveju), vieno taško ištrynimu išsitrina visas objektas. 
 
Apvalių objektų formos keitimas 
  Naudokite Reshape (Edit įrankis), kad pakeisti apvalių objektų formą 
 
Jūs galite pakeisti Circle objektus iš apskritimų į ovalus, naudojant įrankį Reshape. Circle objektai turi formos 
keitimo kontrolinius taškus (naudojamus spindulio ir objekto orientavimo pakeitimui), centrinį tašką 
(naudojamas perkėlimui) ir dygsnių įėjimo tašką. Šiuose objektuose jūs negalite  pridėti, pakeisti arba ištrinti 
kontrolinius taškus. 
___________________________ 
 
Kad pakeisti apvalių objektų formą 
1.Pasirinkti Parallel Fill Circle objektą. 
2.Spragtelėti Reshape  piktogramą. 
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Pabandykite tai  Norėdami perkelti apskritimą, spragtelėkite ant kontrolinio taško, esančio apskritimo centre ir 
tempkite jį į naują vietą. 
3.Spragtelėkite ant kontrolinio taško, esančio ant apskritimo linijos. 
 *Nenorėdami pakeisti orientacijos, naudokite viršutinį kontrolinį tašką 
 
 
 
 *Kad pakeisti formą ir pasukti objektą aplink centrinį tašką, naudokite kraštinį kontrolinį tašką. 
 
 
 
 
Pabandykite tai  Kad pakeisti apskritimo mastelį, nepaverčiant jo į ovalą, pasirinkite jį su įrankiu Select ir 
naudokite kampines pasirinkimo rankenėles. 
 
         Mastelio keitimas su kampinėmis pasirinkimo rankenėlėmis 
 
Dygsnių kampų reguliavimas 
 
Dygsnių kampų reguliavimas priklauso nuo objekto, su kuriuo dirbate, tipo.Dirbant su Parallel Fill  objektais, 
jūs galite nustatyti dygsnių kampus visam objektui. Tą patį galite daryti ir su Turning Angle Fill  objektais. Taip 
pat dygsnių kampą galite reguliuoti Turning Angle Fill  ir Parallel Fill  objektuose, naudojant Reshape  įrankį. 
 
 
Pastaba  Jūs negalite pakeisti dygsnių kampo Border objektams, kadangi juose dygsniai automatiškai pasisuka, 
kad sekti pagal kontūrą. Tačiau jūs galite pakeisti dygsnių kampą Parallel Fill Circle objektuose, perkeldami 
dygsnių įėjimo tašką. 
 
Parallel Fill dygsnių kampo reguliavimas, naudojant objekto savybes 
Naudodami Object Details galite pakeisti objektų Parallel Fill  dygsnių kampą. 
 
 
 
Kad sureguliuoti Parallel Fill dygsnių kampą, naudojant objekto savybes 
1.Pasirinkti ir du kartus spragtelėti ant Parallel Fill  objekto.  Atsidarys Object Details>Fill stitch  lentelė . 
2.Pasirinkite Parallel Fill lentelę 
 
 
 
3.Fill Stitch Angle  lauke įveskite reikalingą dygsnių kampą. 
4.Spauskite OK. 
 
 
 
 
Parallel Fill dygsnių kampo reguliavimas ekrane 

Spragtelėkite Reshape (Edit įrankis), kad pasirinktuose objektuose parodyti kontrolinius taškus ir 
dygsnių kampų linijas. 
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Dygsnių kampą Parallel Fill  objektuose galite reguliuoti, naudojant Reshape  įrankį. 
________________________ 
 
Kad sureguliuoti Parallel Fill dygsnių kampą ekrane 
1.Pasirinkite Parallel Fill objektą. 
2.Spragtelėkite Reshape piktogramą. Pasirodo kontroliniai taškai kartu su dygsnių kampo linija. 
 
 
 
3.Spragtelėkite ir tempkite liniją kiek reikia. 
 
Pastaba  Pastebėsite, kad pelės žymeklis pasikeičia į ‚dygsnių kampo pelės žymeklį‘ 
 
 
 
4.Spauskite Esc, kad užbaigti. 
 
Pabandykite tai  Kad minimizuoti plyšius jūsų siuvinėjimo piešinyje, pastatykite dygsnių įėjimo ir išėjimo 
taškus priešais vienas kitą už ribos. Tada nustatykite dygsnių kampą, kad jis būtų statmenas linijai jungiančiai 
įėjimo ir išėjimo kampus. 
 
Dygsnių kampų redagavimas Reshape režime. 

Spragtelėkite Reshape (Edit įrankis), kad pasirinktame objekte parodyti kontrolinius taškus ir kampines 
linijas  

 
Galite reguliuoti dygsnių kampus Lettering  ir Turning Angle Fill objektuose su Reshape įrankiu dialoginiame 
režime. Taip pat, Reshape režime galite pridėti ir ištrinti dygsnių kampus. 
 
 
 
 
 
_____________________________ 
 
Kad redaguoti dygsnių kampus Reshape režime 
1.Pasirinkite raidinį (Lettering) objektą. 
2.Spragtelėkite Reshape piktogramą ir spragtelėkite raidės kontūrą. 
3.Spragtelėkite ir tempkite dygsnių kampų taškus į reikalingą vietą.  
Atitinkamai pasikeis dygsnių kampai. 
 
 
 
Pastaba  Pastebėkite, kad pelės žymeklis pasikeičia į ‚dygsnių kampo pelės žymeklį‘ 
4.Pasirinkite ir ištrinkite dygsnių kampus, spausdami Delete mygtuką. 
5.Laikydami paspaustą klavišą Ctrl, spragtelėkite bet kur ant kontūro, kur norite patalpinti dygsnių kampo 
liniją. 
6.Spauskite Esc, kad užbaigti. 
 
Įėjimo ir išėjimo taškų keitimas 

Spragtelėkite Reshape (Edit įrankis), kad pasirinktuose objektuose reguliuoti įėjimo ir išėjimo taškus. 
 
Individualiems objektams galite pakeisti dygsnių įėjimo ir išėjimo taškus. Stenkitės patalpinti išėjimo taškus 
šalia kaimyninių objektų, kad sutrumpinti perėjimi (sujungimo) dygsnius arba sumažinti kelionės perėjimų 
skaičių. 
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Pastaba   Circle objektuose, dygsnių kampas yra statmenas linijai jungiančiai įėjimo tašką su apskritimo centru 
 
 
 
 
__________________________ 
 
Kad pakeisti įėjimo ir išėjimo taškus 
1.Pasirinkite objektą 
2.Spragtelėkite Reshape piktogramą. 
Pasirodo kontroliniai taškai, įskaitant įėjimo ir išėjimo taškus. 
 
 
 
 
 
Pastaba  Circle objektuose pasirodo tiktai įėjimo taškas. 
3.Pasirinkite reikalingą įėjimo arba išėjimo tašką ir tempkite jį į naują padėtį ant objekto kontūro. 
 
 
 
 
 
4.Spauskite Esc klavišą, kad užbaigti. 
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V Dalis 
 
 
PROJEKTAVIMAS LABIAU PATYRUSIEMS 
 
 
 
EasyDesign užtikrina specialias produktyvumo galimybes taip pat specialius efektus ir projektavimo būdus. 
 
Objektų detalės ir šablonai 
Šiame skyriuje aprašoma, kaip jūsų piešinyje pakeisti objektų detales, taip pat kaip taikyti, sukurti ir palaikyti 
šablonus EasyDesign programoje. Plačiau skaitykite pusl. 133 Objektų detalės ir šablonai. 
 
Dygsnių kokybės pagerinimas 
Šiame skyriuje aprašoma, kaip sustiprinti ir stabilizuoti piešinius su posluoksniniais patiesalais ir kaip 
kompensuoti medžiagos tamprumą. Taip pat aiškinama, kaip egzistuojančiame piešinyje  pakeisti medžiagos 
nustatymus. Plačiau skatykite  pusl.139 Dygsnių kokybės pagerinimas. 
 
Tobulesni projektavimo būdai 
Šiame skyriuje aprašyta, kaip sukurti iškarpas ir užpildyti skyles objektuose, taip pat, kaip pasirinktiems 
objektams pritaikyti Feather Edge ,Gradient Fill ir Travel on Edge efektus. Čia taip pat pateikiamos Applique 
projektavimo būdo detalės. Plačiau žr.pusl.147 Tobulesni projektavimo būdai. 
 
Dygsnių redagavimas 
Šiame skyriuje aprašyta, kaip pasirinkti ir redaguoti dygsnius dygsniniuose piešiniuose, panaudojant 
DigitizerPro EasyEdit. Plačiau žr.pusl.157 Dygsnių redagavimas. 
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18 Skyrius 
 
OBJEKTŲ DETALĖS IR ŠABLONAI 
 
 
 
 
Siuvinėjimo objektų detalės yra bendros charankteristikos, kaip dydis ir padėtis, taip pat specifinės siuvinėjimo 
charakteristikos, kaip dygsnių tipas ir tankis. Tam tikri dygsnių nustatymai apibrėžia kaip bus regeneruojami 
dygsniai pakeitus objekto formą, transformavus arba pakeitus mastelį. 
 
Pradedant naują piešinį, DigitizerPro panaudoja standartinius nustatymus arba ‚reikšmes‘, saugomas šablone. 
Dauguma piešinių naudoja ‚Normal‘ šabloną, tačiau jūs galite susikurti ir naudoti savo nuosavą šabloną. 
Ištikrųjų, šablone jūs galite išsaugoti bet kokį nustatymų derinį, kaip mėgiamiausių dygsnių arba raidinių 
nustatymų. 
 
Šiame skyriuje aprašoma, kaip jūsų piešinyje pakeisti objektų detales, taip pat kaip taikyti, sukurti ir palaikyti 
šablonus EasyDesign programoje. 
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Objektų detalių pritaikymas ir tvarkymas 
 
DigitizerPro saugoja tris objektų detalių rinkinius – standartinis, veikiantis ir egzistuojantis 
 
Pastaba  Kai kurios objektų detalės gali būti modifikuojamos ekrane – pavyzdžiui, jūsgalite pakeisti dydžio 
detales keisdami objekto mastelį su pasirinkimo rankenėlėmis. Kitos detalės, kaip dygsnių intervalas arba ilgis, 
modifikuojamos Object Details dialoge. 
 
Standartinės objektų detalės 
Standartinės objektų detalės laikomos piešinio šablone ir jos yra startinės, sukuriant naują piešinį šio šablono 
pagrindu. 
 
Veikiančios objektų detalės 
Veikiančios objektų detalės yra nustatymai, naudojami naujų objektų sukūrimui. Nors ir pakeistumete šiuos 
nustatymus, jie išlieka tokie patys, kaip šablono standartiniai. Paprastai, jūs keičiate juos, kad taupyti 
projektavimo laiką. Pavyzdžiui, jūs iš anksto galite nusistatyti Satin Fill dygsnius, kad panaudoti specialų tankį 
naujam projektuojamam Satin objektui. 
 
Pastaba  Pakeitimas paveiks naują objektą piešinyje, ne patį šabloną. Kad pritaikyti pakeitimus visiems 
naujiems šiuo šablonu pagrįstiems piešiniams, jums reikia pakeisti default (standartines) – ne current 
(veikiančias) – detales. Žr.taip pat pusl.142 Darbas su medžiagomis. 
 
Egzistuojančios objektų detalės 
Egzistuojančių objektų detalės yra nustatymai, kurie saugojami kartu su objektu piešinyje. Pasirinktų objektų 
detales jūs galite paversti naujomis veikiančiomis detalėmis arba naujomis standartinėmis. Taip pat galite 
veikiančias detales taikyti egzistuojantiems objektams. 
 
Veikiančių objektų detalių nustatymas 
  Naudokite Object Details (Edit juostos įrankis), kad nustatyti detales veikiančiam piešiniui. 
 
Kada keičiate current (veikiančias) objektų detales, nustatymai automatiškai taikomi visiems naujiems 
veikiančio piešinio objektams. Jūs galite taip pat taikyti veikiančias detales egzistuojantiems objektams. Prieš 
pradedant, galite sureguliuoti veikiančias objektų detales, kaip naujus nustatymus. Jūs galite tiktai pakeisti 
nustatymus tų objektų, kurie nekontroliuojami medžiagų nustatymais. 
 
Pastaba  Pasirinktų objektų nustatymai gali turėti prioritetą prieš medžiagos nustatymus. Žr.žemiau Pasirinktų 
objektų detalių keitimas. 
_________________________________ 
 
Kad nustatyti veikiančias objektų detales. 
1.Įsitikinkite, kad nėra pasirinktų objektų. 
2.Spragtelėkite Object Details piktogramą.. Atsidaro Object Details dialogas. 
 
 
 
 
 
Object Details dialogo viršuje pasirodo langeliai, kurie užtikrina prieigą prie visų galimų objekto detalių 
nustatymo. 
3.Spragtelėkite į langelį, kad pamatyti veikiančius nustatymus ir pakeisti, jeigu reikalinga. 
4.Spragtelėkite OK. 
 
Pasirinktų objektų detalių keitimas 
Galite keisti pasirinktų objektų detales. Jeigu jūs esate pasirinkęs daugiau negu vieną objektą, Object Details 
dialogas parodis tiktai langelius, kuriuose yra nustatymai tinkantys visiems pasirinktiems objektams. 
Pavyzdžiui, jeigu jūs pasirinkote Parallel Fill ir Border objektus, nepasirodis nei Parallel Fill nei Border 
langeliai,  kadangi vienodi nustatymai netaikomi abiems objektams. Jeigu pasirinkti objektai tam pačiam 
nustatymui turi skirtingas veikiančias reikšmes, laukas bus tuščias. Jeigu įvesite naują reikšmę, ji bus taikoma 
abiems objektams. w
w
w
.V
isk
as
Si
uv
im
ui
.lt
 



135 
 
 
 
    Reikšmės pasirinktiems objektams pakeistos 
 
 
Pastaba  Egzistuojančių objektų detalių pakeitimas neveikia į veikiančius arba standartinius nustatymus ir į bet 
kurių esamu metu nepasirinktų objektų detales. Žr.taip pat pusl.142 Darbas su medžiagomis.  
___________________________________ 
 
Kad pakeisti pasirinktų objektų detales 
1.Pasirinkite objektą(us), kurio detales norite pakeisti. 
2.Du kartus spragtelėkite, kad atidaryti Object Details dialogą. 
3.Pasirinkite reikalingą langelį ir pakeiskite nustatymus, kaip pageidaujate. 
4.Spragtelėkite OK. 
 
Standartinių objektų detalių pakeitimas 
Jūs bet kuriuo metu galite pakeisti standartinių objektų detales, išsaugojant objekto, su kuriuo dirbate, detales į 
veikiantį šabloną. Išsaugojami tiktai toobjekto nustatymai. Kitos detalės išlaiko jų veikiančius nustatymus. 
Pavyzdžiui, jeigu jūs darote pasirinkto Border  objekto detales standartinėmis, tai standartiniai Parallel Fill 
nustatymai nepasikeis. 
 
 
 
 
Standartinis Satin Line plotis       Naujo Satin Line plotis 
 
 
Pastaba  Pakeitimas paveiks visus naujus piešinius, sukurtus, panaudojant šitą šabloną. Jeigu tiktai norite, kad 
pakeitimai būtų taikomi piešiniams, su kuriais jūs dirbate,  keiskite veikiančias,  ne standartines detales. 
______________________________ 
 
Kad pakeisti standartinių objektų detales 
1.Pasirinkite objektą(us),  ant kurio norėtumete sudaryti standartinę bazę. 
2.Du kartus spragtelėkite, kad atidaryti Object Details dialogą. 
 
 
 
3.Pasirinkite norimą langelį ir pakeiskite nustatymą. 
4.Spragtelėkite Save. 
Objekto detalės išsaugojamos veikiančiame šablone ir bus taikomos visuose naujuose objektuose ir piešiniuose, 
kurie pagrįsti šiuo šablonu. 
 
Pastaba  Taip pat galite sukurti naują šabloną, panaudojant modifikuoto objekto detales kaip standartines. 
Plačiau skaitykite pusl.136 Piešinių šablonų panaudojimas. 
 
Piešinių šablonų tvarkymas 
Šablonai yra specialūs failai, naudojami standartinių nustatymų išsaugojimui. Šablonus naudokite projektuojant 
dažniausiai naudojamus piešinių tipus taip, kad jums kiekvieną kartą nereikėtų nustatinėti veikiančių detalių. 
Pavyzdžiui, šablone gali būti standartinių objektų ir raidinis pavyzdys. Jame gali būti tiesiog pageidautini 
dygsnių nustatymai, raidiniai fontai ir dydis ir spalvos nustatytos kaip veikiančios detalės. Arba jis gali turėti 
specialų tankį, tempimo kompensaciją arba posluoksnio nustatymus nustatytus, kad tiktų skirtingoms 
medžiagoms. 
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Dažnai naudojamas lankelis arba  
fono spalva gali būti išsaugoti šablone 

 
Kada įjungiate DigitizerPro, ji sukuria tuščią piešinį Normal šablono pagrindu. Tada programa užklausia jūsų, 
kokią medžiagą norėtumete naudoti. Kada jūs pasirenkate File>New, jūs būsit paprašytas pasirinkti šabloną. 
Tada šablonas panaudoja bet kurią medžiagą, kuri yra veikianti, kai jūs pirmą kartą atidarote piešinį arba 
sukuriate naują iš dialogo Geting Started. 
 
Pastaba  Medžiaga piešiniams yra kritinis elementas ir yra kontroliuojamas atskirai šablono reikšmėmis. 
Medžiagų nustatymų kiekis yra mažesnis negu jų patalpinta šablonuose. Šablonai nustato globalines reikšmes 
jūsų piešiniui, tačiau kiekvienas piešinys reikalauja savo atskiro medžiagos nustatymo, kuris saugojamas kartu 
su piešiniu. Žr.taip pat pusl.142 Darbas su medžiagomis. 
 
NORMAL šablonas 
NORMAL šablonas yra standartinis šablonas, patiekiamas kartu su DigitizerPro. Jame yra veikiančio objekto 
detalės. 
 
Piešinio šablono sukūrimas 
Jūs galite sukurti šablonus iš piešinių, kurie susideda iš reikalingų objektų ir objektų detalių. Tiesiog 
išsaugokite piešinį arba jo elementus kaip šabloną. Šablonai atrodo taip pat kaip ir piešinių failai, tačiau 
naudoja failo pavadinimo tęsinį JMT 
 
Pastaba  Šablono jūs negalite perrašyti per klaidą. Kiekvieną kartą kai jūs iš šablono kuriate naują piešinį, 
DigitizerPro atidaro dublikatą. Kada jūs išsaugojate piešinį pirmą kartą, atsidaro dialogas Save As, tokiu būdu 
jūs galite išsaugoti šabloną kitu vardu. 
_______________________________ 
 
Kad sukurti piešinio šabloną 
1.Pradėkite naują arba atidarykite egzistuojantį piešinį. 
2.Jeigu reikalinga, sureguliuokite objekto detales ir efektus. 
3.Pridėkite objektus ir raides, kuriuos norėtumete matyti šablone. 
 
 
    Į šabloną  papildomai įdėtas raidinis objektas,  
    kuris bus kiekviename piešinyje 
 
 
Pabandykite tai  Jūs galite įvesti raidžių bazines linijas, tačiau tai tik pagelbės įvesti teksto pavyzdį. 
Naudodami  šabloną, jūs galite perspausditi teksto pavyzdį. 
4.Pasirinkite File>Save As 
Atsidaro Save As dialogas. 
 
 
 
 
 
5.Iš Save As tipinio sąrašo pasirinkite  Templates (JMT). 
DigitizerPro automatiškai atidaro bylą DigitizerPro/Template.Piešinių šablonai turi būti sagojami čia arba jie, 
jums pradėjus naują piešinį, nepasirodis šablonų sąraše. 
6.File name lauke įveskite šablono vardą. 
7. Spragtelėkite OK. 
 
 
  Piešinys 1   Piešinys 2 
 
 
Piešinių šablonų naudojimas 
Kai iš File meniu pradedate naują piešinį, dialoge New  pasirodo galimų šablonų sąrašas. Plačiau žr.pusl.27 
Naujų piešinių kūrimas pagal vartotojo šablonus. w
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Pastaba  Šablonų sąrašas pasirodo tiktai kada jūs pradedate piešinį iš File  meniu. Jeigu jūs pasirinksite New 
įrankį, pagal standartą bus taikomas NORMAL šablonas. 
 
Piešinių šablonų modifikavimas 
Šablonus jūs galie modifikuoti tokiu pat būdu kaip normalius piešinius. 
 
Pastaba  Pakeitimus taikykite tiktai šablono panaudojimui ateičiai. Egzistuojantys piešiniai, sukurti šio šablono 
pagrindu, nebus paveikti. 
_________________________ 
 
Kad modifikuoti piešinio šablonus 
1.Pasirinkti Files>Open. Atsidaro Open dialogas 
2.Nueikite į DigitizerPro/Template bylą, tada iš „Files of type‘ nusileidusio sąrašo  pasirinkite Templates 
(JMT). 
Pasirodo galimi šablonų failai. 
 
 
 
 
3.Pasirinkite šabloną, kurį pageidaujate modifikuoti, ir spragtelėkite Open. 
4.Modifikuokite objektų detales, stilių ir kitus pageidaujamus nustatymus. 
5.Pasirinkite File>Save As. 
Atsidaro dialogas Save As. 
6.Iš Save As tipo nusileidusio sąrašo pasirinkite Templates (JMT) ir spragtelėkite Save. 
 
Pabandykite tai  Kad sukurti naują šabloną modifikuoto šablono pagrindu, įveskite naują failo vardą ir 
spragtelėkite Save. 
7.Spragtelėkite Yes,  kad patvirtinti. Modifikuotas šablonas paruoštas naudojimui. 
 
Veikiančių detalių išsaugojimas šablone. 
Jūs lengvai galite išsaugoti veikiančio objekto detales į veikiantį šabloną. Žr.taip pat pusl.134 Objekto detalių 
taikymas ir tvarkymas. 
__________________________ 
 
Kad išsaugoti veikiančias detales į šabloną 
1.Įeikite į Object Details  dialogą. 

*Kad panaudoti veikiančias objekto detales, atšaukite visus pasirinktus objektus, tada spragtelėkite Object 
Details piktogramą. 
*Kad panaudoti tam tikras objekto detales, pasirinkite objektą ir du kartus spragtelėkite ant jo. 

 
     Spragtelėkite, kad nustatymus išsaugoti į šabloną. 
2.Pakeiskite reikalingas objekto detales. 
3.Spragtelėkite Save. Pasirodis patvirtinimo pranešimas. 
 
Pastaba  Tiktai veikiančių objektų detalės – ne objektai arba kiti nustatymai piešinyje – yra išsaugojami 
šablone. 
4.Spragtelėti OK, kad atnaujinti šabloną. 
5. Spragtelėti OK, kad sugrįžti į piešinio langą.  
Nauji nustatymai yra išsaugoti šablone, iš kurio buvo sukurtas piešinys, ir juos galima toliau naudoti. 
 
Piešinio šablonų trynimas 
Šablonus ištrinkite tokiu pačiu būdu, kaip ištrintumete bet kurį Windows failą, panaudojant Windows Explorer. 
Šablonai yra saugojami DigitizerPro\Template byloje. 
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19Skyrius 
 
 
DYGSNIŲ KOKYBĖS GERINIMAS 
 
Siuvinėjimo išvaizda ir kokybė labai priklauso nuo posluoksnio, kuris tarnauja dengiančio siuvinėjimo 
pagrindu. Be posluoksnio, siuvinys plokščiai dengia medžiagą, kuri dažnai gali prasišviesti. Nauji 
pprojektuotojai gali susivilioti padidinti dygsnių tankį, tačiau žymiai efektyviau yra panaudoti posluoksnį. Nors 
posluoksnis padidina dygsnių skaičių, bet jis padeda stabilizuoti medžiagą ir sumažinti raukšlėjimąsi ir 
sutraukimą, ypač ant didsnių piešinių. Jis tai pat užtikrina ‚pastogę‘, keliančią dygsnių dangą ir neleidžiančią 
dygsniams paskęsti į minkštas medžiagas. Jis dar gali paruošti suvinėjimui pašiauštas medžiagas, išlygindamas 
ją. 
 
Siuvinėjimo dygsniai įtraukia medžiagą į vidų, kur sminga adatos. Tai gali sukelti medžiagos raukšlėjimąsi, gali 
pasirodyti plyšiai siuvinyje. Kad objektas būtų išsiuvinėtas teisingai, dygsniai jame turi turėti teisingus 
intervalus, pakankamą įtraukos kompensaciją kartu su tinkamu posluoksniu, suderintu su dygsnio tipu, objekto 
tipu, objekto forma ir medžiaga. DigitizerPro užtikrina optimizuotų medžiagos nustatymų rinkinį taip, kad 
programiškai galima būtų įvertinti medžiagos, ant kurios bus siuvinėjama, tipą. 
 
Šiame skyriuje aprašoma, kaip sustiprinti ir stabilizuoti piešinius su posluoksniais ir kaip kompensuoti 
medžiagos tempimąsi. Čia taip pat aiškinama, kaip pakeisti egzistujančių piešinių medžiagos nustatymus. 
 
Sustiprinimas ir stabilizavimas su posluoksniais 
_________________________________________ 
 
DigitizerPro generuoja posluoksnio siuvinėjimą automatiškai, veikiančių nustatymų pagrindu. Pastarieji yra 
saugomi su kiekvienu objektu tokiu pat būdu kaip ir kitos objekto detalės. Jie regeneruojami visuomet kai 
keičiamas objekto mastelis arba objektas transformuojamas. EasyDesign leidžia jums sureguliuoti reikšmes, 
kad suderinti įvairias medžiagas, raidžių išvaizdą ir dydį. 
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Didesni plotai ir tamprios medžiagos, kaip trikotažas ir pike, paprastai labiau reikalauja posluoksnių negu 
mažesni plotai ir tvirtos medžiagos, kaip tikas arba oda. Tada, kai norite visą piešinį kilsterėti, geriausiai yra 
naudoti banguotą (weave) posluoksnį. Ant trikotažo geriausia tinka pakraščio eilutė (Edge run). Žr.taip pat 
pusl.142 Darbas su medžiagomis 
 
Automatinių posluoksnių taikymas 

Naudokite Underlay (Edit įrankis), kad pritaikyti automatinį posluoksnį naujam arba pasirinktam 
objektams 

 
Underlay įrankis yra perjungimo mygtukas, kuris leidžia panaudoti automatinį posluoksnį naujam arba 
pasirinktam objektams, sukurtiems ant veikiančių nustatymų bazės. Underlay įrankis tik įėjus į programą yra 
neveikiantis. 
_______________________________ 
 
Kad panaudoti automatinį posluoksnį 
*Su arba ne pasirinktu objektu, spragtelėkite ant Underlay piktogramos. 
Kai objektas nepasirinktas, posluoksnio dygsniai automatiškai generuojami naujam piešiniui. Abiem atvejais, 
naujam arba pasirinktam objektams automatiškai sugeneruoti dygsniai yra pagrįsti veikiančiomis savybėmis.  
* Su arba ne pasirinktu objektu, spragtelėkite ant Underlay piktogramos, kad išjungti jo veikimą. 
 
 
Posluoksnių keitimas 
DigitizerPro užtikrina galimybę pasirinkti posluoksnių variantą: 
 
 
 
 
 
Papildomai prie bazinių posluoksnių dygsnių tipų – Center Run (centrinė eilutė), Zigzag, Edge Run (pakraščio 
eilutė) ir Weave (banguotas) – DigitizerPro taip pat užtikrina posluoksnių derinius, kaip Double Zigzag 
(dvigubas zigzagas), Center Run+Zigzag ir t.t. Tai leidžia taikyti objektams dvigubus posluoksnius. 
 
Pastaba  Bet koks derinys, kuriame yra Center Run posluoksnis, negali būti panaudotas su Parallel Fill arba 
Parallel Fill Rectangle objektais. 
____________________________________ 
Kad pakeisti posluoksnį 
1.Pasirinkti ir du kartus spragtelėti užpildymo objektą. 
Atsidaro Object Details dialogas. 
2.Pasirinkite Underlay langelį. 
 
 Pasirinkti Underlay 
 
 Pasirinkti Underlay tipą 
 
3.Kontroliniame langelyje pasirinkite Underlay 
4.Iš Underlay Type sąrašo pasirinkite posluoksnio tipą. 
5.Spragtelėkite OK. 
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